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Introduction

As was described in the Getting Started Guide, the GNUPro® Toolkit is made up of
several components, including Source-Navigator™.

If you are familiar with the basics of Source-Navigator and are looking for additional
detailson using it to devel op and manage your source code, see Part I: “User’s Guide”
on page 5. If you want to do your development work from the command line, see
“Command Line Options” on page 131.

In addition to the languages supported in this distribution, you can use the
Source-Navigator Software Development Kit (SDK) to add new parsers for new
programming language or customize the graphical user interface (GUI). For more
information, see Part Il: “Programmer’s Guide” on page 133.
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About this Guide

About this Guide

This document serves as areference to Source-Navigator GUI elements, tools, and
functionality. Part | provides more detailed information than was included in the
Getting Started Guide, and discusses why you might choose one option over another
when achoiceis available to you. Part Il provides information on customizing
Source-Navigator, using the SDK.

Document Conventions

This documentation uses the following general conventions:

Italic Font
Indicates a new term that will be defined in the text and items called out for
special emphasis.

Bold Font
Represents menus, window names, and tool buttons.

Bold Italic Font
Denotes book titles, both hardcopy and electronic.

Plain Typewiter Font
Denotes code fragments, command lines, contents of files, and command
names; also indicates directory, file, and project names when they appear in
body text.

Italic Typewiter Font
Represents a variable for which an actual value should be substituted.

Bol d Typewriter Font
Represents program output.

Menu names and their submenus are separated by an arrow (- ). For example,
File » Open means from the File menu, select Open from its submenu.

Paths are written in UNIX notation (forward slashes) throughout; ~/ bi n means the
directory Source-Navigator isinstalled into, subdirectory bi n.

Mouse Conventions
The following are conventions for using the mouse with Source-Navigator:

Click Place the cursor on a specified object and press the left mouse
button. The term “click” alone always means left-click.

Double-click Click the left mouse button twice in rapid succession without
moving the mouse.
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Right-click Place the cursor on a specific object and click the right mouse
button.
Select text Click and drag the cursor through text (or code) to be selected.

Selected text is highlighted.

Keyboard Conventions
Y ou can use the keyboard to activate many of the functions displayed on the toolbar
and in the menus.

Holding down the Alt key while pressing Sis represented as Alt+S. To open a
command in the menu bar, press the Alt key plus the underlined |etter of the menu.
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Part I:
User’'s Guide
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Using the Project Editor

Y ou learned how to create basic Source-Navigator projectsin the “Starting a New
Project” section in th&etting Started Guide. In this documentation, you will learn to
use theProject Editor to fine-tune your projects.

Project Editor

TheProject Editor enables you to add, hide, and unload files from your project. You
can also use it to create and change views. To opd?rdpect Editor, from theFile
menu, seledProject Editor.
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Project Editor

Figurel: Project Editor Window

% 0 e 0 emo] Proje 0 g@g
Display project files as: ¥ Tree .- Category - List W |
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EuiltIn.cc Add Project... |
BuiltIn.h
[A Channel.h 7
Pattern: |*
glish/agenth |

Select an option from Display project files as to change the layout of the files and
directoriesin the Project Editor window; Treeisthe default layout.

The Project Filetext box contains afile path; the directory that your project fileis
located inis your project directory. From now on, every non-absol ute path will be
relative to this directory. If you would like to choose a different path, click the'“
button. You can change the path only when creating a project.

NOTE If the source code included in the project is in a read-only directory, you will
not be able to create the project and corresponding database files in the same
directory as your source files. You must choose a directory where you have
write permission for the project file and the database files.

Adding Files to a Project

To add source files to a project, click thdd Files button. TheDpen dialog appears.
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Project Editor

Figure2: Dialogfor Adding

Open...

=

irectory:

Filesto a Project

ftoaolsuitessharefdemos/c++_dema

] -moprd confiqure

(] eontrib confiqure. in

(] =ditline install-sh

(3 9lish Makefile

] == HEWS

ot+_dema. prog RERIME

] I

File names: || | Qpen |

Files of type: &l Files () ~| ' cancer |

Y ou can filter files based on the Files of type menu. All files (*) is chosen by default.
Select the source files to be added to the project and click the Open button.

Adding Directories to a Project

The Add Directory button allows you to add directories and their entire contents to

your project.

Figure3: Dialog for Adding Directoriesto a Project

Zelect directory

B ettt _demo
] omntrib
] =ditline
] 9lish
] =d=
L] mencp
] =te=
O] i
] itcll.S
] lecale
] mdk

Ok | Cancel |

Select the directory you want to add and click OK. Y ou can add as many directories as
you wish, but you must add them one at atime.

Adding Another Project to a Project

The Add Project button alows you to import another Source-Navigator project and

al of itsfilesinto your

current project.
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Project Editor

Figure4: Dialog for Adding Another Project to a Project

Open...
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Files of type:  Project files (*.proj) —-| Cancel |

Thisisthe same Open dialog as when you clicked on the Add Files button, except
that Project files (*.proj) isthe default in the Files of typefield. To seeall filesin the

directory, choose All files (*). Click on the project from which you want to import
files.

Using Views

Views show a partia set of project files. For example, one view might be set to show
only database-specific files from a project, while another one shows the GUI

components in the project. Y ou may hide specific filesin one view and show these
hidden files in other views.

Creating views

Enter the name of the new view in the View text box and click OK . This creates the
new view and closes the Project Editor. The next time you open the Project Editor,
this view will be the default view in the View selection box.

Selecting another view

To select an existing view, click the down arrow to the right of the View text box. A
pulldown list of views appears. Select the view you wish to see.

Hiding Files from a View

The Hide button allows you to hide files from the current view, but does not delete
them from the project or the file system. Hiding files is convenient when there are
many filesin aview, but you are only interested in seeing a subset.

Hidefilesor directories by clicking on afile or directory in the file system tree view of
the Project Editor, and click the Hide button. A new folder named Hidden appears
and the hidden files and directories are placed into this folder. To make the hidden
items visible again, select the hidden file or directory and click the View button.
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Project Editor

Unloading Files from a Project

The Unload button allows you to remove files from a project, but not from your hard
drive. To remove filesfrom aproject, select thefiles from the Project Editor window
and click the Unload button.

Statistics for a Project

The Statistics button allows you to view the number of symbols (such as classes,
methods, and functions) in afile. In the Nametext box, select afile and click the
Satistics button. The statistics for the file are displayed. Click Close to close the
Satistics window.

Closing the Project Editor
When you're finished working with ther oject Editor, click OK.

Closing Projects

To close a project, from tHeile menu, seledClose Project. Closing a project:
. closes all tools used while working on the project or a project view.

. closes all database files for the project.

. brings up thérojects window, if no other projects are open.

Deleting Projects

To delete a project while using tBgmbol Browser, from theFile menu, select
Delete Current Project. To delete a project from another browser, fromRte
menu, seledProject — Delete Current Project. The project file and other project
database files are deleted. All source files and directories remain unchanged.

Importing Files and Directories into a Project

As an alternative to using ttiReoject Editor to select source code directories for the
new project, you can collect file and directory names into a separate file and import
this file into Source-Navigator. You can also usefthed command to generate this
list.

To import files or directories, start Source-Navigator withitimgor t option. At the
command line, type:
snavi gator -inport filenane

The project directory is the current working directory, Ahtlename must be a file or
directory, one per line (thenclude Browser uses the directory names). A sample file
for import follows:

chk. h
chk. c
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Project Editor

hell o. h
/usr/tuxedo/src/main.c
/usr/tuxedo/src/read.c
/ hone/ scribbles/tcp/call.c
/usr/local/include
/tnp
For more information on using Source-Navigator from the command line, see

“Command Line Options” on page 131.
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General Source-Navigator
Features

This chapter builds on the basic information in the Getting Sarted Guide and
provides details about the most commonly used features of Source-Navigator.

Menus

The File, Edit, Search, and Tools menus appear in all windows, however they are
context-sensitive: the options available from the menus change depending upon which
tool you're using. Thédistory, Windows, andHelp menus, however, are more
general and offer the same options within each tool.

History Menu

TheHistory menu enables you to repeat queries and restore previous states of each
browser’s view of your project.
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Menus

Figure5: History Menu

History | Windows
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Windows Menu

The Windows menu contains the tools available in Source-Navigator.

Figure6: WindowsMenu

Windows |

| Creates new
window

Creates new,
— split-screen
window

(llzy iz I Editor Fs
Add View < Hierarchy F&
Open Yiews 7 Class F7
Iconize Project ref Fa
1 Symbals Include F3

Hierarchy - Class

Clags - Editor

Class - XRef

Retriever - Editor

Grep - Editor

Hierarchy - Class - Editar

Symbols F4

To add anew tool in aview, from the Windows menu, select New View. To add a
tool to your current window, from the Window menu, select Add View. To changeto
acurrently running instance of atool, from the Windows menu, select Open Views.

Help Menu

The Help menu provides help for Source-Navigator.
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Symbol and Type Abbreviations

Figure7: Help Menu

Help |

Online Manuals...

Abhreviations...

About Source-Mavigatar...

Online Manuals contains an HTML version of the current documentation.
Abbreviations opensthe Abbreviationsdialog, which displaysalist of abbreviations
Source-Navigator uses in its browsers. For more information see “Symbol and Type

Abbreviations” belowAbout Source-Navigator displays copyright and version
information about Source-Navigator.

Symbol and Type Abbreviations

Source-Navigator uses the following abbreviations in its browsers. This dialog is
accessible from thelelp menu by selectingbbreviations.
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General Window Features

Figure 8: Abbreviations Dialog
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General Window Features

Y ou may reuse Source-Navigator windows and adjust the window column size. The
status line, located at the bottom of awindow, shows information such as the number
of lines of source code and the current directory.

Adding a Browser to an Existing Window

If you find yourself often using two Source-Navigator tools simultaneously, you can
combine them into one window. This keeps you from constantly switching between
windows, and alows you to see both tools at the sametime.
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General Window Features

For instance, if you have a class open in the Cross-Reference Browser and you want
to bring up an Editor to see the same class, but you want to continue to see the
cross-references, from the Windows menu select Add View — Editor, and an Editor
appears in the same window. Depending upon your settingsin the Project
Preferences dialog (see page 28), the new Editor appears either at the bottom of the

window (Vertical) or on the right side of the window (Horizontal).

Figure9: Vertical Windows
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Browser

Editor

Zource-Mavigator [c++_demao] Valueh

File Edit Search Tools History  Windows

@ Valueicl)

i

Edit | Hierarchy | Class | ﬁrefl Include | Retriever | Grep |
r ForwardEvent(mi) Sequencer
r Frame({mi) Frame

r field names_built inffu)

Valueicl)

r Generatelndices (mi) Value
r GetEvent(mi) Client

r GetOrCreatebttribute(mil Value

/4 The number of Value chjects created and deleted. Useful for tracking
#¢ down inefficiencies and leaks.

extern int H

extern int

class Eulug : public GlishChject |
public:
Valuei glish bool walue ):
Waluel byte walue );
Waluel short walue ):
Waluel int walue ):

Help
X
Resize
Pane
i Box
B
7

=

(W Reuse|[W Context]  114.6]stoolsuitesshareddemosic++_demo/glishiinclude/Glish/Value.h: 812 lines

Red Hat Source-Navigator

Reference Guide m 17



General Window Features

Figure 10: Horizontal Windows

Zource-Mavigator [c++_demao] Valueh

File Edit Search Tools History  Windows Help Resize

| | Pane

Hierarchy | Class | ﬁrefl Include | Retriever | Grep | BOX

—— r FindIndicesimi] VecRe: T [&]
T4 The number of Value chbjects created and o
#¢ down inefficiencies and leaks.

CTOSS- I r Frame(mi) Frame extern int

extern int
Reference I— r field pames built_inf
Browser Valueicl)|w—1I

I r ForwardEventimi) Sequ

—1 Editor

—— r GemerateIndices{mi) W class ¥alud : public GlishObject {
public:

— GetEvent 1 Cli t
T GetBventimi) Clien Valuei glish bool value J:

I— © GetOrCreatehttributelq Valuel byte walue ):
Waluel short walue ):
I r GetOrCreateRecordElemd Valuesl int walue );

Walusl float walue ):
Valuel double walue ):

| r GetString(mi) CreateT|y Valuel complex value |: 7
| I B = I =

(W Reuse|[W Context| |[#tootsuitersharesdemasic++_demo/glishiinclude/GlisheValue.h: 812 lines

I r GetShellCmdCutput(mi)

Asyou click on symbolsin the Cross-Reference Browser, those symbols appear in
the Editor.

Reusing Windows

When the Reuse button in the window status lineis selected, anew view is displayed
in the current window when you change to another tool. When the Reuse button is
deselected, when you change to another tool, a new window opens.

Figure 11: ReuseButton Selected
] Heuse|

For example, with Reuse desdlected, double-clicking a symbol to display its symbol
definition opens anew Editor window. Y our previous Editor window remains
unchanged. Reuse is selected by default.

Preserving Context Between Windows

Selecting the Context button from a window's status line preserves the context of a
selected symbol when you switch between tool€otitext is deselected, the new
tool opens to the default or empty condition.
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Figure 12: Context Button Selected

] Cnnte>¢t|

For example, if aparticular classis selected in the Editor, the same classis displayed
when you change to the Class Browser. Context is selected by default. When
Context is not selected, the Class Browser opens with whatever was previously

displayed.
Adjusting Column Width Size

The column dividers allow you to adjust the width of columns on the screen. You can
adjust the size of a column by moving your cursor over the divider until the left-right
arrows appear, then clicking and dragging the column divider to the desired position.

Figure 13: Adjusting Column Width
i

File | Directory | Type

B age.. |share/de.. |c++
&~ Arent

Using Filters

Source-Navigator provides several waysto filter the symbolsdisplayed in the Symbol
Browser. You can:

. usethelList Filter buttons (see page 39).
. usethe Symbol Selectorsfrom the View menu.
« use Column Filters (see page 41).

Symbol Selectors

Although the List Filter buttons allow you to search by classes, methods, functions,
and project files, the Symbol Selector provides a more complete list of search
choices. In the Symbol Browser window, from the View menu, select Symbol
Selectors.
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Figure 14: Symbol Selectors Menu

W Exclusive Search

| Classes

|~ Constants

|~ Enums

|~ Enum Yalues

|~ Function Declarations
|~ Friends

|~ Eunctions

|~ Wariahles

[ Instance Yariahles

|~ Macros

I~ Methods

|~ Method Implementations
|~ Typedefs

a

W Files

If the Exclusive Sear ch box is selected, you may choose only one symbol type to
search for; if it's deselected, you may combine symbol types for more complex

searches.

Pattern Box

In large projects, thousands of symbols may be listed in any list view. To list a subset,
or to restrict a symbol list, use tRattern search field. When text is typed in this

field, the list updates to show only the symbols or components matching that pattern.
For instance, wheXariables is selected in th8ymbol Browser or Symbol

Accelerator, typing* gv* in thePattern: field shows all global variables in the file or
project. See “Symbol and Type Abbreviations” on page 15 for a list of pattern

abbreviations.

Pattern: ¥

ThePattern text box allows you to search in a tool for a particular pattern. Patterns
are not case sensitive.

Table 1: Pattern Interpretation of Special Characters

Special Character

Interpretation in Filter or Pattern Boxes

*

Matches any sequence of zero or more characters.

? Matches a single character.

[ char s] Matches any single character in char s. If char s
contains a sequence of the form c- x, any character
between ¢ and x inclusive will match.

\? Matches the ? character exactly, avoiding specia

interpretation of the character. Also appliesto the

following characters: [ ,],*, ?,and\ .
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For example, *. [ hc] matchesall stringswith*. C,*. H, *. ¢, and *. h extensions,
[ 0- 9] * matches all symbols beginning with a number.

With Agent * entered into the Patter n text box, and Classes, M ethods, and Files
chosen from the View menu, the results would be as shown in Figure 15.

Figure 15 Symbol Browser Showing Filter Results

Source-Mavigator [c++_demo] Symbols  |M|EIES
File View Tools History  Windows Help
BEEL ek
Pattern: |Bgem1* | Search
Mame | Class/Directary

TE bgent(cl)

MO Bgentimd) Igent
Igent. oo glish
Igent.h glish
M{) BgentID{md) Igent
M) BgentPtrimd) Value
M) BgentPtrimd) Value
H[) BgentRecord(md) Bgent
Hi) RBgentTaskimd) Iigent
M) EgentTaskimd) Tark
M) BgentVal (md) Value

—I -

To clear the text box for another search, type Ctrl+U.

Printing from Source-Navigator

To print the contents of Source-Navigator browsers, such as the Editor or
Cross-Reference Browser, from the File menu, select Print.

Print Dialog

The print dialog box varies with different printers, printer drivers, and platforms.
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UNIX
Figure 16: UNIX Print Dialog

Print.. Source-MNavigator \[c++_demo'] Agenth
tinter command |pr -h " Source-Navigator  [ctt_demol] Bgent.h" -166 —od | lpr

~r Selection

¥ All

Ok | Cancel |

The default command line shown in the Printer command text box is set from the
Otherstab of the Project Preferences dialog (see “Others tab” on page 31).

ChooseSelection to print only the highlighted portion of the file (if you do not
highlight any part of the file, the entire file is printed).

ChooseAll to print the entire file.

Windows
Figure17: WindowsPrint Dialog
Print HE
— Prirter
Mame: WWPRINTHOS Theng Properties |
Status: Feady
Type: HF Lazerlet 55i/A5i Mx PS
Where:  SAWPRINTHOSTheng
Comment; ™ Frint ta file
— Print range Copie:
& Al Mumber of copies: |1 3:
1 Fames o IU o ID
) Selestion Ijl
()8 I Cancel
Printer
Name
Choose the name of the desired printer.
Print to file

Check this box to print to a file.

NOTE If you choosePrint to file, a dialog box appears after clicki®i. Type the
desired filename (alone or with a path to a specific directory) i@thput
File Name text box and cliclOK.

If you enter the filename without a path, your file is saved in the same
directory as the project file.
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Print range

All
Prints the contents of the entirefile.

Copies

Number of copies
Choose the number of copiesto print.

Properties
If you click the Properties button, the Document Properties dialog appears.
Figure 18: Document Properties Dialog

E \\pc-printhost\eng Document Properties EHE

| Advanced I

Paper Si;e:l @ Letter j
Paper Source: | (] Automatically Select j
LCopy Eount:l‘l 3: Copy
[1-939)

r— Orientation

& Portrait " Landscape " Fotated
r— Print on Both Sides [Duplex Printing)

& Mone A1 " Short Side EE " Long Side
A

()8 I Cancel |

The optionsin this dialog box depend on which printer you have selected, but usually
include paper size, orientation, and duplex printing. For more information on these
options, see your printer documentation.
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Customizing Source-Navigator

This chapter describes how to customize Source-Navigator to reflect your preferences.
For additional information on changing the start-up and runtime behaviors, see
“Customization” on page 137.

Preferences Dialog

Use thePreferences dialog to specify project-specific parameters. InShebol
Browser, from theFile menu, seled®roject — Project Preferences and enter your
changes in the dialog. Cli€BK to update the project with the current settings.

NOTE  Default values may be transferred from the previously created
project, some options take effect only in new windows, and some
options only take effect the next time the project is opened.
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Figure 19: Project Tab of the Preferences Dialog

Source-Mavigator [c++_demo] Preferences

Froject | Edit | Clags/Hierarchy | ﬁrefl Include | Parser | Mersion Control | Others | Colors&Fonts |
— Project

Read-only project =

Refresh project upon startup =
— Database

Database directory name =] |
Fermissions W ruser W wuser W rgroup B Owogroup g rother | owoother

Build comment database =

Datahase cache size 300 KBytes
H-reference databaze cache size 3000 KBytes
— Window

Split Wincdows: ~- Horizontal 4 Wertical

Mew Windows W Reuseable W Keep context

Window size is 65 % of screen size
— Internationalization

Character set encoding imoB859-1 j

Ok | Apply | Save as Defaulf | Cancel |

General Project Preferences

Descriptions of the general Preferencestabs (Project, Parser, Others, and Colors &
Fonts) areincluded in this section. The following tabs are discussed in the relevant
chapters:

Edit see “Editor Preferences” on page 51.

Class/Hierarchy see “Class/Hierarchy Preferences” on page 59.
Xref see “Cross-Reference Preferences” on page 69.

Include see “Include Preferences” on page 75.

Version Control see “Version Control Preferences” on page 94.

Project tab

Project

Read-only project
Select this if the project should be read-only. Default is off.

Refresh project upon startup
Select this when files are likely to be changed by other developers, or when you
want to be sure that your database is in sync with your sources when you start.
Default is off.
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Changing this to on may cause delays when opening your project. For large
source bases that are relatively stable, or where network latency is a problem, set
thisto off and periodically, from the Tools menu, select Refresh Project to resync
the database with the source.

Database

Database directory name
Source-Navigator creates al database files under this directory. If the directory
already exists, you will need read and write permissions for it. If you're creating a
new directory, you will need permission to create it.

The filesystem for this directory must contain free disk space equal to the size of
the source base without cross-references, and up to about ten times the size of th
source code if you choose to generate cross-references. If you don't have the
necessary permissions (for example, if it is a read-only filesystem), or if there is
insufficient free disk space in your first choice of location, you may create your
project directory in another location on your network by entering a directory name
with its absolute path.

This option can be changed only when creating a project.

Permissions
These buttons control the read-write permissions for your project: the first set
controls access for the creator of the file, the second set for the group, and the
third for “others” (everyone else on the network).

Build comment database
Select this to store comment strings in the database. Default is off.

Database cache size
Caches improve performance by using memory (fast) instead of disk (slow) where
possible. Larger cache sizes increase the likelihood that data will be found in
memory rather than on disk, though overallocating caches has the opposite effect.
The operating system will swap the cache to disk and the system will get
dramatically slower. The cache defaults are generous for most projects; don't
increase them without a reason.

This option can be changed only when creating a project.

Enter the database cache size (in kilobytes) or accept the default value.
Source-Navigator creates the project database (in the background) with the
specified cache size. Increasing this amount speeds up project creation and data
access, but requires that more memory be allocated to Source-Navigator.

The recommended maximum is the amount of free RAM divided by 16, up to a
maximum of four MB. The total of this amount plus the amount allocated to the
cross-reference database cache should not exceed one quarter of the total memol

For more details about this parameter, sH®open for Tcl” on page 168.
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X-reference (Cross-Reference) database cache size
Enter the Cross-Reference database cache size in kilobytes or accept the default
value. Source-Navigator creates the project cross-reference database with this
cache size. Increasing this amount speeds up cross-reference creation and data
access but requires that more memory be allocated to Source-Navigator.

This option can be changed only when creating a project.

The recommended maximum size is the amount of system memory divided by 32,

up to eight MB. Thetotal of thisamount plus the amount allocated to the database

cache should not exceed one quarter of the total memory.

For more details about this parameter, sHeopen for Tcl” on page 168.
Window

Split Windows
These buttons control where new views appear when you add a view to an
existing window (from th&Vindows menu, selecAdd View).

SelectHorizontal to have new views appear to the right of the current pane; select
Vertical to have new views appear below the current pane.

New Windows
SelectingReusable causes new information to appear in the current window;
deselecting it causes a new window to appear when you choose a new symbol,
tool, or view.

SelectingKk eep Context causes new tool windows to be opened to the same
symbol context as the current window; deselecting it causes a new tool to be
empty when opened.

Window size is
This setting controls the size of newly-created Source-Navigator windows. You
may also resize the windows after they are created.

Internationalization

Character set encoding
This combo-box allows you to choose the character set encoding for your project
to match the character set of your source files.

The default character set for English, German, and most other European
languages is ISO8859-1. For Japanese, the default character set is Shift-JIS.

Parser tab

Source-Navigator uses plug-in parsers to parse multiple programming languages.
Choosing the appropriate parser is based on file extensions.
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Figure 20: Parser Tab of the Preferences Dialog

Source-Mavigator [c++_demo] Preferences
Project | Edit | Clags/Hierarchy | Xref | Include | Parser | Wersion Control | Others | Colors&Fonts
— Language Extensions
asm *oasm *.3 *.5 External Editor _l
C++ * [hHeo] *. [chlzx *. [ch]pp *.cc *.hh *+ [CH]EX *. [CH]PP *.CC *.HH External Editor _I
cobol  [*.chl *. cob External Editor =
faran  |+.f * for *.FOR External Editor =
java * jawva External Editor _l
others * [ly] *[IMm]akefile *. =m *.in *.md *. txt External Editor _l
python . py *pyw External Editor _l
tcl *. tcl *.itel *+ itk * th * test External Editor _l
— CfC++ macro filename(s)
J;I
¥
Ok | Apply | Save as Default | Cancel |

Source-Navigator is pre-configured for the most commonly used file types; these can
be changed and new parsers can be added. For more information on adding parsers,
see “Adding Parsers” on page 153.

Table 2: File Types and Associated Filename Extensions

Parse sourcefilesas File Extensions

PowerPC 601 assembly *,asm*.s *. S

C/C++ * [hHcCl *.[ch]xx *.[ch]lpp *.cc *.hh
*

* [CH XX *.[CH PP *.CC P

Caobol *.cbl *.cob

FORTRAN *f *. for *. FOR

Java * . java

others *[ly] *[I1M]akefile *.am*.in *.nd
*otxt

Tcl[incr Tcl] *tel *oitel *.itk *.tk

After each of the languages is Brternal Editor text box; you may type in the
executable (shell) command for an external editor, or you may click thieutton to
browse. If you leave the text box blank, Source-Navigator uses its built-in editor.
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Macro processing

Macros make the task of source code analysis more complicated, and thereisno single
right way to handle them. By default, Source-Navigator treats them as opague
symbols and, aside from recording where they are defined, it ignores them completely.
This behavior not only makes parsing substantially faster than true compilation, but it
also preservesthelayer of source code abstraction that is presented inthe Editor. This
behavior is particularly useful when maintaining software that must run on multiple
platforms, and you would like to see all of the impacts that a change might have,
regardless of a macro’s platform definition.

For some projects and/or tasks, this layer of abstraction is a barrier to code
comprehension. For these cases, you can direct Source-Navigator to define and
expand macros in one of four ways:
« define
defi ne is used to insert a symbol into Source-Navigator’'s preprocessor
namespace. If yodef i ne FOO (or#defi ne FOO, the leadingt is optional),
then conditionals that test f def / #i f ndef are scanned according to the
#i f def / #i f ndef test.FOOwill be replaced with the empty string.

defi ne can also be used to give a symbol a value (sudkfasne FOO BAR).

This will not only inject the symbol into the namespace, but will cause
Source-Navigator to sc@RAR whenever it sees tHO macro. This is

particularly useful foDEFUN or PROTO macros that are used to bridge between
K&R and ANSI C at the source code comprehension level. It is also useful when
macros test numerical results, such#iaks (X >= Y) or #f X

def i ne macros can take arguments, just as in C and C++, and they can expand
recursively. For exampl&00 might expand t@AR (5) which might then
expand towunbl e (5, 5, 0);in this case Source-Navigator would only see
munble (5, 5, 0).

« replace
repl ace is just likedef i ne, except that the symbol is not injected into the
namespace. Thus, if you want to expand macros, but not have conditional code
compiled away, useepl ace.

The macro processor does not suppattl ude, token concatenation, ANSI
stringification, or other pre-processor directives. These may be implemented in a
future release.

« delete
Source-Navigator lets you use more than one macro file in a project. You can
specify a macro in one file and then delete it from the preprocessor namespace
usingdel et e in a second macro file.

« undef
undef doesn’t do any substitution, it just affects the evaluatiofi 6f #i f def ,
and#i f ndef statements.
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Defining and using macro files

Source-Navigator parses, but does not interpret, macro definitions in your project
files. It only interprets macro definitions from files you specify explicitly in the parser
preferences of your project. Because multiple files may be specified, you may want to
organize your macro files according to global, per-user, and per-project divisions.
Thisorder isimportant, because Source-Navigator uses the last encountered definition
for the macro.

Macro filesare ASCII files and every non-blank lineis amacro directive. Leading
blanks and # characters are stripped, and if the first character of alineisan apostrophe
(), thelineistreated as acomment. The macro file can contain continuation lines, for
example:

define ABC\
\
5

Others tab

The Other stab allows you to configure external interfaces.
Figure21: OthersTab of the Preferences Dialog

Source-Mavigator [c++_demo] Preferences

Froject | Edit | Clags/Hierarchy | ﬁrefl Include | Parser | Mersion Control I Others | Colors&Fonts |

— Build

make |
— HTML viewer

netscape —remokte cpenURLiEs) |

Eug reports
’VMaiIhost mailhost ‘

— Printer
ASCI Print Command pr -h "%s" -166 —od | lpr

an

Frint Command lpr

— Insight Debugger command
gdb

Retriever
’V_| Do not display the warning dialog for multiple matches ‘

Ok | Apply | Save as Defaulf | Cancel |

Build
Type the executable (shell) command used to start your make system.
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HTML viewer
Enter the HTML viewer to display online help. From Help, select Online
M anuals to open the viewer, which must be included in your path.

This preference can only be set in UNIX.

Bug reports

Mailhost
Source-Navigator supports sending bug report emails by SMTP. Enter the name of
your SMTP mail server in thisfield.

Printer
Printer preferences can only be set in UNIX.

ASCII Print Command
Enter the command you use when printing a source file from the command line.

Print Command
Enter the print command appropriate for your system. For example, Linux-based
systemsusel pr.

On Windows, Source-Navigator uses the Windows Registry Editor to decide how to
print.

Insight Debugger command
gdb isthe executable (shell) command used to start | nsight.
Retriever

Do not display the warning dialog for multiple matches
Select thisif you do not want to be warned when the Retriever finds more than
one symbol with the name you are searching for. See page 79 for more
information about the Retriever.

Colors & Fonts tab

Source-Navigator assigns a different default color to each component of your source
code. To customize these colors or choose different fonts, click the Colors & Fonts
tab of the Preferences dialog.
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Figure22: Colors& FontsTab of the Preferences Dialog

Source-Mavigator [c++_demo] Preferences

Froject | Edit | Clags/Hierarchy | ﬁrefl Include | Parser | Mersion Control | Others I Colors&Fonts |

Default vJ

EH] Seneral K
[ standard Sample
[ Layout
[ Highlighting
[ Bold Font
[ selecticn Eont

5[] Bditer
[ Text
[] Punctiens | fu) Background
[] Functien Declaraticns (£d)
[] subroutines (sul
[ strings
[ Comments
[ ¥evwords
[] classes (cl)
[0 ™pedefs ()
[ Enums (=)
[ Enum Valuss [ec)
[] Methed Definiticns (md)
[] Friends (fr)
[] Methed Implementaticns (mi) 7

Ok | Apply | Save as Defaulf | Cancel |

From thelist of components, choose the item you want to change. The current settings
appear in the Font, Foreground, and Background text boxes, and “Sample” displays
the text with these settings.

Changing Fonts
Changing the font assigned to a component varies, depending upon your platform.

On UNIX, click the “..” button at the end of thieont text entry box. Th€hoose
Font dialog appeatrs:

Figure23: UNIX Font Dialog

Foreground

LA

Choose Font

Sample

Family |adabe jName Courier jSize 1z j

1 Bald _j ltalics

’Tl Apply | Cancel |

Choose thé&amily, Name, andSize of the font that you would like, as well Bsld or
Italics, if you want to use those properties. Click &mply button to see the effect of
your changes and, when you are satisfied, @Bk Your changes take effect the next
time you start Source-Navigator.
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On Windows, click the.!.” button at the end of théont text entry box. Thé&ont
window appears.

Figure 24. Windows Font Dialog

Font 21=]

Font style: Size:

IHeguIar IS QK I
Fegiz— plc 8
Italc 10 Caec) |

Roman Bald 12
Script Bold Italic 14
Small Fonts
B Symbal
System

ETT
=
=

— Sample

| AaBbvyZz

Script:

IWestern hd l

Choose thé-ont, Font style, andSize of the font to use and your changes appear in
the Sample box. When you are satisfied, cli€. Your changes take effect the next
time you access the item you changed.

Changing Colors

You may want to change the Foreground or Background colors from their default
settings if they do not show up well on your laptop or CRT display, or if your code
colorization conventions do not match Source-Navigator's default colors.

To choose a different color for any component, you must set new RGB

(Red-Green-Blue) values. Click the Foreground or Backgrouricutton. The
Choose Color dialog appears.
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Figure 25. Choose Color Dialog

Choose Color

Ok | Apply | Cancel |

Movethered, green, and blue sliders until the color you want appearsin the box at the
top of the dialog. Click the Apply button to see how your text or background looks
with the new color. If you are satisfied, click OK. Y our changes take effect the next

time you start Source-Navigator.
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Symbol Browser

The Symbol Browser window is displayed when you first create or open a project. It
is the main window for navigating between Source-Navigator symbols. The Symbol

Browser shows high-level information about the project, such asfiles, definitions,
functions, variables, or classes/methods.
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Figure 26: Symbol Browser Window

Source-Mavigator [c++_demo] Symbols  |M|EIES
Toolbar buttons m——— _ _
File View Tools History  Windows Help
A mEm )
Pattern: ¥ Search |
File | Directory
Right-click TRy #ent. co alish
for column filter; % e oo I .
left-click to sort [ sinopesr.h alieh Symbol list box,
B euiletn o slien py?ﬁrhglé%d
: : [} Builtin.h glish 0 the Itor
Click to I|st/_,3 I PLioh
symb0|s 3 Client.cc glish
H . 3 Client.h glish/include/G14
n flle 3 Complex. oo glish
3 Complex.h glish/include/G14
3 complete. o editline
3 Dict.co glish
3 Dict.h glish/include/G14
3 direc.h rds/ include/ 2ds
[}| Epicethannel.co contrib/ epice 7
1 B
|

Using the Symbol Browser

Each symbol in the Symbal list box is hyperlinked to the Editor. Double-clicking on
asymbol startsthe Editor, which displaysthe symbol in the source file. Depending on
your settingsin the Edit tab of the Preferences dialog, the cursor is positioned on the
location where the symbol is declared or defined. For information on the Editor, see

page 45.
Toolbar Buttons

Tool icons are located in the Symbol Browser under the main menu bar. To find out
what atool does, move the cursor over it; atooltip appears describing the tool. The
toolbar is shown in its default configuration in Figure 27.
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Figure 27: The Default Toolbar
—_— EH
-| oo |~E #E| =

Browser buttons

With the toolbar, you can access many of the browsers you will use most often.
However, you can add or remove toolbar buttons and menus. For more information,
see “Customization” on page 137.

Em

7 o)

Toolbar buttons provide quick access to the following Source-Navigator functions:
Hierarchy Browser button

——|  Sdlect this button to start the Hier archy Browser. For more

“‘n’\, information about thistool, see page 57.

Class Browser button

Iﬁ:ﬁf- This button starts the Class Browser. For more information
about thistool, see page 61.

Cross-Reference Browser button

Select this button to start the Cross-Reference Browser. For
more information about this tool, see page 65.

Include Browser button

e

Select this button to start the Include Browser. For more
information about thistool, see page 73.

List Filter buttons

ThelList Filter searches for specific types of symbols in the symbol database. Use the
List Filter buttons to restrict searches by symbol type insyrabol Browser.
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Figure28: Filter Toolbar Buttons

L]
5 B = )

For details on how to filter for other symbols, see “Using Filters” on page 19.

Symbol Filters

The Symbol list box displays different kinds of project symbols, depending on which
type of symbol you select from ti8ymbol-type selector (accessed through theew
menu). IfExclusive Search is selected, then only one symbol type is displayed at a
time. If Exclusive Search is deselected, then clicking additional symbol-type
selectors adds those symbols to the existing contents Sfthigol list box.

Figure29: Symbol Browser with Exclusive Sear ch and Classes Selected

Source-Mavigator [c++_demo] Symbols  |M|EIES
File View Tools History  Windows Help
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=] o|-E 88 B EE |
Pattern: |r" | Search |
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T2 hoceptSelectes(cl) glish/ Sequencer.c K
2 hoceptSocketicl) glirh/Socket.h =l
2 hotivateStmbicl) glish/Stmt.h
%2 hotual Parameter(cl) glish/Func.h
T2 Bgenticl) glish/RBgent.h
%2 mndExpricl) glish/Expr.h
%@ mrithExpricl) glish/BinCpExpr.k
2 hrrayRefExpricl) glish/Expr.h
2 BesignExpricl) glish/Expr.h
2 httributeRefExpricl) glish/Expr.h
T2 mwaitStmbicl) glish/Stmt.h /
- e

To find the number of symbols matching your selection, right-click irsyinebol list
box. From the popup menu you may sort the symbol list by column and hide columns
to simplify the display.
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Figure 30: Symbol Browser Right Button Menu
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For faster searching you can use the toolbar buttons to browse project files, functions,
methods, and classes. For more information on the toolbar see “Toolbar Buttons” on

page 38.

Column Filters

Column filters override all other filter preferences, and allow you to constrain the
contents of a list view by filtering by a certain pattern. They are available in any
window where information is presented in columns, such aSytméol Browser,
Class Browser, andRetriever windows.

Right-click on the column header and it is replaced by a column filter box.
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Figure 31: Column Filter Box
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Typein apattern and pressthe Enter key. Thelist displays al symbols matching your
pattern.

Figure 32: Symbol Browser Showing Pattern Matches

Source-Mavigator [c++_demo] Symbols  |M|EIES

File Miew Tools History  Windows Help

SEET RSk

Pattern: |r' | Search
Column filter Narme(agent’) | File

T@ Bgent{cl) glish/Bgent.h

If you left-click on the column header, it sorts the data by that column.
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Figure 33: Column Data Sorted
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Editor

Source-Navigator allows you to edit source files with its built-in editor, or with an

external editor that you select in the Edit tab of the Preferences dialog (see “Editor
Preferences” on page 51). For instructions on how to specify an external editor, see
“Common editor configurations” on page 53.

The Editor Window

To open theeditor, double-click a symbol in th®ymbol Browser (or other
Source-Navigator browser window). Symbols are hyperlinked t&diter, which
displays the contents of a project source file and allows you to edit it.

When you save a modified source file, the project database is updated and changes a
reflected in all of the Source-Navigator tools. Standard mouse operations are
supported in th&ditor:

. click on the text and new text will be inserted to the right of the cursor.

» clicking and dragging selects text so that operations suChtag€opy, andPaste
can be performed.

. clicking and dragging in the scroll bars scrolls the file appropriately.
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line.
Figure 34: Editor Window

Symbol accelerator
combo-box

double-clicking on aword selects the entire word; triple-clicking sel ectsthe entire

Find box (enter

search pattern) Select previous

search pattern

Previous Source-Mavigator [c++_demo] Agenth
File Edit Search Tools History W Help
nl s f
ifd M haJlEEA)S
Next Edit | Hierarchy | Class | ﬁrefl Include | Retriever | Grep |
5
#ifndef agent h
#define J
Text

#include "Stmt.h"

class Value;
class Sequencer:
class Frame;
class Task:
class Bgent;l

struct focbar {
int a;
int b;

} :

declare(Limt, string) ;

typedef Listi{mtring) string list;

(W Reuse|[W Context|

12i12||!”to0Isuitefsharefdem0sfc++_demofglishmgent.h: 141

Line, Column number

Symbol Accelerator

The Symbol Accelerator
through your source code.

Combo-box

combo-box in the toolbar alows you to quickly navigate
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Figure 35: Symbol Accelerator Combo-box

AgentID(mi) Agent j
Bgent(cl) 'S % Related
Agent(md) Agent Al
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AgentID(md) Agent All | MNone |

AgentID(mi) Agent
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AgentTask (md) Agent

W Friends
AssociatedStatements (md) Ac X
agents (gv) W Functions
agent_h(ma) ] W Variables
|-_\|L n i niaoos | — W Macros
Fattern: '+ =

When the Editor is open this combo-box lists al of the symbolsin the open file.
When the All button is clicked, al of the symbols within the entire project are

displayed. When other tools are open, the Symbol Accelerator combo-box lists the
components relative to the tool.

For instance, inthe Class Browser, it listsonly classesin the file. When the All button
isclicked, al of the classesin the project are displayed.

Notice that the Symbol Accelerator text field in the toolbar displays the component
that is referenced as the Editor’s cursor moves through the file.

Find Box

You can use th&ind box in the toolbar to search for text. Type text into the text box
and press thEnter key; the next instance of the text is found. To find a previously
used pattern, click theind box down arrow to see a list of previous patterns. Select
one of the patterns with the mouse and the next instance of that pattern is found.

Pattern Searching

Use these buttons to search the window or the project database for a symbol.
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Figure 36: Pattern Searching Toolbar Buttons
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The Extended Toolbar

The extended toolbar provides buttons to manage your files and text. To add this
toolbar to Source-Navigator, from the File menu, select Project Preferences. Select
the Edit tab and select the Extended Toolbar Buttonsbox.
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Figure 37: Fileand Text Management Toolbar Buttons
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View History

Source-Navigator provides complex information in a number of ways. Asyou
navigate through a project, you may want to return to the view of arelationship that
you previoudly investigated. Source-Navigator stores aview history of your journey
through the project. The left and right arrows in the toolbar act like Back and
Forward buttons in popular Web browsers. Y ou can also right-click on one of these
buttons to get alist of previoudly visited locations within the project.

Figure 38: View History Buttons

For more detailed history, the History menu lists previous views on a per-tool basis.
Thislets you jump directly to the view you want, rather than paging through previous
views.

Search Menu

The Sear ch menu is context-sensitive; different options are available depending upon
the tool you are using.

Find dialog
To find aspecific string or pattern in the text file, from the Sear ch menu, select Find.
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Figure 39: Find Dialog

Source-MNavigator [c++_demo] Search for

Search |
Search pattern: |Bgem1 |
Cancel |
W lgnore case

_1 Regular expression
W Forward

Typeyour string or pattern into the text box and click the Sear ch button; you can click
the Sear ch button multiple times to find more instances of the string. Deselect 1gnore
case if you want a case-sensitive search. When Regular expression is selected, the

pattern istreated as aregular expression, and clicking the Sear ch button finds the next
match for the regular expression. Deselect Forward if you wish to search backwards.

Replace dialog

To search and replace a specific string or pattern in the text file, from the Search
menu, select Replace.

Figure40: Replace Dialog

Zource-Mavigator [c++_demo] Find - Replace

Search pattern: |hgent | Search
Replace pattern:
Cancel |
W lgnore case |
_1 Regular expression
W Fonward All |

The Replace dialog is similar to the Find dialog. The Ignore case, Regular
expression, and Forward options behave the same way. Sear ch finds the next
instance of the pattern. Replace replaces the current pattern with the pattern in the
Replace pattern text box. Select All to replace all occurrences of the pattern.

Find Declaration, Implementation

If asymbol is selected in the Editor, selecting Find Declar ation switchesto the
location of the declaration of the symbol, and Find | mplementation switches to the
location of the implementation of the symbal.

NOTE You can aso toggle between Declaration and Implementation by using the
keyboard shortcut commands Ctrl+Shift+D and Ctrl+Shift+l, respectively.
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Grep

Grep activates the Grep tool, which allows you to search for text in all project files.
Select the expression you want to search for and from the Sear ch menu select Grep.

Source-Navigator automatically searches for your text in all project files. For more
information on Grep, see page 83.

Go To menu

When you want to go to a specific line in the file, from the Search menu, select
GoTo - GoToLine. Thisalowsyou to type in the line number you wish to go to.
Set Mark allows you to set a place in the file you wish to come back to later.

Go To Mark jumpsto the last mark you set. Go to Error displaysthelinethat caused
the build error.

Editor Preferences
You'll find preference settings for tHeditor window in theEdit tab of the
Preferences dialog. To find this dialog:

1. In theSymbol Browser, from theFile menu, seledProject Preferences. In the
Editor, from theEdit menu, selectiew Preferences.

2. Choose thé&dit tab.
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Figure4l: Edit Tab of the Preferences Dialog

Source-Mavigator [c++_demo] Preferences

Froject I Edit | Clags/Hierarchy | ﬁrefl Include | Parser | Version Control | Others | Colors&Fonts |

— Format

Tah stop g

Auto Indent width g

Wrap by 4 Mone - Character - ‘Word

— Work

Create “.bak Files =

Cutput Eile Translation: 4 Keep - Auto ~- UNIX - Windows - Macintosh

Eracket match delay 500

Right mouse supports: 4 Edit menu ~- Scrolling

Translate Tahs To Spaces =

Extended toolbar buttons =

External Editar |

LI Apply Save as Defaulf ﬂl

Format
Tab stop

When atab isinserted, it is this many spaces wide.
Auto Indent width

When the Enter key is pressed, thisisthe number of spacesinserted at the
beginning of the next line. Thisis also the number of spaces inserted by indent
(from the Edit menu, select Indent Text) and deleted by outdent (from the Edit
menu, select Outdent Text) when reformatting source code.

Wrap by

This controls where the Editor breaks aline that islonger than the width of the
window.

Work

Create*. bak Files
If selected, the Editor creates backup files whenever you save afile.
Output File Translation
End-of-lines of source files may be represented differently on different platforms:
- Keep retains the original file’s end-of-line characters; this is set by default.
e Auto saves the file with your current platform’s end-of-line characters.
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« UNIX, Windows, or Macintosh sets the end-of-line characters to match the
platform you choose, regardless of the platform you're working on.

Bracket match delay
Sets the amount of time (in milliseconds) that matching brackets should be
highlighted.

Right mouse supports
If Edit menu is selected, you can access some functions, sudhdis Delete,
Cut, Copy, andPaste through a right-mouse pop-up menu.

If Scrolling is selected, you can scroll the text in Bditor using the right-mouse
button.

Translate Tabs to Spaces
Selecting this converts all tab characters in the file to the number of spaces shown
in theTab Sop box.

Extended toolbar buttons
Selecting this adds several new tool buttons tdetieor toolbar. For more
information, see “The Extended Toolbar” on page 48.

External Editor

Insert the command line for your favorite editor in this text box. See “Common
editor configurations” for command line syntax.

Source-Navigator can set the position of the cursor in the editor if the editor can
be configured by command line options. Source-Navigator can perform the
following substitutions on the command line before it is executed:

o6 file name
% line number
o%c column number

%l project directory

Common editor configurations

Emacs
Sarting a new Emacs session: To start a new Emacs session whenever you view
source code, entenacs or the name of the executable file of Emacs in either the
External Editor text box in theEdit preferences tab or at the command line. For
example, entefermacs or xenacs, without any parameters. The strigigacs
must be found in the command if you want the changes you make and save to be
immediately stored in the database (without terminating Emacs).

Using a current Emacs session: For instructions on how to configure
Source-Navigator to communicate with a currently running Emacs session, see
“Using Emacs as your Editor”.

Notepad
On Windows, you can invoke Notepad by typing:
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not epad %
Vi
To invoke the vi editor, you must enter the following into either the External
Editor text box in the Edit preferencestab or at the command line:
xterm-T % -e vi +% %
The modifications you make and save are stored in the database only after you
quit vi.
Windows NT can execute DOS executables without launching a shell. The
command line for a DOS version of vi is:
vi +% %
For information on customizing your key bindings or using another external editor,
see “Customization” on page 137.

Using Emacs as your Editor

Source-Navigator supports GNU Emacs 19.34 and XEmacs 19.14; other versions may
also work, although these have not been tested.

When you use Emacs as your editor, Source-Navigator displays files in an Emacs
window. Whenever Emacs saves a file, Source-Navigator updates the database.
Multiple projects can share a single Emacs editing session.

You can use Emacs with Source-Navigator in one of two ways:

. to start a new Emacs process whenever you make an edit request.

. to communicate with an already running Emacs process.

To Start a New Emacs Process

Enteremacs (or the name of your program with the stringacs) in theExter nal
Editor text box of theEdit preferences tab.
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To Communicate with an Already Running Emacs
Process

1. Modify your Emacs start-up file so that gnuser v utility, which is provided in
your Emacs distribution, is loaded. Thisinvolves adding two linesto your Emacs
start-up file (usually ~/ emacs). You need to enter the full path to your Emacs
directory:

(1 oad " pat h-to- Emacs-1/ocation/|ispl/gnuserv")
(server-start)

See your Emacs documentation for additional information.
2. Inthe External Editor text box, set your editor to gnucl i ent .
When you start a new Emacs session, Source-Navigator can now request that the

running Emacs session bring up files for editing. Source-Navigator aso rescans
the files when you finish editing.

NOTE If you use xeracs, the gnuser v package isincluded; see your X Emacs
documentation for instructions on loading it.

Source-Navigator's search function replacesfthed- t ag command when you
search for a symbol. Because the other tag commands are not yet available inside
Source-Navigator, you need to use the equivaeats commands, if available.
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Hierarchy Browser =Sg

Inheritance, atype of relationship between objects, alows one object to share
behavior with one or more other objects. Inheritance provides a basic mechanism for
the reuse of code. Sharing with more than one is known as multiple inheritance.

The Hierarchy Browser can display the entire class hierarchy, including the
superclasses and subclasses of a selected class. This helps you understand class
hierarchy trees, which in turn helps you to reuse existing code.

A baseclassis atop-level classin the class hierarchy. It does not inherit from any
other class; other classesinherit from it.

A classaissaid to be asuperclass of class b when class b inherits from a or another
class that inherits from a.

A classaissaid to be a subclass of class b when class a inherits from b or another
class that inherits from b.

If classaisasuperclass of classb, then classb is a subclass of classa.

Using the Hierarchy Browser

Start the Hierarchy Browser in one of the following ways:
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. fromthe Windows menu, select New View - Hierarchy.
. click the Hierarchy toolbar button.
. choosethe Hierarchy tab.

Figure42: Hierarchy Browser Window

Shows entire Shows class, baseclasses, Shows class and
class hierarchy and superclasses superclasses only

Zource-Mavigator [u++ _demo] Class Hierarchy: GlishOhject
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Edit | Hierarchy | Class | ﬁrefl Include | Retriever | Grep |
G.l:'lshQ'Djecg__pAgent, Scripthgent K
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s Delch]
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—whttributeRefExpr
—=BinOpEXpr ATithEXpr
FolEXpr
¥
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|l Reuse||l Context“ ||Elaseclasses: 0, Superclasses: 13

Shows number of baseclasses
and superclasses in hierarchy

Tools Menu

The Hierarchy menu, accessed from the Tools menu, contains the following items,
which control how the class hierarchies are displayed.
Show Superclasses
Limitsthe hierarchy to the superclasses (and their subclasses) of the selected
class.
Show Subclasses
Limits the hierarchy to the subclasses of the selected class.
Show All
Thisis the default for this menu.
Display file names
Displays the file names of the superclasses and subclasses.

58 m Reference Guide Red Hat Source-Navigator



Using the Hierarchy Browser

Class/Hierarchy Preferences
Many of the settings that control how the Hierarchy Browser window functions are
located in the Class/Hier ar chy tab of the Preferences dialog. To find this dialog:

1. Inthe Symbol Browser, from the File menu, select Project Preferences. In the
Hierarchy Browser, from the File menu, select View Preferences.

2. Choosethe ClasgHierarchy tab.
Figure43: Clasg/Hierarchy Tab of the Preferences Dialog

— Class

Source-Mavigator [c++_demo] Preferences

Froject | Edit I Clags/Hierarchy | ﬁrefl Include | Parser | Mersion Control | Others | Colors&Fonts |

Go To
Origntation
Display members

~ Declaration 4 Implementation
~- Horizontal 4 Wertical
4 First ~ Second

— Hierarchy Layout

Display order:
Display layout style:

Wertical space:

Huorizontal space:

4 Leftto right -~ Top to Bottom

~ Tree @ [3]

680
10

Ok | Apply | Save as Defaulf | Cancel |

Class
Go To

Select Declaration if you want the Class Browser to display the prototype of the
function; select Implementation if you want to see the actual code.

Orientation

Select Horizontal to have the Hierarchy Browser appear below the Class
Browser; select Vertical to have the Hierarchy Browser appear to the right of

the Class Browser.
Display members

Select First to cause instance variables to appear before methods in the Class
Browser; select Second to cause methods to appear first, with the instance

variables after them.

Red Hat Source-Navigator

Reference Guide = 59



Using the Hierarchy Browser

Hierarchy Layout

Display order
L eft to right displays the hierarchy from left to right in the main window; Top to
Bottom displays the hierarchy from top to bottom.

Display layout style:
Select Treeto display the hierarchy in tree layout; select 1Sl to display the
hierarchy in IS layout.

Vertical space:
Enter the number of vertical pixels between symbolsin the Hierarchy Browser
window.

Horizontal space:
Enter the number horizontal pixels between symbolsin the Hierarchy Browser
window.

Hierarchy Browser Shortcut Keys

This shortcut key is available for use with the Hierarchy Browser.

Key Combination Function

UNIX Windows

Meta+B Alt+B Starts the Class Browser for the marked class.
(or Alt+B)
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For projects devel oped using object-oriented languages, the Class Browser enables
you to browse class hierarchies, access levels, and member types. The Class Browser
displays the list of class members of a particular class, based on your selections from
the Class/Hierarchy tab of the Preferences dialog (see page 59).

For traditional languages such as C, COBOL, and FORTRAN, the Class Browser
enables you to see the members of structures and common blocks.

NOTE Source-Navigator treats structures, classes, and common blocksin the
sameway. The only differenceisthat classes have inheritance and the
others do not.

Using the Class Browser

Start the Class Browser in one of the following ways:

. double-click on aclass.

. select aclass and click the Class Browser toolbar button (see “Class Browser
button” on page 39).

. from theWindows menu, selediew View - Class.

. choose th&€lass tab.
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Figure44: ClassBrowser Window
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Class Name

Y ou can enter the class name into the Symbol Accelerator combo-box (Emacs-style
tab completion is aso supported). If you pressthe Enter key and the name matches a
valid class name, the information for the appropriate class is loaded.

Member List

The symbols displayed in the member list are controlled by the pulldown menus and
inheritance tree. Access levels and attributes are indicated by icons; for the key to
these icons select Abbreviations from the Help menu, or see Figure 8 on page 16.

Inheritance Tree
The inheritance tree shows the relationship of the browsed class and its baseclasses.
Figure45: Inheritance Tree

Useragent
Agent
[+ Glishohqject

The check boxes before the class names determine whether or not members of aclass
are included in the member list. Use the mouse to manipul ate these check boxes:
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Click
Toggles the check box.

Ctrl+click
Includes only the members of the selected class.

Double-click
Starts the Editor, which displays the sourcefile.

Right-click
Displays a menu in which you may select one or all classes.

Member List Filter Dialog

Click on the Filter button to bring up the Filter dialog. The symbols displayed by the
Member List are included based upon these settings.

Figure46. Member List Filter Dialog

[=[Ei[x]

all MNone |

W hethods W |nstance Variahles W Friends

W public W private W protected

I AND
| static 1 structor 1 inline
1 wirtual 1 pure virtual

1 overridden 1 overloaded

Ok |

All

Sets all items except AND, overridden, and overloaded.
None

Clears al items except AND, overridden, and overloaded.
Methods, I nstance Variables, Friends

Shows methods based on their types.
public, private, protected

Shows members based on their access level.
AND

If AND is selected, only functions matching all attributes will be shown. If AND
is not selected, functions matching any of the attributes will be shown.
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static, structor, inline, virtual, pure virtual
Shows members based on their attributes.

overridden

Shows members that are overridden from a base class. You can also display these
by selecting the overridden checkbox in the main window.

overloaded
Shows functions that have more than one type signature in the class.

Scope Selector

The Scope Selector menu filters the member list by the accessibility of the members.
Figure47:. Scope Selector Menu

class j Eilter |

bareclass |

|class

rubclases

subclass
Shows only the members accessible to new subclasses of the currently browsed

class. Does not include private members of the currently browsed class or private
base classes.

class

Shows only the accessible members of the currently browsed class; private
members of base classes are not included.

baseclass
Shows all members, including the private members of the base classes.
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Browser

The Cross-Reference Browser shows you where elements in your program are used

or accessed. It can find every call of afunction, or tell you everything a particular

function calls. It creates tree diagrams that show essential relationships within the

project’'s symbol database, such as the function-call hierarchy tree. You can traverse
up and down the hierarchy tree, as well as expand or restrict the tree. You can select
items in the hierarchy and display their refers-to and referred-by relationships; these

relationships are based on the “point-of-view” of the selected symbol.

A refers-to relationship is one where the selected symbol is used in the context of
another symbol, which is in turaferred-by the selected symbol.

Source-Navigator creates the cross-reference database in the background, which
enables you to work in other views. During this processCttoss-Refer ence tool
button is disabled (grayed-out). After the database is builCtles-Reference tool
can be opened.
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Using the Cross-Reference Browser

Although you can always start the Cross-Reference Browser from the Windows
menu by selecting New View — Xref, you may want to start the Cross-Reference
Browser so that it focuses on a specific symbol. To do this, select a symbol in the
Symbol Browser or Editor, and then click the Cross-Reference tool button or
choose the Xref tab.

The selected symbol becomes the root symbol in the Symbol Accelerator text box at
the top left of the Cross-Reference Browser window. The references that refer-to the
root symbol are indicated by connecting lines and those that are referred-by are
indicated by connecting arrows. Y ou can traverse the hierarchy tree by selecting
references and clicking the right-pointing hand tool (Refers-to) and |eft-pointing one
(Referred-by) as shown in Figure 48.

Figure48:. Cross-Reference Browser Window

Remove
Depth of
subnodes subnodes

expanded
Filter automatically

Refers-to

Symbol Accelerator

Referred-by
text box

Subnode

Zource-Mavigator [c++_demao] Href

— T agents(gv]) I
| % w agent ID{ud)
—a w agent walueiud)

I—3% © append{ud)

r dict ofderi{e)
Igentimi) Bgeng—_"' r create record dict(fu) 4E r CORDERED ec)

r Value{ud)
| —% r Sequencer({cl)
% w Eequencer{ud)

—w w mtring copiesiud)

L % r Value(cl]

|l Reuse||l Context“ ||References: [9, 0], int Agent:Agentimi) (Sequencer )

The Remove Subnaodes button allows you to remove displayed subnodes from the
hierarchy tree view.

To set the number of subnode levelsto display, enter a positive integer in the Levels
text entry box.
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Double-clicking asymbol inthe Cross-Reference Browser window startsthe Editor,
with the specific symbol in context in the source file. The cross-reference information
is stored in the database and is kept current by the Editor.

Cross-Reference Filter

Click the Filter button to bring up the Filter dialog. The symbols displayed by the
Cross-Reference Browser are included based on these settings.

Figure49: Cross-ReferenceFilter

Source-Mavigator [c++_demo] Filter [M|E=I|ES}

All

MNone |

W Classes (cl)

W Constants (con)

W Common ¥ariables (cov)
W Enum Yalues (ec)

W Function Declarations {fd)
W Functions {fu)

W Variables (gv)

W Instance Variahles (iv)

W Macros (ma)

W tethod Implementations (mi)
W Subroutines (su)

W Typedefs {f)

W Undefined {ud)

ACCeSS
W Read (1)
W Written (W)
W Passed (p)
W Unused (u)

Ok | Cancel |

All
Sets all non-Access selections.

None
Clears all non-Access selections.

Cross-Reference Browser Details

Right-clicking on a symbol in the Cross-Reference Browser brings up a popup menu
that allows you to filter the list of symbols you're working with, as well as to gather
new information about the symbols you're interested in.
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Figure50: Cross-Reference Browser Right Button Menu
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Choosing Details By brings up awindow that shows where each symbol inthelistis

referenced.

Figure51: Cross-Reference Browser Showing Details By Window
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Clicking on the column headers allows you to sort by the selected column, either
aphabetically, by line number, by class, etc. The Pattern text entry box in the
window allows you to use a string to filter the list.

Symbolsthat occur multiple times are listed; when you click on asymbol and then add
the Editor to the window (from the Windows menu, select Add View - Editor), the
Editor shows where that symbol is referenced.

Figure52: Editor Showing Referencing of Symbol

Zource-Mavigator [c++_demao] Valueh
File Edit Search Tools History  Windows Help
Hierarchy | Class [ﬁref] Include |
R e oS G [X
I—p Valueicl)
EommnEie MName | Class | R Lin
IhotivateMonitor(mi) Sequencer T )
IddBuiltInimi) Sequencer T o™
IAdElliprishrges (mi) UserFunc T )
BAdEllipsishrgs (mi ) UserFunc T o lF
=] ] =
Pattern: |*
r
¥
extern int j
extern int
class Eulug : public GlishChject |
public:
Valuei glish bool walue ):
Waluel byte walue );
Waluel short walue ) ;
Waluel int walue );
Waluel float walue ) ;
Walue| double walue );
Walue| complex walue ); 7
=
(W Reuse|[W Context]  114.6]stoolsuitesshareddemosic++_demo/glishiinclude/Glish/Value.h: 812 lines

Cross-Reference Preferences
Preference settings for the Cross-Reference Browser are located in the Xref tab of
the Preferences dialog.

1. Inthe Symbol Browser, from the File menu, select Project Preferences. In the
Cross-Reference Browser, from the Edit menu, select View Preferences.

2. Choosethe Xref tab.
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Figure53: Cross-Reference Tab of the Preferences Dialog

Source-Mavigator [c++_demo] Preferences

Froject | Edit | Clags/Hierarchy I ﬁrefl Include | Parser | Mersion Control | Others | Colors&Fonts |

— Cross-referencing

Build Crozs-Reference database o

Generate references to local variahles =

Audible alert when complete =

— Layout

Compare parameters =

Compare static information =

Display parameter list =

Display boxes =
Display order: 4 Leftto right -~ Top to Bottom
Display layout style: 4 Tree - 15
Wertical space: 650

Huorizontal space: 10

Ok | Apply | Save as Defaulf | Cancel |

Cross-referencing

Build Cross-Reference database
Select thisif you would like Source-Navigator to build the cross-reference
databases for your project. Thisison by default.

Generate referencesto local variables
Select thisif you would like cross-reference information for local variables. This
is off by default.

NOTE Parsing is much slower when cross-referencing local variables. Also, the
database size grows considerably when generating local variable
cross-references. Make sure that you have an adequate amount of disk space
(approximately ten times the space used by your source code).

Audible aert when complete

Selecting this causes a bell to ring when cross-referencing is compl ete.

Layout

Compare parameters
Select this to generate cross-references only when the parameter types of the
refers-to and referred-by symbols match. Deselecting this allows symbols to be
considered matches, regardless of differences in parameters.
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Compare static information
Sdlect this to generate cross-references only when both the refers-to and
referred-by static attributes match.

Display parameter list
Select this to display parameters with the symbol in the Cross-Reference
Browser window.

Display boxes
Select this to surround cross-reference nodes with boxes.

Display order
L eft to right displays the cross-reference hierarchy from left to right; Top to
Bottom displaysit from top to bottom.

Display layout style
Select Treeto display cross-referencesin tree layout; select | S| to display themin
IS layout.

Vertical space
Enter the number of vertical pixels between symbolsin the Cross-Reference
Browser window.

Horizontal space
Enter the number of horizontal pixels between symbolsin the Cross-Reference
Browser window.
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Some programming languages provide afacility for including other sourcefiles. In
C/C++ thisis achieved using the #i ncl ude preprocessor directive. The Include
Browser lets you display Includes and Included by relationships simultaneously.

Using the Include Browser

Start the Include Browser in one of the following ways.

. fromthe Windows menu, select New View — Include.

. click the Includetoolbar button (see “Include Browser button” on page 39).
. choose thénclude tab.
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Figure54: Include Browser Window

Show files included by Show files that
Hide Include Subtree the selected file include selected file

Zource-Mavigator [c++_demao] Include

File Edit Search Tools History % Help
Ql @ glieh/Bgent.h L\I\m e s L9V9|S| 3
Edit | Hierarchy | Class | Href [ Iﬂclude] Retriever | Grep |

5

glish/Tark. hxi
glish/hgent.

gligh/Func.cc

gligh/Stmt.h

gligh/Expr.cc
gligh/Event. coc

glish/bgent. co

(W Reuse|[W Context| |

To seefurther relationships, after selecting afilein the I nclude Browser window, use
the right pointing-hand tool icon to show filesincluded by the selected file. Use the
left pointing-hand tool icon to show files that include the selected file.

To determine the number of levels shown for a query, enter a positive integer in the
L evelstext entry box.

Reducing Displayed Information

Right-clicking on a symbol in the I nclude Browser window brings up a popup menu
that allows you to show or hide include information.
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Figure55: Include Browser Right Button Menu

Zource-Mavigator [c++_demo] Include
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gligh/main. ¢c
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Thisis useful when the Include Browser displays more information than you need,
and you'd like to hide all relationships but the particular one you're interested in.

Include Preferences

Preference settings for thieclude Browser are located in thinclude tab of the

Preferences dialog.

1. IntheSymbol Browser, from theFile menu, seledProject Preferences. In the
Include Browser, from theEdit menu, selectiew Preferences.

2. Choose thénclude tab.
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Figure56: Include Tab of the Preferences Dialog

Source-Mavigator [c++_demo] Preferences

Froject | Edit | Clags/Hierarchy | ﬁrefl Include | Parser | Mersion Control | Others | Colors&Fonts |

— Layout
Display order: 4 Leftto right -~ Top to Bottom
Display layout style: ~ Tree @ [3]
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W Locate Headers
fusr/ include I

contrib/ epics
contribs thelient
editline
editline/include
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gligh/include/Glish
mds

rds/ include/ Sds

= i

Ok | Apply | Save as Defaulf | Cancel |

Layout

Display order
L eft to right displays the include hierarchy from left to right; Top to Bottom
displaysit from top to bottom.

Display layout style
Select Treeto display includesin tree layout; select 1Sl to display themin IS
layout.

Vertical space
Enter the number of vertical pixels between symbolsin the Include Browser
window.

Horizontal space

Enter the number of horizontal pixels between symbolsin the Include Browser
window.

Include directories
L ocate Headers
Uncheck this box to prevent included files from being cross-referenced.

In the Include Directories box you can choose which directories should be searched
for include files. Using the set of directories shown in Figure 56, for example, if
st di 0. h isareference then Source-Navigator looksfirst for the file
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/usr/include/stdio. h,thenfor./stdio. h, and so on down thelist. The order
of the list isimportant, because the first file found is the one that will be used by the
Include Browser.
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Retriever

Retriever allows you to search for text patterns in the names of symbolsin the
database. To search for text patternsin source files, use the Grep tool in
Source-Navigator. For more information about the Grep toal, see “Grep” on page 83.

Using the Retriever

To find a symbol, enter its search pattern surrounded by asterisks (for example
*agent *) in thePattern text box and clicisearch. The*, ?, [, and] wildcard
characters are supported.
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Figure57: Retriever Window

Zource-Mavigator [c++_demo] Retriever: Agent

File Edit Search Tools History  Windows Help
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Edit | Hierarchy | Class | Xrefl Include | Retriever | Grep |

EWugentﬂ | Search
Pattern — |7 Name | Class | Type | Farameters
text box
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The Retriever displays all the symbolsit found containing the pattern being searched.

Figure58: Retriever Window Showing Sear ch Results

Zource-Mavigator [c++_demo] Retriever: *agent™
File Edit Search Tools History  Windows Help
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Double-clicking an item in the list opens the Editor showing the symbol in context in

the source code.

For more information on reusing windows for multiple searches, see “Reusing

Windows” on page 18.
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Retriever Filter

Click the Filter button to bring up the Filter dialog. The symbols displayed by
Retriever areincluded or excluded based upon these settings.

Figure59: Retriever Filter Dialog

= S =1{E]
All Maone | I Exclusive Search
W Classes ' Constants W Enums
W Enum Walues W Function Declarations W Friends
W Functions W Mariables W |nstance Variahles
W hacros W hethods W Method Implementations
W Typedefs = _1 Files
Search | Close |
All
Sdects all items except Unions and Files.
None
Clears al selections.
Executive Search

If the Exclusive Search box is selected, you may choose one symbol type to
search for. If it's deselected, you may combine symbol types for more complex
searches.

Retriever with the Cross-Reference
Browser

If you're looking at a unique symbol in tilitor and you click theXref tab to see its
cross-references, ttier oss-Reference Browser window appears.

However, if you're looking at a symbol that is not unique (there’s more than one
symbol with that name in the database),Retriever displays a message dialog
notifying you that it has found multiple matches and requests that you choose the
correct one to display.
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Figure 60: Multiple Symbols Notification Dialog

Retriever: Found hatches

Click this to gO Stralght Eased on the selected symbol information, Source-Mavigator has found more than one match.
to the Retriever d|a|og\ You must select one match to continue.

from now on _ -
~| Do not display this dialog box.

Ok |

If you don’t want to see this warning in the future, but want to go straight to the
Retriever, click the check box in the dialog. This can also be changed dttrees
tab of thePreferences dialog (see page 31).

Figure61. Xref Retriever Window

Zource-Mavigator [c++_demo] #Ref Retriever : Walue

File Edit History Windows Help
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@ Valueimi) Walue int ({Value *,wvalue type! glirh/Value.cc

| =

Pattern: |*
(W Reuse|| |

In theXref Retriever window, double-click on the symbol for which you want
cross-reference information, and fheoss-Reference Browser window appears. See
“Cross-Reference Browser” on page 65 for more information.
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The Source-Navigator Grep tool allows you to search for text patternsin source files
throughout the project. It is more powerful than using gr ep at the command line
because it:

alows you to search multiple directories.

searches only the filesin your project.

can be restricted to a subset of the filesin your project.

saves alist of previously performed searches so you can repeat a search later.
provides “one-click’Editor access to the lines of code matching your search.

To search for text patterns in the symbols database, uBetiHiever tool. For more
information, see “Retriever” on page 79.

Using Grep

A convenient way to use th&rep tool is by using &rep-Editor window. From the
Windows menu, selediew View — Grep-Editor (for more information on split
windows, see page 16).
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Figure62: The Grep/Editor Window

Source-Mavigator [c++_demo] (noname)
History  Windows
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j Format |
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Editor

e

|l Reuse||l Context“ 1.D||ﬁoolsuitefsharefdemosfc++_dem0f(n0name):1 lines

In the Patter n text box, enter aregular expression then click the Search icon. For
more information on regular expressions, see “GNU Regular Expressions” on

page 85.

You can use thEilesfilter to limit your search; for example, enteringc restricts
the search to only C files. For a list of file extensions and their associated languages

see Table 1 on page 20. Figure 63 shows the results of a Samgplsearch.
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Figure 63. Sample Grep Search Results
GNU regular expression  Files to search
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Clicking on an item in the Grep window displays the appropriate file in the Editor,
with the cursor positioned at the selected line.

To step through the Grep results, click the left or right black arrow keysin the toolbar.
To filter your Grep results, use the Format combo-box to select an option.

GNU Regular Expressions

A GNU regular expression’ is a pattern that describes a set of strings. Regular
expressions are constructed like arithmetic expressions:. various operators combine
smaller expressions to form larger expressions.

Ordinary Characters

An ordinary character is asimple regular expression that matches a single character
and nothing else. For example, f matches f and no other string. Y ou can concatenate
regular expressions together. For example, foo matches foo and no other string.

1 Richard Stallman and Karl Berry wrote the GNU regex backtracking matcher. Copyright © 1989, 1991 Free
Software Foundation, Inc., 675 Massachusetts Avenue, Cambridge, MA 02139, USA.
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Special Characters

Y ou can combine regular expressions with regular expression operators, or
metacharacters, to increase the versatility of regular expressions. Traditional
expression characters are enclosed by brackets[ and ].

For example, [Aa]pple matches either Apple or apple. A range of charactersis
indicated by adash -. [a-Z] matches any lowercase letter and [0-9] matches any digit
string between zero (0) and nine (9). Y ou can string groups together, so that
[a-zA-Z0-9] matches any single alphanumeric character.
To represent the - dash itself, it must be the last character, directly succeeded by the].
To represent | bracket, it must be the first character after the [ or the [*.
Table 3 lists special characters and examples of how to use them.

Table 3: Special Characters

Symbol Definition Example

. (period) matches any single a.b
character except anew line  matches any three-character string
beginning with a and ending with b
(such as ach, a6b, and a#b)

[ -] matches characters between  [af]
the brackets matches either one a or one f
[af]*

matches any string composed of just
a’s or f's or the empty string

[~ matches any character [ra-Z]
except the ones specified matches any characters except
lower-case letters

A (caret) matches the empty string, ~foo
but only at the beginning of matchedoo andfood, but notofoo
the line

$ (dollar sign)  matches the empty string, fo$
but only at the end of the  matches a string endingfia, but not

line foop
\ (backslash) escapes special charactersfo\?
(including \) matchedo?
| (pipe) is used to designate OR  foo|bar

matches eithefoo or bar

(...) is a grouping construct foo(bar)*
matches zero or more instances of
bar with foo (such afoo, foobar,
andfoobar bar)

NOTE Inthe| (pipe) example above, notice that foo|bar is matching either foo or
bar. It's not matching or b, resulting with eithefooar orfobar.
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Predefined Sets of Characters

Certain named classes of characters are predefined, but can only be used within

bracket expressions.

Table 4: Character Classes
Symbol
[:alnum:]
[:alpha]
[:blank:]
[:entrl:]
[:digit:]
[:graph:]

[:lower:]
[:print:]

[:punct:]
[:space]

[:upper:]
[:xdigit:]

Definition
alphanumeric characters
alphabetic characters
space and tab characters
control characters
numeric characters

characters that are printable and
aredsovisible (atabis
printable, but not visible, while
an ais both)

lower-case al phabetic characters

printable characters (ASCII 32
and above), but not control
characters

punctuation characters

space characters (such as space,
tab, newline, and page gject)

upper-case a phabetic characters
hexadecimal digit characters

C-locale Equivalent
[a-zA-Z0-9]
[a-zA-Z]

[0-9]

[A-Z]
[0-9a-fA-F]

For example, [[:alnum:]] means[0-9A-Za-Z] in the C-locale, except the latter formis
dependent upon the ASCII character encoding, whereas the former is portable.

Repetition

A regular expression matching a single character may be followed by one of several

repetition operators:

Table5: Interval Expressions

Symbol
* (asterisk)

Description

post-fix operator that matches an
expression 0 or more times

Example

fo*

matches a string
starting with f and
ending with a
repeating o or no
o's (such ad, fo,
andfoo)
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Table5: Interval Expressions (Continued)

+ (plus)

? (question
mark)

{n}
{n}

{,m}

{n,m}

post-fix operator that matches an
expression at |least once

post-fix operator that must

f+o

matches a string
starting with one or
more f's and
ending with aro
(such ado, ffo,
andfffo)

f?0

match an expression once or notmatchedo oro

at all

preceding item is matched
exactlyn times

preceding item is matchetor
more times

proceeding item is optional and
is matched at mosh times

proceeding item is matched at
leastn times and at mosh times

Escape Sequences

Some characters cannot be included literally in regular expressions. Y ou represent
them instead with escape sequences, which are characters beginning with a backslash
(\). A backslash is also part of the representation of unprintable characters such asa

tab or newline.
Table 6: Escape Sequences

Symbol
\

\a

\b

\e

\f

\n

\r

\t

\v

\?

\(

Description

a literal backslash
alert

backspace
escape character
form feed
newline

carriage return
horizontal tab
vertical tab
question mark
left parenthesis

fo{2}

matchegoo

fo{2,}
matchegoo and
fooo

fo{,3}
matched, fo, foo,
andfooo

fo{1,3}
matchedo, foo,
andfooo
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Table 6: Escape Sequences (Continued)

\) right parenthesis
\[ left bracket
\] right bracket

Two regular expressions may be concatenated; the resulting regular expression
matches any string formed by concatenating two substrings that respectively match
the concatenated subexpression.For example:

[a-b] matches either a or b
[d-€] matches either d or e
[a-b][d-€] matches ad, bd, ae, or be

The backreference \n, where n is a single digit, matches the substring previoudy
matched by the nth parenthesized subexpression of the regular expression. For
example, \(ab)c\1 matches abbbcabbb, but not abbbcabb.

For additional information on regular expressions, please refer to areference text such
as Mastering Regular Expronsz.

2 Friedl, Jeffrey E. F. 1997. Mastering Regular Expressions. ISBN 1-56592-257-3.
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Version Control Systems

Version control systems use locks to prevent the same files from being modified by
two developers simultaneoudly. If alock is used while revising afile, no one can
modify the file until it is unlocked. Locking and unlocking can be controlled by
checking in or checking out versions.

Source-Navigator provides a GUI to several external version control systems. With
version control you can organize your development to manage versions, version
history, labels, and related documents.

Using Version Control

The following version control systems have been integrated with Source-Navigator:

GNU Revision Control System (RCS), Concurrent Versions System (CV S), and the

Source Code Control System (SCCS). It has also been integrated with Rational’s
ClearCase version 3; other versions may also work, although these have not been
tested. When creating a project, you must specify the version control system being
used to manage the body of source code you wish to analyze. You make your selectiol
in theVersion Control tab of thePreferences dialog (see page 94).
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To open the Revision Control Editor, from the Tools menu, select
Revision Control — Revision Control Editor (see Figure 64).

Figure 64: Revision Version Control Window

Source-Mavigator [empty] Revision Control Editor

File Edit History Windows

Help

File

Wiew |default j

ﬁ{gjectﬂles

Sxample. o

Pattern: |*

Symhaolic tags History example.c

revision 1.2

Fixed #include

revision 1.1
date: ZO00S01525 00:12:54; mtate: Exp:

Initial revisicn

d

date: ZO00/01/25 00:15:36; mtate: Exp; lines: +2 -0

-

| |

Change history

Checking Out a File

Shows all or specific
changes

In the Editor, from the Tools menu select Revision Control — Check Out to check
out afile. Versions of afile can be checked out for modification either locked or

unlocked.
Figure 65. Check Out Dialog Box

Check Cut glish/Agenth

1.6
1.5
1.4
1.3
1.2

ar | Cames | ‘Paﬂern: *

Revision: |1.6

W With lock

Checking out with With lock selected in the Check Out dialog box prevents other
users from checking out the same version in write mode.
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Checking In a File

Y ou can check in al or selected project filesinto your version control system. When
you check in, you may enter descriptive text of the changes and a version number.
Using the left-mouse button, select one or more filesto check in. With these files
highlighted, in the Revision Control Editor window, from the Edit menu, select
Check In. The Check In dialog is displayed.

Figure66: Check In Dialog Box

Check In glish/Agenth
Comment

Bdd a new Eeuturq

W With lock

Ok | Cancel |

If you check in with With lock selected in this dialog box, others may not check out
the same file in write mode.

Thisisuseful if you are continuously working on a particular file, but wish to register
checkpointsin your work without giving others the opportunity to make modifications
to that file.

Discarding Changes to a File
To revert working filesto the repository version, in the Revision Control Editor
window, from the Edit menu, select Discard Changes.

Show Differences

The Diff tool highlights differences between the current version of afile (the one you
have checked out) and another one that you select from the list of available version
numbers.

To access Diff, from the Edit menu, select Compar e Revisions.
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Figure 67: Showing Differences

Source-Mavigator [empty] DIFF
example.c [[5|[rCSfexample.c,y —-= standard output |
(X[ ¥include <etdic.h> 1 X
2 2
3 int main{) { 3
4 fooi);
5 }
L
P =
Close Prev Net | 1 [of 11,200

Version Control Preferences

Preference settings for the Version Control window are located in the Version
Control tab of the Preferences dialog.

1. Inthe Symbol Browser, from the File menu select Project Preferences. In the
Version Control window, from the Edit menu, select View Preferences.

2. Choosethe Version Control tab.

94 m Reference Guide

Red Hat Source-Navigator



Version Control Preferences

Figure68: Version Control Tab of the Preferences Dialog

Source-Mavigator [c++_demo] Preferences

Froject | Edit | Clags/Hierarchy | ﬁrefl Include | Parser I Mersion Control | Others | Colors&Fonts |

Wersion contral system
’70 RCS ., CWS ~, SCCS ~, ClearCase ‘

lgnored directories

RCS
foctic)
sCCs
archives
.Bnprj
7
Ok | Apply | Save as Defaulf | Cancel |

Version control system
Select your external version control system for the project.

Ignored directories
These directories will be ignored by Source-Navigator asit scans for filesto
parse.

For more information on integrating version control packages, see the “Integrating
with Version Control Systems” on page 195.
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Building Programs

Source-Navigator allows you to build executable programs from the filesin your
project. Using Source-Navigator, you can compile your code, navigate to any errors,
link your code, and, with the Insight debugger, set up adebugging session to debug
your code.

NOTE  Thecompiler, make, and the Insight debugger must be installed on
your machine before using these features.

At the end of this chapter, thereisabuild tutoria for acommand line-driven rea
estate trading game.

The Building Process

The building process compiles and links source files, such as libraries and executable
files, to produce an output binary file.
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Figure 69: Build Process

v
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rmodule Injection {
interface Inject {
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!

734004

Source Code Object Code Application Debugger
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External Libraries

There are four stepsto building your program:

. editing your code,

. compiling your source into an intermediate format, called object files,

. linking your object files together to produce an executabl e application, and

. debugging your executable to find any problems.

The minimum requirements for building source code include specifying which source

files should be included, the directory in which the build should be stored, linking
rules, debugging, optimization flags, and included paths.

Y ou can edit your code using Source-Navigator. This chapter explains compiling and
linking. For information about the Insight debugger, see “Working with Insight, the
Debugger Interface” in th@etting Started Guide.

Source-Navigator uses a utility called Gbke. nake combines a set of rules for
compiling and linking code with a tracking mechanism for determining which files
must be compiled.

Source-Navigator generatesakef i | e, whichmake uses to determine which
commands to be execute in order to build your program.
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Build Targets

A build target is a conceptual object that contains information needed to compile and
link a project. For example, hel | 0. ¢ convertsinto hel | o. o before producing the
hel | o executable. The hel | 0. o object fileislinked with required libraries.

Thefirst time you select Build Settings, the Build Tar getslist is empty. After you
create a build target, its name appearsin thelist.

Creating a New Build Target

From the Tools menu, select Build Settings to start the Build Settings dialog.
Figure 70: Build Settings Dialog

[=[Ei[x]

Build Targets:

Type the name of the build target in the text entry box and click the Create button.
The Edit Target dialog opens. See “Editing a Target” on page 100.

Modifying Build Targets
Rename a build target by selecting the target, typing a new name, and clicking the
Rename button.
NOTE Do not highlight the target name in the text box or a new target is created.
To edit an existing build target, select the target and clickthebutton.

Duplicating a build target is useful when a new target is only slightly different from an
existing target. To duplicate an existing build target, select the targetBuilte
Targets list and click theDuplicate button.

Delete a build target by selecting it in tBeild Tar gets list and click theDelete
button. The target is removed from the listing.
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Editing a Target
Inthe Build Targetslist, either
. select thetarget name and click the Edit button, or
. double-click the target name.
The Edit Target dialog opens.

Figure 71: Edit Target Dialog

Edit Target: monop
Source Files | Library Files | EBuild Rules | Link Bules | : :
Euild Directory:
Froject Files: Target Files: |
B cards.o [ 1< A Files > | (X
B deck.h Target Type:
_ execute. o Clear | Executable ﬂ
_ getinp. o
_ houses. o Clear Al | Tool Chain:
B initdeck.s SMUFre (native) -
B idail.c
_ miGEc. o Impart:
_ Moo .
B monop.h Files |
_ marg . o
I-B pathnames.h Directary |
_ print.c
_ prop . o
_ rent.c
_ roll. o
_ BpEC. o
_ trades.c = =
| | —
Ok Cancel

Edit Target tabs

The Build Directory, Target Type, and Tool Chain combo-boxes are common to the
tabs accessed in the Edit Target diaog.

Figure72: Build Directory, Target Type, and Tool Chain Combo-boxes

select

Euild Directory: ;
/tocleuite! apps/ share/c _1/ dlreCtory
Target Type:
select target
Executable -
— type
Tool Chain:
GUPro (native) -
J\ select
development
tool set

These store information about the build target.
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Build Directory

Thisisthe directory where all files generated in the build process areinitially stored.
By default thisis blank. If thisisleft blank, then the project directory isused. To
specify the directory, either type the directory path or click thebutton. If you
click the “..” button, theOpen dialog opens.

Figure 73: Build Directory Open Dialog

Open..

] sbin
[ tme
EHI] teeleuite
EHI] apps
EH_] share

[ bitmaps

] cwonus

EH_ ] demos

[ ott_demo

8 meoee
Detc

[6]:4 | Cancel |

Select the directory in which to store the intermediate files. @ikio close the
dialog. The directory appears in tBaild Directory field.

Target Type

Use this combo-box to select the type of build target to create. The options are
Executable andLibrary.

Tool Chain

A tool chain is a set of compilers, debuggers, and linkers. GRE/Pro (native)
option is always available. Other toolchains may be available, depending upon the
Source-Navigator package purchased.

Source Files tab

TheSource Filestab controls which source files are included in your build target. The
Project Files andTar get Files lists contain tree information for the selected build
target.
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Figure 74: SourceFilesTab

Edit Target: monop
Source Files | Library Files | EBuild Rules | Link Bules | : :
Euild Directory:
Project Files: Target Files: /tomlmuite/ appe/ share/c| .. |
_ cards . o K = Add Files = | IFilels I
B deck.h B cards.c Target Type:
_ execute. o Clear | _ execute. o Executable ﬂ
_ getinp. o = _ getinp.c
_ houses. o Clear Al | _ houses. o Tool Chain:
_ initdeck.c _ jail.c ITPro (natiwve) ﬂ
_ jail.c _ miBc. o
_ miGEc. o Impatt: _ monop . o
_ Moo . _ morg. o
B monop.h L~ Files | B print.c
Add additional Al s i — prop. o
. T3 pathnames Directary | @ rent.c
files and | B print.c LB ==ll.c
directories —B prep.o —B spec.o
_ rent.c _ trades.c
_ roll. o
_ BpEC. o
_ trades.c = =
| | —
Ok Cancel
Adding files

To add filesto the Target Fileslist:

1. Select thefilesfrom the Project Fileslist.

2. Click the Add Files button.
Thefiles are copied into the Target Fileslist.

Removing files

To remove files from the Tar get Fileslist, select the files to remove and click the
Clear button. To remove all of the filesfrom the Tar get Fileslist, click the Clear All
button.

Importing files and directories
To import files or directoriesinto your currently active project:
1. Under Import, click either the Files or Directory button.

2. Select thefiles or directories you wish to add to the project. Click OK when done.
The names of the added files or directory appear in the Project Fileslist.

Library Files tab

Most libraries required for building targets are linked in automatically by the
compiler/linker. If you know that your target requires additional libraries, use the
Library Filestab to add them to your build.
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Figure75: Library FilesTab

Edit Target: monop
Source Files | Library Files | EBuild Rules | Link Bules | X X
Euild Directory:
Libraries: /tocleuite/ apps/ shareds | .. |
Add... Target Type:
| Executable ﬂ
Tool Chain:
—I GMUPro (native) -
Ok | Cancel |

Add additional libraries by clicking the Add button. The Open dialog opensto the last
directory you have looked at in this project. After you select alibrary and click the
Open button, it appearsin the library list.

Toremovealibrary from the Librarieslist, select the library and click the Remove
button. The library is removed from the build.

Libraries are linked in the order listed inthe Librarieslist. To change the order of
libraries, select the library and click either the M ove Up or M ove Down button to
change itslinking order.

Build Rules tab

Click the Build Rulestab to configure each rule in the build target.

A rule contains information required to compile filesin a project. For example, arule
to compile a C file might contain information about which compiler and flags to use,
as well as what the file is called after it's compiled.

This tab lists the rules for the specified build target. WithirBihiéd Rules tab, you
can:

. disable and enable rules for the target.

. edit existing rules.
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Figure 76: Build RulesTab

Edit Target: monop
Source Files | Library Files I EBuild Rules | Link Bules : :
Euild Directory:
Status | File Type | Description ftmls“itEfﬂppEfEh“rEf“;I
Enabled Yacc Frocess a yacc file. I Target Type:
Enabled Lex Frocess a lex file. Executable ﬂ
Enabled Java Compile a Java file
Enabled (o4 Compile a © file Taal Chain:
Enabled o+ Compile a CH+ file SMUFro (mative) ﬂ
Command
Line for
Selected i~
Rule ~_| | |
\Erilscm o2
Ok Cancel
Status

This column shows the currently enabled and disabled rules. To disable arule,

highlight the rule and click the Disable button. To enable arule, highlight the ruleand
click the Enable button.

NOTE This button changes between Disable and Enable depending upon the state of
therule.

File Type

This column displays the type of file the rule acts upon.
Description

This column displays a description of the rule.

Editing arule

To edit arule, either
. select therule from therule listing and click the Edit Rule button, or
» double-click therule.

The Build Rule Settings dialog opens. The dialog title bar displays the extension for
the filesinvolved.

104 = Reference Guide Red Hat Source-Navigator



Build Targets

Settings tab
The Settings tab allows you to change the default settings for the rule.
Figure 77: Build Rule Settings with Options Selected

Build Rule Settings []
Settings | Includes | Defines |
Det:nug:|0:'m1:'i1Er Default ﬂ| Optimization: |Compiler Default =
Warnings: |Coompiler Default ﬂ Code Generation: |Compiler Default ﬂ
User Flags: Executable: |goc _l
. goo —c 57
Displays rule 1
Ok Cancel
Debug
This controls the debug information generated by the compiler.
Warnings

Controlsthe level of warnings the compiler generates. A stricter warning ensures
fewer problems with future compatibility. Set “Warnings as Errors” to make sure
the compile stops any time a warning is generated.

User flags
Enter flags not covered by the options listed in this screen. To add macros, see
“Defines tab” on page 106.
Optimization
Compiler optimization for the code.
Code Generation
Processor- or code control-specific optimizations of settings.

Executable
Selects the executable to use. To change the tool (such as compiler) location,
either enter the location path or click the"button to choose the tool binary to
use.

Includes tab

Sometimes files include other files. In C this is done with#ihec| ude statement.
Thelncludes tab allows you to change the included paths for the rule.
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Figure78: Includes Tab

Build Rule Settings []

Settings | Includes | Defines |

Auto-Generated Include Paths:

User Specified Include Paths:

Generate |
Delete |

Ok

| Cancel |

The Auto-Generated | nclude Paths list displays paths generated from the

Source-Navigator database.

Click the Gener ate button to generate alist of Source-Navigator included paths.
These appear in the Auto-Generated Include Paths list.

To add additional paths, click the Add button. The selected paths appear in the User
Specified Include Paths list. Delete paths by highlighting the path and clicking the

Delete button.
Defines tab

The Definestab enables you to view, edit, and create new macro definitions.

Figure79: DefinesTab

Build Rule Settings []

Settings | Includes | Defines |

kacro defines:

Ok

Cancel

Modifying macro definitions

To create anew macro, type the name and definition in the text entry box and click the

New button.
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Figure 80: New Macro Created

Build Rule Settings []

Seftings | Includes | Defines |

kacro defines:

GNU_SOURCH |

Ok | Cancel |

To change the current macro definition, select the macro from the Macro defineslist.
The macro appearsin the text entry box.

Figure81: Macro Created and Selected

Build Rule Settings []

Settings | Includes | Defines |

kacro defines:

GNU_SOURCE |

_owge |

_GNU_SOURCE

Ok Cancel

Make the necessary modifications to the macro.
To create anew macro, click the New button. The new macro appearsin the listing.

To delete amacro, select it from the M acro defineslist and click the Delete button.
The macro is removed from the listing.

To update the macro, click the Change button. The modified macro appearsin the
listing.
Link Rules tab

TheLink Rulestab allows you to specify the program to execute and the name of the
fina output file.
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Figure82: Link RulesTab of the Build Targets M enu

Edit Target: monop
Source Files | Library Files | EBuild Rules | Link Bules | S e iy
Command Outpuit File: | monep Entry Paint; /tecleuite/ apps/ share/s | . |
line output ~ Linker: |gco _| Link flags: IEargEt;sflE. =
displayed
gee —o manap Tool Chain:
GNUFro (native) ﬂ
Dehug/Execute Settings:
Command to launch Application: # Execute - Debug
./ monop
Ok Cancel
Output File
The name of the final output file.
Linker
Auto-detects the type of project. Click the™button to select another linker.
Entry Point

This is the first function executed for the application. Defauttisn() . In
Java”, you must specify the name of the class that defines mai n() .

Link flags
Displays the full link command line and allows you to add flags, but you cannot
edit existing links or flags.

Debug/Execute Settings
Controls the mode for the rule. Execute allows running the program from the
Build window. Debug allows starting the Insight debugger from the Build

window. See “Debugging the build target” on page 113 for more information on

debugging your program.
Command to launch Application

This field lists the name of the binary to execute or debug. The default name is the

file listed inOutput File. If you changed the default output file, you must also
change the name here.

On UNIX, typext er m - e before the executable name if you are debugging a
console application.
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Click the OK button to close the Edit Target dialog. Click the Done button to close
the Build Settingsdiaog.

Compiling Build Targets
After you have created and configured a build target, you must build it.
Source-Navigator can generate its own makef i | es or work with one that you supply.

Internal build systems
To build your project using the Source-Navigator build system:
1. From the Tools menu in the Symbol Browser, select Build.

2. TheBuild window opens.
Figure83: Build Window

Zource-Mavigator [monop] Build: make

File Edit History Tools Windows

R

Build command make j | Start |
DirECtDry‘ftmlsuitefﬂppsfshurefdem:isfmcmcq;' j | |

Build Targets |<External Makefile> j
Debug |

(W Reuse||

3. Sdlect the build target from the Build Tar get list.
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Figure 84: Selecting a Build Target

Zource-Mavigator [monop] Build: make

File Edit History Tools Windows Help

R

Build command make j | Start |
Directary |/ tooleuite/ apps/ share/ demos / monop j | |
Build Targets |<External Makefile> j
Debug |
“External Makefile> |
Mmoo
M Reuse| |

4. Click the Sart button to perform the build. If you need to stop the build process
for any reason, click the Stop button.

5. When Source-Navigator startsthe make command, output from the make process
isdisplayed. To step through the results, click the left or right black arrow keysin
the toolbar.

6. If errors appear, the build target needs to be modified. See “Modifying the Build”
on page 111.
If no errors appear, the build target is compiled and ready to be executed. Click
the Run button to execute the application.

External build systems

To build using your owmakefi | e:
1. From theTools menu in theSymbol Browser, selectBuild.
2. Ensure thaBuild Targetsis set to<Ext er nal Makefi |l e>.
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Figure 85: Selecting the <External M akefile> Build Tar get

Source-MNavigator [monop] Build: make

File Edit History Tools Windows Help

R

Build command make j . | Start |
DirECtDry‘ftmlsuitefﬂppsfshurefdem:isfmcmcq;' ‘j | |

Build Targets |<External Makefile> j
Debug |

(W Reuse|| |

3. IntheDirectory field, select the directory containing the external makefile.

If you require additional flags or a different make program, from the File menu,
select Project Preferences and select the Other stab. Enter the additional flags or
make program into the Build field (see Figure 21 on page 31).

4. Click the Sart button to perform the build. If you need to stop the build process
for any reason, click the Sop button.
5. When Source-Navigator startsthe make command, output from the make process

isdisplayed. To step through the results, click the left or right black arrow keysin
the toolbar.

6. If errors appear, the source code needs to be modified.

If no errors appear, the build target is compiled and ready to be executed. Click
the Run button to execute the application.

Modifying the Build

If errors appear in the Build window, the source code must be modified before the
program will run.

Double-clicking aline with a compiler error message activates the Editor with the
cursor positioned on the line of code where the error appears. Right-clicking in the
output window allows you to save the build output to afile.

From the Windows menu, select Add View - Build to add a Build window to an
Editor window.
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Figure 86: Editor-Build Window

Source-MNavigator [monop] Build: make

File Edit Search Tools History  Windows Help

T | EERE
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* OR SERVICES; LOSS OF USE, DATL, OR PROFITS; OR BUSIMNESS INTERRUFTICN) K
¥ HOWEVER CHITSED LMD N BNY THEORY OF LIREILITY, WHETHER IM COMNTRRCT, STRICT
Editor * LILEILITY, ©OR TORT (INCLUDIMG NEGLIGENCE COF OTHERWISE) BRISIMNG IN BNY WAY =1
* QUT OF THE USE OF THIS SCFTWRRE, EVEN IF ROWISED OF THE POSSIEILITY OF
* SUCH DEMRGE.
Wi
#include <pye/ cdefs.h>
#ifndef lint
#if O
rtatic char mocsid[] = "@i#)cards.c 5.1 {(Berkeley) 5/317/%3";
#elee
__RCSID( " $NetBSD: carde.c,v 1.5 1995/08/30 09:19:39 veego Exp $"): | 4
N iy
Build command (fnake ‘j | Start |
Directary |/ tooleuite/ apps/ share/ demos / monop ﬂ | |
Build Targsts |menep j
. . Debug |
Build

|l Reuse||l Context“ ||ﬁoolsuitefappsfsharefdemosfmonopfcards.c: 228 lines

To save and recompile the modified files, pressthe Sart button. The Fast Savedialog
appears asking if you want to perform afast save. Click the Yes button to save the
changes and rebuild. Click the No button to discard changes and perform arebuild.
Clicking the Cancel button closes the dialog without rebuilding the program.

When the build is completed, Source-Navigator saves the executable using the name
specified in the Link Rulestab. If aname is not specified, the file name will be the
target name. The compiled fileis saved in the build directory.

Build types

The Tools menu in the Build window lists the types of builds you can perform. Before
selecting an option from this menu, ensure that a build target has been selected.
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Figure87: ToolsMenu

Toals
Build
Force Build
Clean Build

Export Makefile...

Build
Rebuilds only the modified files. Thisisthe same as clicking the Sart button in

the Build Tar gets window.

Force Build
Rebuilds the maodified files in the project and ignores errors.

Clean Build
Removes the object files and executables. Thisis equivalent to the command

make cl ean.
Export Makefile

Saves your build target asanakefi | e for external use.
Debugging the build target

If you selected Debug from the Link Rulestab inthe Edit Target dialog, you will use
Insight or another debugger to debug your code.
1. From the Build window, click the Debug button.

The Program to debug dialog appears.

Figure 88: Program to Debug Dialog

Program to debug

Frogram

Warking directory

Hierm

Ok | Cancel |

2. Inthe Program field, type or select the application to debug.
In the Working Directory field, type or select the path of the project directory.

On UNIX, inthe Xterm field, type xt er mto have a separate debugger output
console window appear. If thisfield is left blank, the Source-Navigator output
console, specified in the Other s preference tab (see “Others tab” on page 31), is
used.
3. Click OK to debug the build target.
The debugger launches.
For more information on the debugger, see “Working with Insight, the Debugger
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Interface” in theGetting Sarted Guide.

4. Returnto Source-Navigator to fix any errors and repeat the build-download-debug
cycle.

Changing the build target from Debug to Execute

After debugging and fixing your build target, you must change the build target from
debug to execute in order to run the application.

1. From theSymbol Browser window, seleciTools - Build Settings.
Double-click the build target to modify from tiguild Tar gets list box.
Click theLink Rulestab.

UnderDebug/Execute Settings, selectExecute.

Click theOK button to close thEdit Target dialog.

Click theDone button to close thBuild Settings dialog.

Recompile and execute your build target (see “Compiling Build Targets” on page
109).

No o ~®D

Executing the application

Once the application compiles without errors, fromBhdd window, click theRun
button to execute the application.

Build Tutorial

This build tutorial is based on thenop demo, located in théenos directory.

monop is a command line based game that you can build, edit, and play. In this
tutorial, you will create two build targets and use many build and debugging features
of Source-Navigator.

NOTE Thenonop demo is written in C. A Java demo is located in the
~/ shar e/ denos/ j ava folder. A C++ demo is located in the
~/ shar e/ denos/ c++ folder. To learn more about these demos, read the
Readme file located in each folder.

Creating the Project

1. IntheSymbol Browser, from theFile menu, seledew Project.
2. Create a new project callegnop. proj .
3. UnderAdd Directory, click the “..” button to select thdenos/ nonop folder.
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Figure 89: Creating the monop Project

Auto-Create Project

0 Do you want to automatically create a Source-Mavigator Project based on:

Froject File apps/ share/ demors/ monop monop . prog
Add Directory ftooleuite apps s/ Ehurefdermsfmcmcq_:'
more |

W Include Subdirectories W Build Cross-Reference databasze

ok | Project Editor Cancel

4. Click OK to create the project.

Creating the Tonop Target

1. From the Tools menu, select Build Settings. The Build Settings dialog opens.

2. Typenonop asthe name of the build target.

Figure90: Creating the monop Build Target

Build Targets:

|“ :'“:'F' | Dane

[=[Ei[x]

e |
[gerene |

=

[ oupteeis|
i |

3. Click the Create button. The Edit Target dialog opens.
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Figure91: Edit Target Dialog

Edit Target: monop
Source Files | Library Files | EBuild Rules | Link Bules | : :
Euild Directory:
Froject Files: Target Files: |
—B earde.o X - addFiles » | i
B deck.h Target Type:
_ execute. o Clear | Executable ﬂ
_ getinp. o
_ houses. o Clear Al | Tool Chain:
B initdeck.s SMUFre (native) -
HB dail.c
_ miBc. o Impart:
_ Moo .
B monop.h Files |
_ marg . o
_ pathnames.h Directary |
_ print.c
_ prop . o
_ rent.c
_ roll. o
_ BpEC. o
_ trade.c = =
| | —
Ok | Cancel |

4. IntheBuild Directory field, click the “..” button and select the build directory
for thenonop project.

Figure92: Addingthe Build Directory

Euild Directory:
ftooleuite appe/ gharedc ... |

Target Type:

Executable ﬂ
Tool Chain:

GMUPro (native) -

5. FromProject Files, select thear ds. c, execut e. ¢, geti np. ¢, houses. c,
jail.c,msc.c,monop.c,norg.c,print.c,prop.c,rent.c,roll.c,
spec. ¢, andt r ade. c files.

6. Click the Add Files button to copy the files to thiarget Fileslist.
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Figure93: Files Added tothe Target

Edit Target: monop
Source Files | Library Files | EBuild Rules | Link Bules |
Euild Directory:
Project Files: Target Files: /tomlmuite/ appe/ share/c| .. |
_ cards . o K = Add Files = | IFilels I
B deck.h B cards.c Target Type:
_ execute. o Clear | _ execute. o Executable ﬂ
_ getinp. o _ getinp.c
_ houses. o Clear Al | _ houses. o Tool Chain:
_ initdeck.c _ jail.c ITPro (natiwve) ﬂ
_ jail.c _ miBc. o
_ miGEc. o Impatt: _ monop . o
_ Moo . _ morg. o
B monop.h Files | B print.c
_ marg . o _ prop. o
I-B pathnames.h Directary | B rent.o
_ print.c _ roll.c
_ Prop. _ BDEC. C
_ rent.c _ trades.c
_ roll. o
_ BpEC. o
_ trades.c = =
| | —
Ok | Cancel |

NOTE To execute the program correctly on UNIX, click the Link Rulestab. Type
xterm -e ./ nonop inthe Command to launch Application field. Click
OK to closetheLink Rulesdiaog.

7. Click OK to close the Edit Target dialog.
8. Click the Done button to close the Build Settings dialog.
The build target is created. Now you need to compile the program.

Debugging the nonop build target

1. From the Tools menu, select Build. The Build dialog opens.
2. From the Build Targetsfield, select nonop.

Red Hat Source-Navigator Reference Guide m 117



Build Tutorial

Figure 94:. Selecting the monop Build Tar get

Source-MNavigator [monop] Build: make

File Edit History Tools Windows

)]
Build command |make j
El

Directory ‘ftmlsuitef apps Ehurefdermsfmcmcq_:' ‘

Build Targets | monop

(W Reuse||

3. Click the Start button.
Figure 95: Building monop

Source-MNavigator [monop] Build: make

File Edit History Tools Windows

R

Build command (fnake ‘

o [
Directary |/ tooleuite/ apps/ share/ demos / monop ﬂ | |
Build Targsts monep j
Run |

m —-£ ¥.o

m —-f monop

goo —c carde.c

carde.c:41l: parse error before string constant

carde.c:41l: warning: data definition has no type or storage class

make: **% [cards.o] Error 1
+++ End +++

(W Reuse|| |

Errors are generated from the build. Thel i nt macro must be defined.

Creating the I i nt macro
1. From the Tools menu, select Build Settings. The Build Settings dialog appears.
2. Double-click the nonop build target. The Edit Tar get dialog opens.
3. Click the Build Rulestab.
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Figure 96: Build RulesTab

Edit Target: monop
Source Files | Library Files I EBuild Rules | Link Bules : :
Euild Directory:

Status | File Type | Description ftmls“itEfﬂppEfEh“rEf“;I
Enabled Yacc Frocess a yacc file. I Target Type:
Enabled Lex Frocess a lex file. Executable ﬂ
Enabled Java Compile a Java file
Enabled (o4 Compile a © file Tool Chain:
Enabled o+ Compile a CH+ file SMUFro (mative) ﬂ
-
bison 5%

Ok | Cancel |

4. Because nonop iswrittenin C, double-click the C rule. The Build Rule Settings
dialog opens.

5. Click the Definestab. Typel i nt inthe text entry box.
Figure 97: Creatingthelint Macro

Build Rule Settings []

Settings | Includes | Defines |
kacro defines:
‘ Mew
lint
Ok Cancel

Click the New button to create the macro.

Click OK to close the Build Rules Settings dialog.
Click OK to close the Edit Target dialog.

Click the Done button to close the Build Settings dial og.

© o N o
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Rebuilding the nonop build target

1. From the Tools menu, select Build.
2. From the Build Tar gets combo-box, select nonop.
3. Click the Start button.

Figure 98: Rebuilding the monop Build Target

Source-MNavigator [monop] Build: make

File Edit History Tools Windows Help

R

Euild command

frakc= ‘ j _| Start |
od [

Directary |/ tooleuite/ apps/ share/ demos / monop

Euild Targets monop J
g M Run |

—Dlint [
goo —c roll.c -0 PATH CRRDS="%"/tooleuite/ appe/ share/demos/ monops cards . pokeh, " "
—Dlint
goo —c Epec.c -0 PATH CRRDS="%"/tooleuite/ appe/ share/demos/ monops cards . pokeh, " "
—Dlint
goo —c krade.c
—DO_FLTH CLRDE="\"/tooclesuite/ apps/share/demos/monop/ cards . pckh," " —Dlint
goo —o monop cards .o execute.o getinp.o houses.o jail.o misc.o monop.o morg.o print.o
prop.o rent.o roll.o spec.o trade.o J
+++ End +++
7

(W Reuse|| |

The build generates without errors. However, at runtime the program will not execute
because the path to the cards must be defined.
Creating the _PATH_CARDS macro
1. From the Tools menu, select Build Settings.
2. Double-click the nonop build target. The Edit Tar get dialog opens.
3. Click the Build Rulestab.
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Figure99: Build RulesTab

Edit Target: monop
Source Files | Library Files I EBuild Rules | Link Bules : :
Euild Directory:

Status | File Type | Description ftmls“itEfﬂppEfEh“rEf“;I
Enabled Yacc Frocess a yacc file. I Target Type:
Enabled Lex Frocess a lex file. Executable ﬂ
Enabled Java Compile a Java file
Enabled (o4 Compile a © file Tool Chain:
Enabled o+ Compile a CH+ file SMUFro (mative) ﬂ
-
bison 5%

Ok | Cancel

4. Double-click the C rule. The Build Rule Settings dialog opens.
5. Click the Defines tab.
6. Typethefollowing information in the text entry box, replacing
proj ect - di rect or y with the path to the denos/ nonop directory:
_PATH_CARDS="\"proj ect - di r ect or ylcards.pck\"”
Figure 100: Creatingthe PATH_CARDSMacro

Build Rule Settings []
Settings | Includes I Defines |
kacro defines:
lint ‘ Mew
__PNTH CRRDS="%"/tooleuite/ appe/ share/demos / monops cards . pokeh, " "
Ok | Cancel |

Thistells Source-Navigator which card pack to use when running the monop
program.

7. Click the New button to create the macro.
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8. Click OK to close the Build Rules Settings dialog.

9. Click OK to close the Edit Target diaog.
10. Click the Done button to close the Build Settings dialog.

Performing a clean build
To ensure that the new macro is picked up at compile time, perform aclean build on
the nonop target.
1. IntheBuild window, from the Tools menu, select Clean Build.

Figure 101: Selecting Clean Build

Source-MNavigator [monop] Build: make

File  Edit History Toolslﬁindows

L 2Eir|:e Build

Euild command mal <|aan Build j | Start |
i i hare/d /menop
Directary Export Makefile... are/ demos ﬂ_l |

Euild Targets monop J
g hié Run |

(W Reuse||

2. Click the Start button to perform the build.
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Figure 102: Performing a Clean Build

Source-MNavigator [monop] Build: make

File Edit History Tools Windows Help

R

Euild command

frakc= ‘ j _| Start |
od [

Directary |/ tooleuite/ apps/ share/ demos / monop

Euild Targets monop J
g M Run |

—Dlint [
goo —c roll.c -0 PATH CRRDS="%"/tooleuite/ appe/ share/demos/ monops cards . pokeh, " "
—Dlint

goo —c Epec.c -0 PATH CRRDS="%"/tooleuite/ appe/ share/demos/ monops cards . pokeh, " "
—Dlint

goo —c krade.c

—DO_FLTH CLRDE="\"/tooclesuite/ apps/share/demos/monop/ cards . pckh," " —Dlint

goo —o monop cards .o execute.o getinp.o houses.o jail.o misc.o monop.o morg.o print.o
prop.o rent.o roll.o spec.o trade.o J
+++ End +++

7
(W Reuse|| |

Again nonop compiles without errors, but now uses the correct card pack.
Now you need to create another target to initialize the cards used in the nonop game.

Creating the i ni t deck Target

1. From the Tools menu, select Build Settings. The Build Settings dialog opens.
2. Typei ni t deck asthe name of the build target.

Figure 103: Creatingtheinitdeck Target

S =1{E]

Build Targets:

menep I’QeTl
__fename_ |

_ gt |
G|
4 |

| initdech | Done |

3. Click the Create button. The Edit Target dialog opens.

4. IntheBuild Directory field, click the “..” button and select the build directory
for thenonop project. This is the same build directory used fomtiweop target.
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Figure 104: Addingthe Build Directory

Euild Directory:
ftooleuite appe/ gharedc ... |

Target Type:

Executable ﬂ
Tool Chain:

GMUPro (native) -

5. From Project Files, select thei ni t deck. c file.
6. Click the Add Files button to copy the file to the Tar get Fileslist.
Figure 105: Files Added to the Target

Edit Target: initdeck.
Source Files | Library Files | Build Rules | Link Rules | ) )
Euild Directory:
Froject Files: Target Files: / toolmuite/ appe/ sharede | . |
Files S - addFiles = | |Files 5]
B cards.c LB initdeck.c Target Type:
B deck.h Clear | Executable -
_ execute. o
_ getinp.c Clear Al | Tool Chain:
B houses.c SMUFra (nativel -
_ initdeck.c
HB Jail.s Impart:
_ miGEc. o
B monop.o Files |
B monop.h
B morg.c Directory |
_ pathnamss.h
_ print.c
_ prop . o
_ rent.c
_ roll. o =
_ BDEC. © ; =
| | —
Ok | Cancel |

NOTE To execute the program correctly on UNIX, click the Link Rulestab. Type
xterm -e ./initdeck inthe Command to launch Application field.
Click OK to closethe Link Rules diaog.

7. Click OK to close the Edit Target diaog.
8. Click the Done button to close the Build Settings dialog.

The build target is created. Now you need to compile the program.

Debugging the i ni t deck build target

1. From the Tools menu, select Build. The Build dialog opens.
2. From the Build Targets combo-box, selecti ni t deck.
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Figure 106: Selecting theinitdeck Build Tar get

Source-MNavigator [monop] Build: make

File Edit History Tools Windows

R

Build command (fnake

Directary |/ tooleuite/ apps/ share/ demos / monop

Build Targets |initdeck

(W Reuse||

3. Click the Sart button.
Figure 107: Buildinginitdeck

Source-MNavigator [monop] Build: make

File Edit History Tools Windows

R

Build command (fnake

Directary |/ tooleuite/ apps/ share/ demos / monop

Build Targets |initdeck

m —-£ ¥.o

m —f initdeck

goo —c initdeck.c

initdeck.c:38: warning: unknown escape sequence:
initdeck.c:3%: parse error before string constant
initdeck.c:3%: warning: data definition has no type or storage class
initdeck.c:46: parse error before string constant

initdeck.c:46: warning: data definition has no type or storage class
make: **% [initdeck.o] Error 1

+++ End +++

N followed by char code Oznd

i

(W Reuse||

Errors are generated from the build. Thel i nt and _PATH_CARDS macros must be

defined.

Creating the | i nt and _PATH_CARDS macros
1. From the Tools menu, select Build Settings. The Build Settings dialog appears.
2. Double-click thei ni t deck build target. The Edit Tar get dialog opens.

3. Click the Build Rulestab.
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Figure 108: Build RulesTab

Edit Target: initdeck.
Source Files | Library Files I EBuild Rules | Link Bules : :
Euild Directory:

Status | File Type | Description ftmls“ite’xﬂpps’xsh“re’xc;l
Enabled Yacc Frocess a yacc file. I Target Type:
Enabled Lex Frocess a lex file. Executable ﬂ
Enabled Java Compile a Java file
Enabled (o4 Compile a © file Tool Chain:
Enabled o+ Compile a CH+ file SMUFro (mative) ﬂ
-
bison 5%

Ok | Cancel |

4. Becausei ni t deck iswritten in C, double-click the C rule. The Build Rule
Settings dialog opens.

5. Click the Definestab. Typel i nt inthetext entry box.
Figure 109: Creatingthelint Macro

Build Rule Settings []

Settings | Includes | Defines |
kacro defines:
‘ Mew
lint
Ok Cancel

6. Click the New button to create the macro.

7. Typethefollowing information in the text entry box, replacing
proj ect - di r ect or y with the path to the dermos/ nonop directory:
_PATH_CARDS=""pr oj ect - di r ect or y/cards.pck\"”
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Figure 110: Creatingthe PATH_CARDSMacro

Build Rule Settings []

Settings | Includes I Defines |

kacro defines:

lint ‘ Mew

__PNTH CRRDS="%"/tooleuite/ appe/ share/demos / monops cards . pokeh, " "

Ok | Cancel |

Thistells Source-Navigator which card pack to use when running the monop
program.

8. Click the New button to create the macro.

9. Click OK to close the Build Rules Settings dialog.

10. Click OK to closethe Edit Target dialog.

11. Click the Done button to close the Build Settings dialog.

12. Open aconsole window and copy thecar d. i np file, located in the
denos/ nonop directory, into the build directory.

Figure 111: Copyingthecard.inp File
= Terminal ™ =1E]

Eile Edit  Settings Help

&
toolsuitefapps/share/demos/monop/cards.inp foolsuitefappsishare/demo :E
7]

Performing a clean build

To ensure that the macros are picked up at compile time, perform a clean build on the
i ni tdeck target.

1. Inthe Build window, from the Tools menu, select Clean Build.
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Figure 112: Selecting Clean Build

Source-MNavigator [monop] Build: make

File Edit History Toolslﬁindows

‘l >| Build

|——— Faorce Build

Build command mal Claan Build ﬂ_l il
o

i i hare/d /
Directory Export Makefile... are/ demos / monop

Build Targets |initdeck j
Run

m -£ *.o

rm —f initdeck

goo —c initdeck.c -D PRTH CRBRDS="'"tooleuite/ appe/ share/demos/ monops cards . pokeh, " "
—Dlint

goc —o initdeck initdeck.o

+++ End +++

(W Reuse||

2. Click the Sart button to perform the build.
Figure 113: Performing a Clean Build

Source-MNavigator [monop] Build: make

File Edit History Tools Windows

R

Euild command

[pake ‘j | Start |
Directary |/ tooleuite/ apps/ share/ demos / monop ﬂ | |

Build Targets |initdeck j
Run

m —-£ ¥.o

m —f initdeck

goo —c initdeck.c -D PRTH CRBRDS="'"tooleuite/ appe/ share/demos/ monops cards . pokeh, " "
—Dlint

goo —o initdeck initdeck.o

+++ End +++

(W Reuse|| |

Thistimei ni t deck compilesand linkswithout errors. i ni t deck isthe name of
the working executable.
3. Click the Run buttonto runi ni t deck, which creates the cards used in the game.

A console window opensto build the cards and closes after the build is complete.
4. Fromthe Build Targetsfield, select monop.
5. Click the Run button.
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A console window opens and nonop runs automatically. Enter the number of
players and their names. Press the ? key to list the playing options.

Figure 114: Playing monop

maonop
How many players? 2

Player 1's name: Jack
Player 2's name: Jill

Jack (1) rolls T
Jill (2) rolls 6
Jack (1) goes first

Jack (1) {cash $1500) on === GO ===

—— Commands 7

save, restore, roll, <RETURM:
—— Command: i

Valid inputs are: guit, print, where, own holdings, holdings, mortgage,
unmortgage, buy houses, =sell houses, card, pay, trade, resign,
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Command Line Options

Source-Navigator supports the following command line options:
- - bat chnode

This forces batch mode to create a new project. If thisis set, Source-Navigator
will not launch. Instead the following command line options will be used to create
anew project.

- - proj ect nanme

This command creates a project in the current directory using the directory path.
For example, if the current directory is/ home/ f oo and - - pr oj ect name isrun,
the project name becomes/ hone/ f oo/ f 0o. proj .

--avail -options

Sets preferences for an option used in project creation.
--define option=val ue

Lists optionsthat can be set using - - def i ne.
--dat abasedir directory

(synonyms: - dbdi r, - dat abase, - db)

Defines the directory for the symbol databases. Without this, the symbol
databases are put in adirectory called . snprj at the samelevel asthe project file.

--inmport file
Specifies atext file with alist of all files or directoriesto add to the project.
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- - noxr ef

This option prevents the creation of cross-references. By defaullt,
Source-Navigator generates cross-reference information for the project.

--Create

This option is used to start the Auto-Createdialog. It is not normally used with
- - bat chnode. Source-Navigator prompts the user for information used to create
aproject.

Example: Creating a New Project in devo-files

The following command creates a project named / hone/ smi t h/ devo. proj using
the files listed in devo-filesin batch mode. The database files are stored in
~/db_fi | es. Source-Navigator returns when the project has been created.

~bi n/ snavi gat or --bat chnode \
--inmport devo-files \
--databasedir ~/db _files \
--proj ectname /hone/snith/devo

Example: Creating a New Project in the Current
Directory

The following command creates a project in batch mode using the current directory. It
adds al of thefilesin the current directory and in all of the subdirectories. The current
working directory is/ hone/ smi t h/ devo/ snavi gat or . The generated project
nameis/ honme/ smi t h/ devo/ snavi gat or/ snavi gat or. proj .

~bi n/ snavi gat or --bat chnode

Example: Auto-Create Dialog

The following command displays the Auto-Create dialog, initialized with the current
directory, with f oo. proj asthe project name. To view the project, you must open
Source-Navigator.

~bi n/ snavi gat or --projectnane foo
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Introduction

Source-Navigator is based on two software components: a database engine and a
graphical user interface for representing information about software projects which
are held in the database. Source-Navigator has been designed to permit third partiesto
customize and extend Source-Navigator into specific problem domains.

Figure 115: Source-Navigator Component Overview

C/C++
S:obol
ava
ForTRAN ® L §
Sources Parsers Project Database
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Software Development Kit

With the Software Development Kit (SDK), you can:
modify the graphical user interface (see “Customization” on page 137).

write new parsers that allow Source-Navigator to support additional programing
languages (see “Adding Parsers” on page 153).

query the database for specific information (see “Database API” on page 163).

use other applications in conjunction with Source-Navigator (see
“Interapplication Communication” on page 205).

The graphical user interface (GUI) is based on Tcl and Tk (v. 8.1). If you are not
familiar with the Tcl programming language, please refer to a reference text such as

Practical Programmingin Tcl and Tk andTcl and the Tk Toolkit?.

1 Welch, Brent B. 1997. Practical Programming in Tcl and Tk. 2nd ed. ISBN 0-13-616830-2.
2 Qusterhout, John K. 1994. Tcl and the Tk Toolkit. ISBN 0-201-63337-X.
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Customization

This chapter describes how to change the start-up and runtime behaviors of
Source-Navigator. Y ou can also customize menu items and keyboard shortcuts for the
Editor. For more information see “Editor” on page 45.

The profile File

A general configuration files/ shar e/ et ¢/ profi | e, iS a system-wide configuration
file for GUI language and database cache size. These form the default values that all
users inherit for all the tools.

If you would like to customize Source-Navigator for a specific user, you may create a
file called$HOVE/ . sn/ profil e (on UNIX) Or 9aSERPROFI LE% . sn/ profil e (ONn
Windows) to contain the configuration for that user’s preferences.

Configurable Settings

The settings that may be customizedsare anguage and encodi ng, which
designates the language of the GUI, andwi | host , which tells Source-Navigator
how to connect to your mailer.
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The format for a usersrofi | e file issetti ng nane: val ue, one entry per line.
Table 7: User-Specific Settings

Setting Name Default Possible Values

sn_| anguage engl i sh engl i sh, ger man, or
j apanese

encodi ng | SCB8859- 1 see the character set

encoding combo-box in the
Project Preferences dialog

sn_mai | host mai | host mai | host , DNSname, or P
address of the mailhost

An examplepr of i | e file for the German user interface is:

sn_| anguage: ger man
sn_nai | host : mai | host

Therc.tcl Start-up File

The information in the following section assumes that you are conversant with Tcl,
which is used by Source-Navigator for program configuration tasks.

You can create a file called. t ¢l , which will automatically load when
Source-Navigator starts. If you have either share/etc/rc.tcl or a

$HOVE/ . sn/rc. tcl file, Source-Navigator reads and executes the file with the Tcl
sour ce command. The system-wide configuration file is read first; your own
configuration file is read afterwards and can override the site-local defaults.
When a Source-Navigator project opens, a Tcl procedure called (if it exists) is
called with no input parameters. This enables you to:

- install additional Tcl programs.
« customize keyboard shortcuts.
launch specific applications at start-up.
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Adding Events to therc. t cl File

Many eventsin Source-Navigator have a corresponding Tcl procedure that is called
when the event occurs. This provides the facility to control the appearance and
behavior of each tool. Y ou can choose whether or not to implement each of these Tcl
proceduresinrc. tcl, but it is not mandatory to do so.

Table 8: Eventsand Corresponding Tcl Procedures

Event Procedure called (with parameters)

A new symbol browser is opened sn_r c_synbol br owser { wi ndow nenu}

A new window is created sn_rc_mai nwi ndow{ wi ndow nenu}

A new editor view is created sn_rc_editor{view text}

A new class view is created sn_rc_cl assbrowser {vi ew cl asstree nmenberlist}
A new grep window is opened sn_rc_grep{view |list}

A new include view is created sn_rc_i ncl ude{vi ew canvas}

A new make window is opened sn_rc_make{view |list}

A new retriever view is created sn_rc_retriever{view |list}

A new cross-referenceview iscreated sn_rc_xref {vi ew canvas}

The preferences dialog is opened sn_rc_preferences{w n}
The project editor dialog is opened sn_rc_projecteditor{win nmenu}
A project is opened sn_rc_proj ect _open{projectdb}

The version control browser isstarted sn_rc_project_editor{win nmenu |ist}
Theretriever is started sn_rc_retrieve{win nmenu list}

Table 9; Parametersfor Tcl Event Procedures
Parameter  Description

W n The name of the Tk window widget. Referencing $wi n. exp returns
the name of the Tk toolbar widget, and $wi n. menu returns the name of
the Tk menu widget.

vi ew The name of the current view.

list A window-specific list of data (for example, alist of filenames).

canvas The name of the Tk canvas widget used to draw graphs in those tools

where it isapplicable.
menu The path to the menus.
classtree A pathto a Source-Navigator tree widget.
member [ ist A path to a Source-Navigator tree table widget.
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When a Symbol Browser window is created, a Tcl procedure called
sn_r c_synbol browser, if it exists, is called with the following input parameters:

= the name of the Symbol Browser window.
the path of the menu.

Changing Functionality Within the Symbol Browser

The following example script lists the names of the button widgets of a Symbol
Browser toolbar:

proc sn_rc_synbol browser {top menu} {
set tool bar_franme $top. exp
puts stdout [join [winfo children \
$t ool bar_frane] "\n"]

}

which, when using the default toolbar, provides output similar to:
.multisynmbr-1.exp.tree
.mul tisynbr-1. exp.class
.mul tisynbr-1. exp. xref
.mul tisymbr-1.exp.inc
.mul tisynbr-1. exp. space
.multisynmbr-1.exp.retrfr

Example: adding a DOS shell or xterm toolbar button

The following example code adds a new button that starts a DOS shell on Windows
and an xt er mapplication on UNIX:

proc sn_rc_synbol browser {top nmenu} {
gl obal tcl_platform

set tool _frame $top. exp

# Set a variable that identifies the text w dget on
# the status bar.
set info $top.nsg. nsg

# Create a new button on the toolbar. Note that the

# button’s command i nvokes the command |ine tool

# in the background so that Source-Navigator is not

# bl ocked while the tool is running. On Wn32, we enul ate
# ‘xtermi with ‘cnd’ .

if {$tcl_platforn(platform != "w ndows"} {
set cndline "exec xterm-T {Source-Navigator} &'
set description xterm
} else {
set cndline "exec cnmd /c start cmd &"
set description shell

}

button $tool _frame. xterm-text $description \
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-comrand $cndl i ne

# Set the main wi ndow s status bar to read "xterni
# or "shell" when the nouse pointer is over the region
# of the button.
bal I oon_bi nd_i nfo $tool _frane. xterm\
"Starts a new $description”
bi nd $t ool _frane. xterm <Leave> "set $top.nsg {}"

# Pack this button onto the tool bar.
pack $tool _frane.xterm-side left

}
Figure 116: Adding a new toolbar button

Em

T 5] e |

New tool button

Adding Menus and Submenus

You canusetherc. tcl filetoadd new menus to the menu bar or new menu items to
existing menus.

Example: adding an Extras menu

The following example shows how to add a new menu with two submenus. The first
procedure creates the menu and submenu items, and the next two are the procedures
that each of the submenu items actually execute.

proc sn_rc_synbol browser {wi n nmenu} {
# Abbreviate the nane of the nmenu to "extras".
set extras $nenu. extras
# Create a new nenu called "Extras".
menu $extras -tearoff O
# Add a nmenu itemto the nenu. The second character is
# the designated hot key. Place this nenu fourth in
# the nmenu bar.
$nenu insert 3 cascade -label Extras -underline 1\
-menu $extras
# Add two itens to the nenu.
$extras add command -1 abel Functions -conmmand \
"cust om show_synbol s Functi ons" -underline 0O
$extras add command -1 abel Met hods -command \
"cust om show_synmbol s Met hods" -underline 0
}

proc custom show synbol s {synbol type} {
# Set the scope appropriately.
switch -- $synbol type {
"Met hods" {
set scope "md"
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}
default {

set scope "fu"
}

}

if {[info commands paf _db_$scope] == "

sn_error_dial og \

"} A

"No synbols of the type <$scope> are available in the project.”

return

}

# Generate a unique nane for our new top-level w ndow

# w dget .

set w .customw n_$scope

# See if the wi ndow al ready exists.
if {I[info exists $W} {

# Create a new top-level window with a unique nane.

topl evel $w
# Change its title.

wntitle $w "[sn_read_option project-nane] ($synboltype)"
# Put a frane around this wi ndow and add scrol |l bars

# that scroll through a |istbox.
frame $w.frm

scrol | bar $w. frmscrollx -orient horizontal \
-relief sunken -conmmand "$w. frmsymist xview
scrollbar $w. frmscrolly -relief sunken \

-command "$w. frmsymist yview'

# Create a listbox to hold the synbol

namnes.

listbox $w. frmsynmist -height 20 -width 40 \
-xscrol | command "$w. frmscrollx set" \
-yscrol | command "$w. frmscrolly set”

the synbol to customedit_file.

defi ned.
ind $w. frm synli st <Doubl e-1> {

O HHHHFH

If the user double-clicks in the list box, find
the nearest entry in the list and pass the nane of
This will |aunch
us into the source file where that symbol is

customedit_file [%WVget [%N nearest %]]

}
# Pack the widgets onto our new w ndow.

pack $w.frmscrolly -side right -fill y
pack $w.frmscrollx -side bottom-fill x
pack $w. frmsynmist -expand y -fill both

pack $w.frm-fill both -expand y
} else {

# The wi ndow al ready exists, so just delete
# everything fromthe listbox and we'll re-insert

# the current itens in the next step.

$w. frmsynlist delete 0O end

}
# Put all of the database keys into the list.

eval $w. frmsynist insert end \
[ paf _db_$scope seq -data]
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proc customedit_file {key} {

#
the function or

{ nane,

#
#
#
#
#
if {[Ilength $key]

set pos [lindex $key 1]
set filename [lindex $key 2]

W have been passed the key of a record fromeither
net hod dat abase tabl es.
determine the filename and
editor to junp into the source code.
The key of a record takes the form
start_position,

== 3} {

We need to
|'ine nunber for the

filenanme }

} else {

set pos [lindex $key 2]

set filenanme [lindex $key 3]
}

sn_edit_file {} $filenane $pos

}

Figure117: AddingaMenu Item tothe Menu Bar

New menu item

File  Wiew Tools Extras | History  Windows Help
Eunctions
kethods

=/ c++_demo (Methods) ||Q|E_|E| =/ c++_demo (Functions) [EEE]
AcceptSelectee AcceptSelectee 000083.001 X CheckVarLength 000294, 000 sds/sds_offil. T
AcceptSelectee Notify0fSelection 000084, = Client_signal_handler 000048005 glish/C =
AcceptSocket Accept 000040009 glish/Soc CreateChild 000165. 009 glish/clients/she
AcceptSocket AcceptSocket 000037001 gli FillBaseAddress 000425, 000 sds/sds_offil
ActivateStmt ActivateStmt 000169001 gli FindMatches 000045.000 editline/complete
ActivateStmt Describe 000172 006 glish/s LoadFronHeader 000516000 sds/sds_offil
ActivateStmt DoExec 000171003 glish/Stm ReceiveChildOutput 000263, 004 glish/clie
ActualParameter ActualParameter 000076.0 Ref 000054.012 glish/include/Glish/0Objec
ActualParameter ActualParameter 000085.0 ScanForPreCount 000244, 000 sds/sds_offil
Agent Agent 000044 001 glish/Agent. h ScanFortranFile 000317.000 sds/sds_offil
Agent AgentID 000094.013 glish/Agent. h SendChildInput 000228, 005 glish/clients/
Agent AgentRecord 000095, 008 glish/Agent SplitPath 000100.000 editline/complete.c
Agent AgentTask 000092015 glish/Agent. h TTthackn 000229.000 editline/editline.c
Agent AssociatedStatements 000088.008 gl TT¥flush 000128, 000 editline/editline. c
Agent BuildEwentWalue 000100.008 glish/a TT¥get 000185. 000 editline/editline. o
Agent CreateEwvent 000062, 013 glish/Agent TTYinfo 000237.000 editline/editline. o
Agent DescribeSelf 000097.006 glish/Agen TT¥nbget 000200.000 editline/editline.c
Agent DoNotification 000111.005 glish/ag TTYput 000137.000 editline/editline. o
Agent HasRegisteredInterest 000075005 g TTYputs 000148, 000 editline/editline. o
Agent NotifyInterestedParties 000107.005 TTY¥show 000156, 000 editline/editline. c
L — S = ] =
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Changing Functionality Within the Editor

All Source-Navigator Editor windows execute a Tcl procedure called sn_rc_edi t or

(if it exists) at start-up. Y ou can implement this procedurein thefilerc.tcl as
described in the section “Adding Events to the rc.tcl File” on page 139. The input
parameters of this procedure are as follows:

the name of the view.
the name of the text widget.

Example: adding or changing Editor keyboard shortcuts

You can add or change keyboard shortcuts foEttieor using commands shown in
the following examplec. tcl file. This example demonstrates how the built-in
Editor can be customized to emulate other popular editors.

Note that thei nd command assigns the key bindir@ts|+A andCtrI+E to move
the cursor to the beginning and end of a line, respectively.

proc sn_rc_editor {viewtext} {
set top [winfo toplevel $view
set menu_frame $top.menu
set tool _frane $top.exp

# Bind Control-a to junp to the start of the line
# (like emacs).
bi nd $text <Control-a> {

%V mark set insert "insert linestart”

%N yvi ew - pi ckpl ace insert

br eak

}
# Bind Control-e to junp to the end of the line
# (like emacs).
bi nd $text <Control -e> {
oW mark set insert "insert |ineend"
%N yvi ew - pi ckpl ace insert
br eak

}
}

For more information about bindings, emctical Programming in Tcl and Tk by
Brent B. Welch, page 285.

Example: changing behavior of Editor toolbar buttons

The following example shows how to change the behavior & ohgpile button so it
compiles the current source file using the Jabygtecode compiler rather than gcc.

NOTE This example only works when the extended toolbar buttons are enabled. To
enable them, from the File menu, select Project Preferences. Select the Edit
tab and click the Extended toolbar buttons checkbox.

proc sn_rc_editor {viewtext} {
set top [winfo toplevel $view
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set nenu_frane $top.nenu
set tool _frane $top.tool bar.editfr

# MAKE SURE THAT THE EXTENDED TOOLBAR BUTTONS ARE ENABLED.

# Reassign the command associated with the "conpile" button.
if {[winfo exists $tool _frame.conmpile]} {
$t ool _frame. conpile config \
-command "custom conpil e $view'
}
}

proc customconpile {view} {
# Save the preconfigured "nake" command |ine; we need
# to tamper with it in this procedure.
set tenp [sn_read_option make- conmand]
# Extract the fil enane.
set file [$view cget -fil enane]
# Set the "nake" command |ine appropriately.
if {[string match {*.jav*} $file]} {
sn_nodi fy_option make-command "javac \"$file\""

}

# Byte-conpile the source file.
sn_make

# Restore the "nmke" conmand |ine.
sn_nodi fy_option make-command $t enp

}
Example: adding a button to the Editor’s extended toolbar

Thefollowing exampl e shows how either the Windows Notepad editor or the UNIX vi
editor can be integrated into Editor toolbar as an auxiliary editor.

NOTE Thisexample only works when the extended toolbar buttons are enabled. To
enable them, from the File menu, select Project Preferences. Select the Edit
tab and click the Extended toolbar buttons checkbox.

proc sn_rc_editor {viewtext} {
global tcl_platform

set topw [winfo toplevel $view
set tool _frame $topw tool bar
# On Wndows call Notepad to edit a file.
if {$tcl_platformplatform == "w ndows"} {
# Create a new button to edit the file using Notepad.
button $tool _frame.vi -text Notepad \
-command "exec notepad \[$view getfilenane\]"
bal I oon_bi nd_i nfo $tool _frane.vi \
"Edit current file using the Notepad editor."
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} else {
# Create a new button to edit the file using vi
button $tool frame.vi -text vi \
-conmand "exec xterm-T vi -e vi \[$view getfilenane\]"
bal | oon_bi nd_i nfo $tool _frane.vi \
"Edit current file using vi"
}
# Pack this button onto the tool bar.
pack $tool _frane.vi -side left

}
Example: generating an HTML file of the project database

This example shows how you can display project database information in a format
that is different from what Source-Navigator usually provides.

proc htm _doc {topw} ({
set actview [ $t opw ActiveW dget]
set ed [Multi Wndow&: : list_find_editor $actview]

if {$ed == ""} {
bell; return
}
doc_start [list [$ed getfil enanme]]

}

proc sn_rc_editor {view editor} {
# mai n wi ndow
set topw [winfo toplevel $view
# add a nenu entry for the html docunmentation
set M $t opw. nenu
$m. t ool s add conmand \
-l abel "HTML Docunentation" \
-conmmand "htm _doc $topw'
}
In the Editor, from the Tools menu, select HTM L Documentation, and
Source-Navigator brings up a browser window containing definitions and

cross-references of the symbolsin your project.
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Figure 118: Generatingan HTML Representation of the Project Database
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Error Formats

Source-Navigator can receive and act upon messages from external tools such asa
compiler or debugger through use of aconfigurable error format file that can be found
in~/ share/etc/sn_cnp_g. pat.

The contents of this error-format file is as follows; the comment above each regular
expression illustrates the kind of text that the given expression can handle. For more
information on regular expressions see “Grep” on page 83.

# Sour ce- Navi gat or regul ar expressions for conpiler,
# debugger and grep patterns.

# Sour ce- Navi gat or supports al so bl anks, so the patterns
# must be so defined that blanks could be a part of the fil enanme

# "filenane.c", line 789
([~ 190 1+inel J+([0-9]+)

# filenane.c, line 789

([ 14, [ 1+ine[ ]+([0-9]+)

# line 789, filename.c

line[ ]+([0-9]+),[ 1+([", 1+4)

# [fil ename. c: 789]
VIO 14):([0-9]14)V]

# filenane.c: 789

([* 149):0 1*([0-9]+)

# filenane.c(789)
(0™ IR0 IHNVL0-9T M)

# filenanme.c(789,11) or filenane.c(789.11)
(0™ 10 IH)NCL0-9]+[, - ][ 1*[0-9]14)\)
# /dir/filenane.c, 789
([~ 14). [ 1+([0-9]+)
The lines beginning with the haglsymbol are comments showing matching patterns;

the GNU regular expression describes the expressions. Every expression must contain
two expressions enclosed in parentheses (for the file name and line number).
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Source-Navigator does not invoke a compiler to build its databases; instead, it has a
plug-in parser for each language it supports. For details on how to add plug-in parsers
to Source-Navigator, see “The Parser Toolbox Library” on page 155.

Predefined Parsers

Source-Navigator was designed to support not only the most common software
development languages, but to support them together. With Source-Navigator you car
follow references from a C++ method to a FORTRAN subroutine, and even to
assembly language. To accomplish this task efficiently, Source-Navigator shares
terms between multiple languages, even when the languages are defined in different
terms.

For example, a Gtruct is represented in Source-Navigator as as; there is no
separateat ruct type for C. By unifying these terms, Source-Navigator greatly
simplifies both the task of multi-language code comprehension and its own internal
organization.
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The C and C++ Parser

This parser understands C++, K&R C, and ANSI C languages, including the
pre-processor directives. Pre-processing is not necessary to parse C or C++ source
code. During project creation adefault include search path is created that has the same
role asthe - I option for the C pre-processor. The include search path can be modified
during project creation or from the File menu by selecting

Project Preferences - Include.

The FORTRAN Parser

The FORTRAN parser understands the FORTRAN 77 syntax, plus extensions such as
record, structure, andi ncl ude. Theusua FORTRAN extensions are understood
by the parser as well. The include search path hasthe same role asthe -1 option for
the C pre-processor. The include search path can be modified during project creation
or from the File menu by selecting Project Preferences — Include.

The FORTRAN structure declaration is mapped by the toolsto a class. Structure
members are treated as instance variabl es.

The COBOL Parser

The COBOL parser understands these dialects: ANSI '74 Standard, ANSI "85
Standard (ANSI X3.23-1985), IBM OS/VS COBOL, IBM VS COBOL II, IBM SAA
COBOL/370, IBM DOSV S COBOL, X/Open, and Micro Focus COBOL.

The Tcland [ 1 ncr Tcl] Parser

The Tcl parser understands all versions of Tcl/Tk through version 8.1. In addition, it
understands[i ncr Tcl] versions 1.5 and 2.x.

The Java Parser

The Java parser understands Java 1.0.

The PowerPC Assembly Parser

The PowerPC assembly parser understands model number 601 assembly language.

NOTE The empty areas of Table 10 represent types that don’t exist in each language.
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Table 10: Type Definitionsfor Supported Languages

Type C/C++ and PowerPC
Abbrev. | Java FORTRAN | COBOL Tcl [incr Tcl] | assembly
cl Class, Struct Structure Structure Namespace Class
com Common
Block
cov Common
variable
con #define” Constant Const
const’
static final*
e Enum
ec Enum value
fd Function
declaration
fr Friend
fu Function Function, Function, Procedure Procedure Function
Label Label
v Global Global Global Global Global
variable variable variable variable variable
iv Instance Instance Instance Namespace Instance
variable variable™ variable!t variable variable
v Local Local Local
variable variable variable
ma Macro Macro
md Method
declaration
mi Method Namespace Method
implemen- procedure implemen-
tation tation
su Subroutine
t Typedef
un Union
* In C and C++.
T In C and C++.
¥ In Java.

*k For structure members.
Tt For structure members.
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Adding Parsers

Each parser in Source-Navigator is capable of understanding source files writtenin a
specific programming language. In the Source-Navigator suite, parsers are stand-alone
executables which adhere to a consistent command line interface. Thisinterface
allows Source-Navigator to control the parser’s behavior through command line
switches that the parser is expected to observe.

The SDK provides a C-based application programming interface (API) which enables
parsers to insert information into a project database.
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Figure 119: ParsersOverview

Standard Parsers
C/C++. Java, Fortran, Tcl, HII‘

[incr Tcl], Cobol, assembly
y

§ Project Database
New Languages ||‘Q \\\\‘

New Parsers
(generated with the SDK)

All fileslisted in Table 11 can be found in the ~/ shar e/ sdk directory.
Table 11: SDK-Related Files
Subdirectory Files Description

/incl ude/ sn. h Include files
snptools. h

/1ib/ l'ibdbutils.a Source-Navigator library files
| i bpaf db. a

| i bsnptool s. a
libtcl8.1.a

/ par ser s/ exanpl es/ assenbl y Makefil e

READVE

a.c

abrowser.!l.in

b.c

bui | d- macr os

l'i nux-i486-el f.nd
sol ari s-sparc. md

t ool box. m

/ par ser s/ exanpl es/ el f Makefil e Makefile for ebr owser . |
README The latest release information
bl obsql . el f Example source
ebrowser. | Parser (Iex)

Parsers may be implemented in any programming language. Naturally, the task of
writing aparser is significantly simpler when using compiler generation tools such as
GNU flex. All of the examples provided with Source-Navigator are written using
GNU flex.

A sample parser for the ELF language (an embedded SQL -like language) is provided
with the SDK. To experiment with this parser, change to the
~/ shar e/ sdk/ par ser s/ exanpl es/ el f directory and type

make test

Thiswill compile the parser and then parse a number of ELF source files, placing
items of interest into a project database.
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The Parser Toolbox Library

A library, implemented above the API, ssimplifiesthetask of writing new parsers. This
library, known as the parser toolbox, allows programmers to focus on the issues of
parsing source filesin their chosen language and then storing the relevant information
in the database.

Thetoolbox provides anumber of C functionsthat can help you write your parser with
less effort. These functions can be grouped as follows:

functions to maintain line and column counts in your source files. Whenever the
parser encounters an interesting symbol in the source program, it must know
where in the source file the symbol occurred.

That is, the function sn_advance_I i ne() will increment aline counter
maintained internally by the toolbox library. This function would be called along
with other actions that the parser might perform when it encounters a newline
character in the source text.

afunction to determine the name of the source file currently being parsed.

miscellaneous text processing functions for counting the number of lines and
columns consumed by a given block of text and so on.

an entry point, called sn_mai n, which manages all of the details of interfacing
with Source-Navigator and parsing each source file. In most circumstances, it is
sufficient for the parser to call sn_mai n and allow this function to call back to
your actual parsing function when required.

Thisintroduces a number of important concepts best explained with an example:

int sn_main(int argc, char *argv[], char *lang_string,
FILE **infile_ref, int(*parse)(), void(*reset)());

char group[] = "java";

int main(int argc, char *argv[])

{

return sn_nain(argc, argv, group, &yyin, yylex, reset);
}

When calling sn_ni n, it is necessary to pass:

« theargc andar gv variables as passed into yowf n() function. This allows
the library to access the command line options given by Source-Navigator.

e a pointer to a string identifying the language. In the example above, the string
is calledgr oup.

e apointer to &l LE * stream variable. You must pass the address of this
variable as the library will manipulate the stream when opening new source
files. If you are using GNU flex/bison, then pass a pointer to the global
variableyyi n.
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e A pointer to a function which takes no arguments and returnstaihis is a
pointer to your actual parsing function. If you are using GNU flex/bison, then
passyyl ex Oryypar se.

e A pointer to a function which takes no arguments and retwirs This
function is expected to perform any actions prior to processing the next source
file. Typically this function might look like:
voi d reset()

sn_reset_line(); /* reset line count */
sn_reset_colum(); /* reset colum count */

}
A detailed description of the functions available in the parser toolbox library can be
found in~/ shar e/ sdk/ i ncl ude/ snpt ool s. h.

Unless the parser has to do something out of the ordinary, it should be possible to

create a new parser by following these steps:

1. #include snptools.hinyour program (or within the verbatim section of your
lex specification).

2. Define amai n function which callsn_nmai n with the appropriate arguments and
returns the result afn_mai n to the host environment.

3. Utilize the parser toolbox routines to simplify your work within the parser. For
examplesn_nessage may be called to display messages in a dialog box that is
shown to the user during the parsing process.

4. When your parser recognizes important language constructs such as comments,
function declarations, or function invocations, call the appropsiatensert
function to insert this information into the project database.

5. Link your final program with thent ool s library. A typical command line for
linking a parser can be found in the Makefile given in the
~/ shar e/ sdk/ par ser s/ exanpl es/ el f directory.

Project Database Calls

The toolbox library provides a number of functions for inserting information into the
database that the parser will encounter in the source text. Each of these functions
return an nt with two possible return values:

0 success

-1 failure
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sn_insert _synbol

int sn_insert_synbol (int id_type, char *classnane,
char *identifier, char *filenanme, int start_|ineno,

int startCol, int endLine,

int endCol, unsigned long attrib,

char *returnType, char *argTypes, char *argNanes,
char *comment, int highStartLine, int highStartCol,
i nt hi ghEndLi ne, int hi ghEndCol);

sn_i nsert_synbol insertsasymbol into the project database.
t ype determines the type of the symbol. Possible values are:

SN_TYPE_DEF
SN_CLASS_DEF

SN_MBR_FUNC DEF
SN_MBR VAR DEF
SN_ENUM DEF
SN_CONS_DEF
SN_MACRO DEF
SN_FUNC_DEF
SN_SUBR DEF
SN_GLOB_VAR DEF
SN_COMVON_DEF
SN_COMVON_MBR VAR DEF
SN CLASS | NHERI T
SN_MBR_FUNC_DCL
SN_FUNC_DCL
SN_ENUM CONST_DEF
SN_UNI ON_DEF
SN_FRI END_DCL
SN_NANMESPACE_DEF
SN_EXCEPTI ON_DEF
SN_LOCAL_VAR DEF
SN VAR DCL

SN_I NCLUDE_DEF
SN_REF_UNDEFI NED

type definitions (such asaCt ypedef)

class definition (particularly for object-oriented
languages)

member functions

member variables
enumerations

constants

macros

functions

subroutines

global variables

common blocks

member variables within a common block
class inheritance

member function declarations
functions

enumeration constant
definitions of unions or variant records
friends (for C++)

name spaces

exceptions

local variables

variables

include files

reference to undefined symbols
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cl assnane

identifier

filenanme

start_I|ineno
start Col
endLi ne
endCol
attrib

returnType

argTypes

ar gNanes

coment

hi ghSt art Li ne

hi ghSt art Col

hi ghEndLi ne

hi ghEndCol

the name of the class, structure or common block of the symbol
if the symbol’s type is one &N_MBR_FUNC_DEF,
SN_MBR VAR DEF, SN COWON MBR VAR DEF, or

SN _CLASS | NHERI T. Otherwisec!| assnanme must be a NULL
pointer. If the symbol’s type BN _CLASS | NHERI T,

cl assnane contains the name of the base class.

the name of the symbol to be inserted into the project database.

the name of the source file in which this symbol was
encountered.

the line number of the position where the symbol starts.
the column number of the position where the symbol starts.
the line number of the position where the symbol ends.

the column number of the position where the symbol ends.
contains attributes of the symbol definitions (seeh).

a string describing the return type of the function, subroutine or
method. If the symbol is not one of these types, pass a NULL
pointer.

a string containing a comma-separated list of argument types for
the argument list of functions, subroutines or methods. If the
symbol is not one of these types, pass a NULL pointer.

a string containing a comma-separated list of argument names
for the argument list of functions, subroutines or methods. If the
symbol is not one of these types, pass a NULL pointer.

a string containing the comment that often occurs after a
definition in the source text. Note that eight-bit characters
including\ n may be used in the string. If there is no comment,
pass a NULL pointer.

the line number of the position where the highlighting of the
symbol starts.

the column number of the position where the highlighting of the
symbol starts.

the line number of the position where the highlighting of the
symbol ends.

the column number of the position where the highlighting of the
symbol ends.
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Examples

The following example inserts a class definition:

sn_i nsert_synbol (SN_CLASS DEF, NULL, cl assnane,
sn_current _file(), sn_line(), sn_colum(), sn_line(),
sn_colum() + strlen(classnanme), 0L, NULL, NULL,
NULL, NULL, sn_line(), sn_colum(), sn_line(),
sn_colum() + strlen(classnane));
The following example inserts a method definition:

sn_i nsert _synbol (SN_MBR_FUNC _DEF, cl assnane, nethodnane,
sn_current _file(), sn_line(), sn_colum(), sn_line(),
sn_colum() + strlen(nethodnanme), OL, NULL, NULL,
NULL, NULL, sn_line(), sn_colum(), sn_line(),
sn_colum() + strlen(nethodnane));
For a C function with the following prototype:

int transform(struct coord * p, int x, int y, unsigned att);

the following example inserts the definition into the database:

sn_i nsert_synbol (SN_FUNC DEF, NULL, "transfornft,
sn_current _file(), sn_line(), sn_colum(), sn_line(),
sn_colum + len, OL, "int", "struct coord *, int, int,
unsi gned", "p,x,y,att", NULL, NULL, sn_line(), sn_colum(),
sn_line(), sn_colum() + len);

sn_insert xref

sn_i nsert_xref inserts cross-referencing information.

One of the most useful aspects of Source-Navigator isits cross-referencing
capabilities. For instance, it is possible to see which functions are used by other
functions or which functions modify a particular global variable.

Where possible, aparser should attempt to collect information of this nature and insert
it into the project database. In alanguage with a flat namespace such as C, this can be
achieved by noting the name of the current function within the parser. If afunction
invocation is encountered in the source text, then the cross-referencing can be inferred
based on the current function’s name and the function being called.

Cross-referencing information is added using:

int sn_insert_xref(int type, int scope_type, int scope_level,
char *classnane, char *funcnane, char *argtypes,
char *refclass, char *refsynbol, char *ref_arg_types,
char *filenane, int lineno, int acc);

type describes the type of the referenced symbol. It must be one of
the following:

SN_REF_TO TYPEDEF
SN_REF_TO DEFI NE

Red Hat Source-Navigator Reference Guide = 159



Project Database Calls

scope_type

scope_| eve

cl assnane

f uncnane

ar gt ypes

refcl ass

r ef symbol

SN_REF_TO ENUM

SN_REF_TO STRUCT

SN_REF_TO _UNI ON

SN _REF_TO CLASS

SN_REF_TO_FUNCTI ON

SN _REF_TO MBR_FUNC

SN_REF_TO MBR VAR

SN_REF_TO _COWM VAR

SN_REF_TO CONSTANT

SN_REF_TO SUBROUTI NE

SN_REF_TO GLOB VAR

SN_REF_TO LOCAL_VAR

SN _REF_TO TEMPLATE

SN_REF_TO NAMESPACE

SN_REF_TO_EXCEPTI ON

SN _REF_TO LABEL
describes the type of the location where the cross-reference
information is reported. It must be one of the following:

SN_FUNC DEF

SN_MBR_FUNC DEF

SN_SUBR_DEF
describes the scope level of the referenced symbol. It must be
one of:

SN_REF_SCOPE_LOCAL

SN_REF_SCOPE_GLOBAL
astring containing the class name of the method if scope_t ype
iSSN_MBR_FUNC_DEF; otherwise, it must beaNULL pointer.

a string containing the function, method or subroutine namein
which the reference information is reported.

astring containing a comma-separated list of argument types for
the argument list of functions, subroutines or methods. Pass
NULL if there are no arguments.

astring containing the class, structure or common block name of
the referred symbol. If the symbol is not within a namespace,
passaNULL pointer.

the name of the referred symboal.
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ref _arg_types astring containing a comma-separated list of argument types if
the referred symbol's type is a method, subroutine or function.
Pass NULL if there are no arguments or the referred symbol is
not one of these types.

fil ename the name of the source file in which the reference information is
reported.
l'i neno the line number of the source file in which the reference

information is reported.

acc the level of access to the referenced symbol and is one of:
SN _REF_READ symbol is read (such as(ik) { ... })
SN _REF_WRI TE symbol is modified (such as = 10)
SN _REF_PASS variable is passed to a subroutine/function

SN _REF_UNUSED symbol is never used

Examples

The following exampl e inserts cross-referencing information for a function that is
called from another function.
sn_insert _xref (SN_REF_TO _FUNCTI ON, SN_FUNC_DEF,

SN _REF_SCOPE _GLOBAL, NULL, currentFunction, NULL, NULL,

cal l edFunction, NULL, sn_current file(), sn_line(),

SN_REF_PASS) ;
The following example inserts cross-referencing information for afunction that is
called from a member function calledi nsert which belongsto a C++ class called
St ack.

sn_i nsert_xref (SN_REF_TO MBR_VAR, SN _MBR_FUNC_DEF,
SN REF_SCOPE GLOBAL, "Stack", "insert", NULL, "Stack",
"i", NULL, sn_current_file(), sn_line(), SN_REF_READ);

sn_insert_coment

sn_i nsert_comment inserts comments into the project database.

When comments are encountered in the source text, the parser should call

sn_i nsert_comment to add these comments to the project database. In some
Source-Navigator projects, the user will choose to not include comments, but the
parser should call this function regardless. Thelibrary function will decide whether or
not to actually store the information in the database.

Comments are added to the database using:

int sn_insert_coment(char *classnane, char *funcnane,
char *filenane, char *coment, int beg_line, int beg_col);
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classname  astring containing the name of the class or method where the comment
was found or NULL.

funcnane a string containing the name of the function or method in which the
comment was found, or NULL if the comment is outside any function
or method scope.

fil ename a string containing the name of the current file being parsed.

comment a string containing the comment without the comment separators. For
example, in Tcl thiswould exclude the leading # character.

beg_|ine the line number of the source file where the comment begins.
beg_col the column number of the source file where the comment begins.

Integration with Source-Navigator

A completed parser can be integrated into Source-Navigator by following these steps:
1. Copy the parser executable into the ~/ bi n directory.

2. Editsn_prop. cf g inthedirectory ~/ shar e/ et c. The Tcl procedure
sn_add_par ser isused to add parsersto the configuration. The following
example shows how to include support for Java:
sn_add_parser java -suffix {*.java} \
-brow_cmd $odd_path(bindir)/jbrowser \
-hi gh_cnd $odd_pat h(bi ndir)/j browser \
-high_switch "-h"
When Source-Navigator is restarted, support for the new language becomes available.
When creating a project, the Par serstab in the Project Preferences dialog showsthe

new language and its associated filename extensions.

Thisisadl that isrequired to add new language support to Source-Navigator. If a
project is created which contains files with any of the specified filename extensions,
the new parser isinvoked to process those files as a part of the overall parsing process.
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This chapter provides information that enables programmers to build applications that

make use of Source-Navigator’'s project databases. It covers the API, including
available functions and their syntax.

This chapter assumes that you are familiar with the Tcl or C programming languages.
For information about Tcl, séRractical Programming in Tcl and Tk! andTcl and

the Tk Toolkit2, and for information about C, s&@e C Programming Language3.

Introduction

Source-Navigator project information is stored uatabase. There is one database

for each project and the database may contain one orviear® A view is a named
subset of records; this might be the subset aoftafiles, or the subset of all files in a
given subdirectory. Views are a powerful and fast way to narrow down a large project
without building multiple projects (see page 165).

1 Welch, Brent B. 1997. Practical Programming in Tc! and Tk. 2nd ed. ISBN 0-13-616830-2.
2 Ousterhout, John K. 1994. Tcl and the Tk Toolkit. ISBN 0-201-63337-X.
3 Kernighan, Brian W., and Dennis M. Ritchie. 1988. The C Programming Language. 2nd ed. ISBN 0-13-110362-8.

Red Hat Source-Navigator Reference Guide = 163



Structure

A database consists of 15 to 25 files; each file consists of atable that contains symbol
and index information. Databasefiles are regular filesin the operating system that you
can share between UNIX and Windows operating systems.

When you create a project with Source-Navigator, a database is created in the
projectdirl.snprj directory. By default, thislocation can be changed in the Project
Preferences dialog when the project is created. See “General Project Preferences” on
page 26 for more information. Each database file is created with a filename starting
with proj ect nane, wherepr of ect nane is the project name you chose and

proj ect di r is the project directory you chose. One or more databases may exist in the
same directory.

Each file is aable that contains specific symbol information and indexes. A database
table can be accessed viaiaaiex, which is handled internally by the database, or
sequentially. To use the Tcl API, you do not need additional header files, compilers,
or libraries. All of the Tcl commands you need to work with a Source-Navigator
project database are built into the Source-Navigator Tcl interpreter bgtied

NOTES In previous versions of Source-Navigator, fields in the database were

separated by space characters. To accommodate filenames that contain
spaces, the field separator has been changed to an internal value that can be
referenced through the read-only Tcl variablesep. See the scripts in
“Cross-Reference Tables” on page 166 for more information on this variable.

The first three lines of the scripts in this chapter are “boilerplate” text to run
these scripts on UNIX. On Windows you must delete these lines and run the
remainder from a file usingNsdk.

To run stand-alone Tcl scripts (see page 188) on Windows NT, an execution
command must be used. The usage of this command is:
SNsdk scri pt-name argunents

To run themul ti cl udes. t cI example script on a project callegst 1 in the

C: \test directory the syntax would be:
SNsdk multicludes.tcl C\test testl

Structure

The database may be accessed by a set of Tcl commands. The primary goals in
designing the API were performance and flexibility; for high-level queries, the Tcl
language provides a powerful and flexible solution.
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Figure 120: Database APl Overview
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Project Database tables

The database supportsthe bt r ee and hash file formats. Thebt r ee format isa
representation of a sorted, balanced tree structure. The hash format is an extensible,
dynamic hashing scheme.

Thedbopen, cl ose, del , get , put , and seq routines are used to access the database.
Optimal database tuning calls and parameters may also be configured in Tcl using the
cachesi ze and pagesi ze properties (see “dbopen for Tcl” on page 168) to give
optimum performance in specific applications.

Views

Views define sets of files to include or exclude from queries. The hidden files list is
stored in a view. For example, in a project where you have both database- and
GUI-specific source files, you can hide the databasedilec and save the remaining
project information as a view. Hiding this view means the records with references to
the filesql . ¢ must be skipped. The following example lists a view table:

set db_vi ew [ dbopen nav_view .snprj/cpl.2 RDONLY 0644 hash \

cachesi ze=300000]

puts stdout [join [ $db_view seq -data] \n]
The output is as follows:

sql.c
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Using Views

Views have to be specified when atable is opened using the dbopen command; the
application does not have to be changed. For more information ondbopen for Tcl, see
page 168.

The example below uses aview. The view table in the following example
(. snprj/cpl.2)iscreated using the Editor. The first view in a project has the suffix
.1, thesecond . 2. Thereis no limit for views.

#1/bin/sh
# Repl ace $HOVE/ snavi gator w th the Source- Navi gat or
# installation directory! \
exec $HOVE/ snavi gat or/ bi n/ hyper "$0" "$@
#
# Don't forget the backslash before exec!
#
set db_view [dbopen nav_view .snprj/cpl.2 RDONLY 0644\
hash cachesize=300000]

set db_functions [dbopen nav_func .snprj/cpl.fu RDONLY \
0644 btree cachesize=20000 $db_view]

# Output the list of matches with newline characters
# after each.
puts [join [$db_functions seq -data] \n]

# Force our way out of this event-driven shell.
exit

Cross-Reference Tables

Source-Navigator stores the cross-reference information in two tables with the
suffixesby and to . They contain the same information, only their key format differs.
Theto table keepstherefers-to information and the by table the referred-by
information. The following script openstheto cross-reference table of a project and
listsits contents.

#!/bin/sh

# Replace $HOME/snavigator with the Source-Navigator

# installation directory! \

exec SHOME/snavigator/bin/hyper "$0" "$@"

#

# Don't forget the backslash before exec!

#

set db_functions [dbopen nav_func .sn/cpl.to RDONLY 0644 btree \
{cachesize=200000}]
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puts [join [$db_functions seq -data] \n]
exit

The above script would generate these results:

# len fu # strlen fu p 000019 c.c

# main fu # glob_var gv w 000010 c.c
# main fu # len fu p 000013 c.c

# main fu # printf fu p 000013 c.c
# main fu # strcpy fu p 000012 c.c

The hash (#) characters mean that the symbols do not belong to any classes. To fetch
only the references in the main function, modify the fetch instruction:
$db_functions seq -data "#${sn_sep}mai n${sn_sep}"

In the query, note that the first character of the key must be a hash (#) character
because nai n is not a method but afunction. To be sure that only the references of
main are reported, a separator character ($sn_sep) hasto be added to the string mai n.
Without the separator, the query would report the references of al functions whose
names begin with the string mai n.

An example of the result after the modification:

# main fu # glob_var gv w 000010 c.c
# main fu # len fu p 000013 c.c

# main fu # printf fu p 000013 c.c
# main fu # strcpy fu p 000012 c.c

If an application collects references to afunction referred-by, it is better to use the by
database table.

The script below opens the referred-by table and reports every reference to the global
variable gl ob_var and the function | en.

#1/bin/sh

# Repl ace $HOVE/ snavi gator with the Source- Navi gat or

# installation directory! \

exec $HOME/ snavi gat or/ bi n/ hyper "$0" "$@

#

# Don't forget the backslash before exec!

#

global sn_sep

set db_functions [dbopen nav_func .snprj/cpl.by RDONLY \
0644 btree cachesize=200000]

# Output the cross-references which match the following

# criteria, with newline characters between all of them.

puts [join [$db_functions seq -data \
"#${sn_sepl}glob_var${sn_sep}gv"] \n]

puts [join [$db_functions seq -data \
"#${sn_sep}len${sn_sep}fu"] \n]

# Force our way out of this event-driven shell.
exit
The result will be:

# glob_var gv # main fu w 000010 c.c
# len fu # main fu p 000013 c.c
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The output above indicates that the symbols gl ob_var and | en are only used by the

function mai n.

Tcl API Functions

The Source-Navigator database tables can be accessed by means of Tcl commands
created using the dbopen command. The database APl can access Source-Navigator
tables regardless of whether Source-Navigator is running, or aproject is using the

target tables.

dbopen for Tcl

The dbopen command opens atable for reading and/or writing. dbopen creates anew
Tcl object (command) with the name dbobj ect .

SYNOPSIS

dbopen dbobj ect tabl eNane access perm ssion type ?openi nfo?

dbobj ect

t abl eNane

access

perm ssi on

type

openi nfo

The desired name of the new command. dbopen will fail if thereis
already a command named dbobj ect .

The dbopen command opens atable for reading and/or writing. Files
not intended for permanent storage on disk can be created by setting
thet abl eNane parameter to NULL.

Theaccess argument is as specified for the Tcl open routine;
however, only the CREAT, EXCL, RDONLY, RDWR, and TRUNC flags are
significant. Refer to the Tcl documentation for further information on
modes for opening files.

If anew fileis created as part of the process of opening it,
per i ssi on (aninteger) setsthe permissionsfor thefile. On UNIX,
this is done in conjunction with the process’ file mode creation mask.

Thet ype argument must be eithbtr ee orhash. Thebtr ee
format represents a sorted, balanced tree structure. The hash format
is an extensible, dynamic hashing scheme.

Theopeni nf o optional argument must be a valid Tcl list and can be
used to set type-specific properties of database tables. The syntax is
as follows:

propertyl=val ue, property2=val ue, ...\

propertyn=val ue

See Table 12 and Table 13 for valid values for this parameter.
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Table 12: Hash Table Properties

Hash table

properties Meaning

bsi ze Defines the hash table bucket size, and is, by default, 256 bytes. It may be
preferable to increase the page size for disk-resident tables and tables with large
dataitems.

fact or Indicates adesired density within the hash table. It is an approximation of the
number of keys allowed to accumulate in any one bucket, determining when the
hash table grows or shrinks. The default valueis 8.

nel em An estimate of the final size of the hash table. If not set, or set too low, hash tables
will expand gradually as keys are entered. Although a slight degradation in
performance may be noticed, the default value is 1.

cachesi ze Suggested maximum size, in bytes, of the memory cache. Thisvaueisonly

advisory, and the access method will allocate more memory rather than fail.

Table 13: btree Table Properties

btreetable
properties

Meaning

flags

Thef | ags vaueis specified by applying the bitwise OR operation with any of
these values:

R_DUP permit duplicate keysin the tree; that is, permit insertion if the key to be
inserted already existsin the tree. The default behavior isto overwrite amatching
key when inserting anew key or to fail if theR_NOOVERWRI TE flag is specified. The
R_DUP flag is overridden by the R_NOOVERWRI TE flag, and if the R_NOOVERWRI TE
flag is specified, attemptsto insert duplicate keysinto the tree will fail. If the
database contains duplicate keys, the order of retrieval of key/data pairsis
undefined if the get method is used; however, seq method calls with the R_CURSOR
flag set will always return the logical “first” of any group of duplicate keys.

cachesi ze

Suggested maximum size (in bytes) of the memory cache. This value is only
advisory, and the access method will allocate more memory rather than fail. S
every search examines the root page of the tree, caching the most recently u
pages substantially improves access time. In addition, physical writes are dela
long as possible, so a moderate cache can reduce the number of I/O operatidg
significantly. Using a cache increases (but only increases) the likelihood of
corruption or lost data if the system crashes while a tree is being modified. If
cachesize is 0 (no size is specified), a default cache is used.

m nkeypage

The minimum number of keys stored on any single page. This value determin
which keys are stored on overflow pages; that is, if a key or data item is longe
the pagesize divided by tiné nkeypage value, it is stored on overflow pages

instead of in the page itself.df nkeypage is 0 (no minimum number of keys is

ince
sed
yed as
ns

es
r than

specified), a value of 2 is used.
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Table 13: btree Table Properties (Continued)

btree table

properties Meaning

psi ze Page size isthe size (in bytes) of the pages used for nodes in the tree. The minimum
page size is 512 bytes, and the maximum page size is 64K. If psi ze is0 (no page
sizeis specified), apage size is selected based on the underlying file system I/O
block size.

| order The byte order for integers in the stored database metadata. The number should
represent the order as an integer; for example, big endian order would be the
number 4,321. If | or der isO (no order is specified), the current host order is used.

If the file already exists (and the TRUNC flag is not specified), the values specified for
the parameter f | ags, | or der, and psi ze areignored in favor of the values used when
the tree was created.

Forward sequential scans of atree are from the least key to the greatest.

Space freed up by deleting key/data pairs from the tree is never reclaimed, although it
isnormally made available for reuse. This meansthat the bt r ee storage structureis
grow-only. The only solution isto avoid excessive deletions, or to create afresh tree
periodically from a scan of an existing one (see “dbcp” on page 192).

The instruction below opens (for read-onlyt aee database table using cachesize of
two MB.
set db [dbopen nav_cl asses brow. cl RDONLY 0644 btree \
{cachesi ze=2000000} ]
The next example opens a hash table that is used later as a view.

set db_vi ew [ dbopen nav_view .snprj/progs.1l RDONLY \
0644 hash "cachesi ze=300000"]

set db_functions [dbopen nav_func .snprj/progs.fu\
RDONLY 0644 btree "cachesi ze=200000" $db_vi ew]

Methods

With commands created layopen, these methods can be usddise, del , excl ude,
get,isenpty, put, reopen, seq, andsync. In the following examplesibob; ect
represents the command returned frtaopen.

cl ose

SYNOPSIS

dbobj ect cl ose
This method flushes any cached information to disk, frees any allocated resources,
and closes the underlying table. Since key/data pairs may be cached in memory, a
database should be closed or synchronized before the application exits; this flushes the
cache to disk. Failure to close or synchronize can cause data loss. As a final step,
dbobj ect is also destroyed.
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del

SYNOPSIS

dboj ect del ?-glob pattern? ?-beg pattern? ?-end pattern?
?-regexp pattern? ?-strstr pattern? ?key? ?flags?

This method removes key/data pairs from the table.
With gl ob, beg, end, regexp, and st r st r switches (applicable only to the bt r ee
tables), a pattern must be specified to delete every record whose key matches the

pattern. If key is specified, only those records are checked for deletion whose keys
begin with key.

The parameter f | ags may be set to the value R_CURSOR. Delete the record referenced
by the cursor. The cursor must have previously been initialized.

This method returns the number of the deleted records.

excl ude

SYNOPSIS
dbobj ect excl ude view

Thismethod effectively setsthe view of dbobj ect by excluding all symbolsnotinthe
view. Vi ew must be the name of an already existing object created using an earlier
dbopen command.

get
SYNOPSIS
dbobj ect get key

If key isfound, this method returns key and the associated datain separate Tcl lists;
otherwise, it returns an empty string. For more information, see “Fetching Tables” on
page 172.

I senpty
SYNOPSIS
dbobj ect isenpty
This method returns 1 if the table (with its current view) is empty, otherwise 0.

put

SYNOPSIS
dbobj ect put key data ?flags?
This method stores key/data pairs in the table.
The parameterl ags may be set to one of these values:

The default behavior of theut routines is to enter the new key/data pair, replacing
any previously existing key.
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R_CURSOR Replace the key/data pair referenced by the cursor. The cursor
must have previously been initialized.

R_NOOVERWRI TE Enter the new key/data pair only if the key did not previously
exist.

R _SETCURSOR Store the key/data pair, setting or initializing the position of the
cursor to referenceit. (Applicable only to the bt r ee tables.)

This method returns 0 on success, and 1 if theR_NOOVERWRI TE flag was set and the key
already existsin the table.

reopen

SYNOPSIS
dbobj ect reopen

This method closes and reopens the table. This flushes data to disk and resets any
views.

Se(
SYNOPSIS
dbobj ect seq option
See “Fetching Tables” on page 172.
sync
SYNOPSIS
dbobj ect sync

If the table is in memory only, this method has no effect and will always succeed. This
method returns zero (0) on success.

Fetching Tables

Database tables can be fetched bytheandseq methods.

get returns only one record if the fully qualified key can be found. For more
information, see the description of e method on page 171.

seq can be used to fetch tables sequentially. lktyeargument is not given, the
whole table is fetched (records to be retrieved can be filtered with pattesniinits
the records that should be fetcheely may begin at any time, and the position of the
cursor is not affected by calls to the , get , put, orsync methods. Use the optional
filters - end, - gl ob, - nocase, -regexp, -result_filter, and-strstr to limit the
retrieved records.
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Using key assures the best performance because it aready limits the records that
should be fetched while the filters limit the results only after the records have been

fetched.

By fetching, the view (if any) assigned to the table while it was open is always

processed.
Fetch Methods

Database tables can be fetched sequentialy using seq or with indexed get access.

seq
SYNOPSIS

dbobj ect seq ?-columms columm_list? ?-data? ?-end pattern?
?-first? ?-format format_string? ?-glob pattern? ?-key?
?-nocase pattern? ?-regexp expression?
?-result _filter pattern? ?-strstr pattern? ?-uniq? ?-list?

?key? ?fl ags?

-colums columm_Ii st

This switch determines the order and format in which the fields
of therecordsareto beretrieved. col um_I i st isaTcl list with

the format:

{{col _nunll ?format?} {col _nun2 ?format?}...
{col um_nunbern ?fornmat ?}}

where f or rat may be one of the following:

/

#separ at or

%

:biteq:bitor

Only the remainder of the field after the last
| character isretrieved.

The remainder of the field after the last /
character isretrieved, and then separ at or
and the field contents, until thelast / .

If the field doesn't contain any, only the
field contents are retrieved.

The field is formatted with theprintf C
Programming function as if it were:
sprintf(result,format,field);

The formatted result up to the current field is
formatted as if it were:
sprintf(new result, format,
current _result);
The & character is interpreted as if it wéte

Records are retrieved only if the current field
contents fulfill the condition as follows:
(biteqg &field) == biteq & (bitor

& field)

Use this operator only for numerical fields.
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-data

-end pattern
-first

- f or mat
format _string

-glob pattern
- key

-nocase
pattern

-regexp
expressi on

-result_filter
pattern

-strstr
pattern

-uni g

=val ue Records areretrieved only if the current field

equalstoval ue.
- mi n: max Records areretrieved only if the current field
is between i n and max. Thefieldisin the
rangeif it equalsto i n or nax.
This operator can be used only for decimal
numerical fields.

Records areretrieved only if the current field
islessthanval ue.
Use this operator only for numerical fields.

<val ue

>val ue Records areretrieved only if the current field
is greater than val ue.

Use this operator only for numerical fields.
A suffix is added to the contents of the field.

If f or mat does not match any of the special characters
listed above, it will just be appended after the field
contents.

| suf fix

Incol um_l i st, every field can be defined only once.

When this switch is specified, the fetched data of the record is
not retrieved.

Only those records are fetched whose keys end with pat t er n.

When this switch is specified, only the first record to match the
conditionsisretrieved.

If this option is specified, every retrieved record is additionally
formatted with the spri nt f C Programming function asif it
were;

sprintf(new result,format_string,result)

Therecord isretrieved only if its key matchesthe gl ob pattern.

If this key is specified, the keys of the selected records are not
retrieved.

The record isretrieved only if its key matches the
non-case-sensitive gl ob pattern.

The record is retrieved only if its key matches the regular
expression.

Therecord is retrieved only if the formatted fields match the
gl ob pattern.

The record isfetched only if the pattern can be found in the key
of the fetched record. (For more information, seethestrstr C
library function).

If this option is specified, duplicated listsin the result returned
are eliminated.
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-list

fl ags

If neither the col umm, dat a, or key switch is used, the keys and
data parts of the fetched records are retrieved in separated
sub-Tcl list. If this switch is specified, the key and data parts are
retrieved in the same lists.

The f I ags value may be set to one of these values:

R_CURSOR

R_FI RST

R_LAST

R_NEXT

R PREV

The data associated with the specified key is
returned. This differs from the get routines
inthat it sets or initializes the cursor to the
location of the key aswell. (For thebt r ee
access method, the returned key is not
necessarily an exact match for the specified
key. The returned key is the smallest key
greater than or equal to the specified key,
permitting partial key matches and range
searches.)

Thefirst key/data pair of the database is
returned, and the cursor is set or initialized to
referenceit.

The last key/data pair of the database is
returned, and the cursor is set or initialized to
reference it (applicable only to the bt r ee
tables.)

Retrieve the key/data pair immediately after
the cursor. If the cursor is not yet set, thisis
the same asthe R_FI RST flag. Thisvalueis
taken if aflag isnot given.

Retrieve the key/data pair immediately
before the cursor. If the cursor is not yet set,
thisisthe same asthe R_LAST flag
(applicable only to the bt r ee tables).
R_LAST and R_PREV are available only for
the bt r ee tables because they each imply
that the keys have an inherent order that does
not change.

C Programming API Functions

This section provides the equivalent of manual pages for the C Programming API

functions.

NOTE Youmust #i ncl ude <db. h> when using the C API, and you need to link the
final executable with | i bpafdb. a and i bt cl 8. 1. a to locate the database

library routines.
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dbopen for C

SYNOPSIS
#i ncl ude <db. h>

DB *dbopen(const char *file, int flags, int node, DBTYPE type, const
voi d *openi nfo);

dbopen isthelibrary interface to database files.

dbopen opensfi | e for reading and/or writing. Files that are never intended to be
preserved on disk may be created by setting the file parameter to NULL.

Thef | ags and node arguments are as specified to theopen(2) routine; however, only
the O_CREAT, O EXCL, O _EXLOCK, O NONBLOCK, O _RDONLY, O RDWR, O_SHLOCK, and
O_TRUNC flags are meaningful. (Note that opening a database file O WRONLY is
meaningless.)

Thet ype argument is of type DBTYPE, defined in the <db. h> includefile. It may be set
to DB_BTREE Or DB_HASH.

The openi nf o argument is a pointer to an access method specific structure described
inthe access method’s manual page.dfeni nf o is NULL, each access method will
use defaults appropriate for the system and the access method.

Thedbopen routine returns a pointer to a DB structure on success and NULL on error.
The DB structure is defined in tkeb. h> include file, and contains at least these
fields:

typedef struct {
DBTYPE type;
int (*close)(const DB *db);
int (*del)(const DB *db, const DBT *key, u_int flags);
int (*fd)(const DB *db);
int (*get)(const DB *db, DBT *key, DBT *data, u_int flags);
int (*put)(const DB *db, DBT *key, const DBT *data, u_int flags);
int (*sync)(const DB *db, u_int flags);
int (*seq)(const DB *db, DBT *key, DBT *data, u_int flags);
} DB

The elements of this structure specify the database type and a set of functions required
to perform operations on a database of this type. These functions take a pointer to a
structure as returned lyopen, and sometimes one or more pointers to key/data
structures and a flag value.

The structure elements are:

type The type of the underlying access method (and file format).

cl ose A pointer to aroutine to flush any cached information to disk, free any
allocated resources, and close the underlying file(s). Since key/data
pairs may be cached in memory, failing to sync the filewith acl ose or
sync function may result in inconsistent or lost information. cl ose
routines return -1 on error (setting er r no), and 0 on success.
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del

fd

get

put

seq

A pointer to aroutine to remove key/data pairs from the database.
The parameter f | ags may be set to:

R_CURSCR Delete the record referenced by the cursor. The
cursor must have previously been initialized.

del routinesreturn -1 on error (setting er r no), 0 on success, and 1 if
the specified key was not in thefile.

A pointer to aroutine that returns afile descriptor representative of the
underlying database. A file descriptor referencing the samefileis
returned to all processesthat call dbopen with the same filename. This
file descriptor may be safely used as an argument to the f cnt | (2) and
f1 ock(2) locking functions. The file descriptor is not necessarily
associated with any of the underlying files used by the access method.
No file descriptor is available for use in memory databases. f d routines
return -1 on error (setting er r no), and the file descriptor on success.

A pointer to aroutine that is the interface for keyed retrieval from the
database. The address and length of the data associated with the
specified key are returned in the structure referenced by dat a. get
routines return -1 on error (setting er r no), 0 on success, and 1 if the
key was not in thefile.

A pointer to aroutine to store key/data pairs in the database.
The parameter f | ags may be set to one of these values:

R_CURSOR Replace the key/data pair referenced by the
cursor. The cursor must have previously been
initialized.

R_NOOVERWRI TE Enter the new key/data pair only if the key does
not previoudly exist.

R_SETCURSOR s available only for the DB_BTREE access method
because it implies that the keys have an inherent order that does not
change.

The default behavior of the put routinesis to enter the new key/data
pair, replacing any previously existing key.

put routinesreturn -1 on error (setting er r no), 0 on success, and 1 if
the R_NOOVERWRI TE flag was set and the key aready existsin thefile.

A pointer to aroutine that is the interface for sequential retrieval from
the database. The address and length of the key are returned in the
structure referenced by key, and the address and length of the data are
returned in the structure referenced by dat a.

Sequential key/data pair retrieval may begin at any time, and the

position of the “cursor” is not affected by calls to tle¢ , get , put, or

sync routines. Modifications to the database during a sequential scan
are reflected in the scan, that is, records inserted behind the cursor are
not returned while records inserted in front of the cursor are returned.

Thef | ags value must be set to one of these values:
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sync

Key/Data pairs

R_CURSOR The data associated with the specified key is
returned. This differs from the get routinesin
that it sets or initializes the cursor to the location
of the key aswell. (For the DB_BTREE access
method, the returned key is not necessarily an
exact match for the specified key. The returned
key isthe smallest key greater than or equal to the
specified key, permitting partial key matches and
range searches.)

R_FI RST Thefirst key/data pair of the databaseis returned,
and the cursor is set or initialized to reference it.

R_LAST Thelast key/data pair of the database is returned,
and the cursor is set or initialized to reference it.
(Applicable only to the DB_BTREE access
method.)

R_NEXT Retrieve the key/data pair immediately after the
cursor. |f the cursor isnot yet set, thisisthe same
asthe R _FI RST flag.

R_PREV Retrieve the key/data pair immediately beforethe
cursor. |f the cursor isnot yet set, thisisthe same
asthe R_LAST flag. (Applicable only to the
DB_BTREE access method.)

R_LAST and R_PREV are available only for the DB_BTREE access
method because they each imply that the keys have an inherent order
that does not change.

seq routines return -1 on error (setting er r no), 0 on success, and 1 if
there are no key/data pairs less than or greater than the specified or
current key.

A pointer to aroutine to flush any cached information to disk. If the
database isin memory only, the sync routine has no effect and always
succeeds.

Thef | ags value may be set to this value:
sync routinesreturn -1 on error (setting er r no), and 0 on success.

Accessto al file typesis based on key/data pairs. Both keys and data are represented

by this data structure:
typedef struct {

voi d *dat a;

size_t size

} DBT;

The elements of this structure are defined as follows:

data

si ze

A pointer to abyte string.
The length of the byte string.
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Key and data byte strings may reference strings of essentially unlimited length
athough any two of them must fit into available memory at the same time. It should
be noted that the access methods provide no guarantees about byte string alignment.

Errors

The dbopen routine may fail and set er r no for any of the errors specified for the
library routines open(2) and mal | oc(3) or the following:

[ EFTYPE] A fileisincorrectly formatted.

[ El NVAL] A parameter, such as hash function or pad byte, has been specified
that isincompatible with the current file specification, or which isnot
meaningful for the function (for example, use of the cursor without
prior initialization), or there is a mismatch between the version
number of the file and the software.

Thecl ose routines may fail and set er r no for any of the errors specified for the
library routinescl ose(2),read(2),wite(2),free(3),orfsync(2).

Thedel , get, put, and seq routines may fail and set er r no for any of the errors
specified for the library routinesread(2), wite(2), free(3),or mal | oc(3).

Thef d routines will fail and set er r no to ENCENT for any of the errors specified in
memory databases.

The sync routines may fail and set er r no for any of the errors specified for the library
routinef sync(2).

Limitations

None of the access methods provides any form of concurrent access, locking, or
transactions.

bt r ee Database Access Method

SYNOPSIS
#i ncl ude <db. h>

Theroutine doopen isthe library interface to database files. One of the supported file
formatsisbt r ee files. For a general description of the database access methods, see
dbopen( 3) ; this describes only the bt r ee-specific information.

The bt r ee data structure is a sorted, balanced tree structure storing associated
key/data pairs.

The bt r ee access method specific data structure provided to dbopen is defined in the
<db. h> include file as follows.

typedef struct {
u_long fl ags;
u_int cachesi ze;
i nt maxkeypage;
i nt m nkeypage;
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u_int psize;

int (*conpare)(const DBT *keyl, const DBT *key2);
size_t (*prefix)(const DBT *keyl, const DBT *key2);

int |order;
} BTREEI NFQ,

The elements of this structure are as follows:

fl ags

cachesi ze

maxkeypage

m nkeypage

psi ze

conpar e

Thef | ags vaueis specified by applying the bitwise OR operation
with the following value:

R_DUP Permit duplicate keysin the tree, that is, permit insertion
if the key to be inserted already existsin the tree. The
default behavior, as described in dbopen( 3) , isto
overwrite a matching key when inserting a new key or to
fail if the R_NOOVERWRI TE flag is specified. TheR_DUP
flag isoverridden by the R_NOOVERWRI TE flag, and if the
R_NOOVERWRI TE flag is specified, attempts to insert
duplicate keys into the tree will fail.

If the database contains duplicate keys, the order of

retrieval of key/data pairsis undefined if the get routine

is used; however, seq routine calls with the R_CURSOR

flag set will always return the logical “first” of any group
of duplicate keys.

A suggested maximum size (in bytes) of the memory cache. This value
is only advisory, and the access method will allocate more memory
rather than fail. Since every search examines the root page of the tree,
caching the most recently used pages substantially improves access
time. In addition, physical writes are delayed as long as possible, so a
moderate cache can reduce the number of I/O operations significantly.
Using a cache slightly increases the likelihood of corruption or lost data
if the system crashes while a tree is being modifiechdhesi ze is 0

(no size is specified), a default cache is used.

The maximum number of keys stored on any single page. Not currently
implemented.

The minimum number of keys stored on any single page. This value
determines which keys are stored on overflow pages; that is, if a key or
data item is longer than the pagesize divided byt eypage

value, it is stored on overflow pages instead of in the page itself. If

ni nkeypage is 0 (no minimum number of keys is specified), a value of
2 is used.

psi ze is the size (in bytes) of the pages used for nodes in the tree. The
minimum page size is 512 bytes and the maximum page size is 64K. If
psi ze is 0 (no page size is specified) a page size is chosen based on the
underlying file system 1/O block size.

conpar e is the key comparison function. It must return an integer less
than, equal to, or greater than zero if the first key argument is
considered to be respectively less than, equal to, or greater than the
second key argument. The same comparison function must be used on a
given tree every time it is openedchbnpar e is NULL (no

comparison function is specified), the keys are compared lexically, with
shorter keys considered less than longer keys.
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prefix pr ef i x isthe prefix comparison function. If specified, this routine
must return the number of bytes of the second key argument, which is
necessary to determine that it is greater than the first key argument. If
the keys are equal, the key length should be returned. Although the
usefulness of thisroutine is very data dependent, in some data sets it
can produce significantly reduced tree sizes and search times. If
prefix iSNULL (no prefix function is specified) and no comparison
function is specified, a default lexical comparison routineis used. If
prefix iSNULL and acomparison routine is specified, no prefix
comparison is done.

| order The byte order for integers in the stored database metadata. The
number should represent the order as an integer; for example, big
endian order would be the number 4,321. If | or der iSO (no order is
specified), the current host order is used.
If thefile already exists (and the © TRUNC flag is not specified), the values specified
for the parametersf 1 ags, | or der, and psi ze areignored in favor of the values used

when the tree was created.
Forward sequential scans of atree are from the least key to the greatest.

Space freed up by deleting key/data pairs from the tree is never reclaimed, although it
isnormally made available for reuse. This means that the bt r ee storage structureis
grow-only. The only solutions are to avoid excessive deletions, or to create afresh tree
periodically from a scan of an existing one.

Searches, insertions, and deletionsin abt r ee will al completeino (I n N) whereNis
the averagefill factor. Often, inserting ordered datainto abt r ee resultsin alow fill
factor. This implementation has been modified to make ordered insertion the best
case, resulting in a much better-than-normal page fill factor.

Errors

Thebt r ee access method routines may fail and set er r no for any of the errors
specified for the library routine dbopen(3) .

Hash Database Access Method

SYNOPSIS

#i ncl ude <db. h>
The routine dbopen isthe library interface to database files. One of the supported file
formatsis hash files. For a general description of the database access methods, see
dbopen( 3) ; this describes only the hash specific information.

The hash data structure is an extensible, dynamic hashing scheme.

The access method specific data structure provided to dbopen is defined in the <db. h>
includefile asfollows:

typedef struct {
u_int bsize;
u_int ffactor;
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u_int nelem
u_int cachesize

u_int32_t (*hash)(const void *, size_t)

int |order;
} HASHI NFO

The elements of this structure are as follows:

bsi ze

ffactor

nel em

cachesi ze

hash

| order

bsi ze defines the hash table bucket size, and is, by default, 256
bytes. It may be preferable to increase the page size for
disk-resident tables and tables with large data items.

ffact or indicates adesired density within the hash table. Itisan
approximation of the number of keys allowed to accumulate in any
one bucket, determining when the hash table grows or shrinks. The
default value is 8.

nel emis an estimate of the final size of the hash table. If not set or
set too low, hash tables will expand gracefully as keys are entered,
although a slight performance degradation may be noticed. The
default valueis 1.

A suggested maximum size, in bytes, of the memory cache. This
valueis only advisory, and the access method will allocate more
memory rather than fail.

hash isauser-defined hash function. Since no hash function
performs equally well on all possible data, the user may find that
the built-in hash function performs poorly on a particular data set.
User-specified hash functions must take two arguments (a pointer
to abyte string and alength) and return a 32-bit quantity to be used
as the hash value.

The byte order for integers in the stored database metadata. The
number should represent the order as an integer; for example, big
endian order would be the number 4,321. If | or der is 0 (no order
is specified), the current host order is used. If the file already
exists, the specified value is ignored, and the value specified when
the tree was created is used.

If the file aready exists (and the 0 TRUNC flag is not specified), the values specified
for the parametersbsi ze, f fact or, | or der, and nel emare ignored and the values
specified when the tree was created are used.

If ahash function is specified, hash_open attempts to determine if the hash function
specified is the same as the one with which the database was created, and will fail if it

is not.

Backwardly compatible interfaces to the routines described in don( 3) and ndbn{( 3)

are provided; however,

Errors

these interfaces are not compatible with previous file formats.

The hash access method routines may fail and set er r no for any of the errors specified
for the library routine dbopen(3) .
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Simple Query Tool

The example below shows a simple query tool written in the C programming
language. Note that it works only for bt r ee tables and that views are not supported.
#i ncl ude <db. h>

mai n(int argc,char *argv[])
{

DB *db;

DBT dat a, key;

int flag,len;

char *pattern;

if (argc !'= 3)

printf("usage: % database pattern\n",argv[0]);
exit(1);

}
if (!(db = dbopen(argv[1], O RDONLY, 0644, DB_BTREE, NULL)))

fprintf(stderr,"Could not open \
\"os\", %\ n",argv[1],
strerror(errno));
exit(2);

pattern = argv[2];
len = strlen(pattern);

key.data = (void *)pattern;
key.size = len;
for(flag = R_FIRST;

db- >seq(db, &ey, &data, flag) == 0 &&
strncnp(key. data, pattern,len) == 0; flag = R_NEXT)

printf("key: 9%\n",key.data);
printf("data: %\n", data.data);

élb- >cl ose(db);
exit (0);
}
To compile and link you can use the following Makefile:
SDK=/ export/ hone/t om snavi gat or/ sdk

CFLAGS= -1$(SDK)/include
LI B= -L$(SDK)/1ib -1 pafdb
dbqgry: dbgry.c

$(C0) -0 $@3$< $(LIB)
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Database Table Structures

Source-Navigator stores information about source files in project (database) tablesto
assure high performance with flexible query possibilities.

With the exception of the project file (that isitself also a hash database table), every
table normally relies on the . snprj sub-directory of the project and can be accessed
like any other database table. The following example shows what the table structure of
aproject database looks like on aUNIX system. It was produced using the shell
commandls -I

.snprj .
SFWIr--1-- 1 user sys 16384 Aug 12 12:19 cpl.1
STW-Tr--T1-- 1 user sys 16384 Aug 12 12:34 cpl.2
SFWIr--r-- 1 user sys 8192 Aug 12 12:19 cpl. by
SFWIr--r-- 1 user sys 8192 Aug 12 12:19 cpl.cl
SPWr--t-- 1 user sys 16384 Aug 12 12:19 cpl . f
SFWIr--t-- 1 user sys 8192 Aug 12 12:19 cpl.fil
SPWr--1-- 1 user sys 8192 Aug 12 12:19 cpl.fu
STW-Tr--1-- 1 user sys 8192 Aug 12 12:19 cpl.gv
SPWIr--t-- 1 user sys 8192 Aug 12 12:19 cpl.iv
SPWr--1-- 1 user sys 8192 Aug 12 12:19 cpl.nd
SPWr--1-- 1 user sys 8192 Aug 12 12:19 cpl.m
SPWIr--1-- 1 user sys 8192 Aug 12 12:19 cpl.to

In the following table, the symbol f representssthesep separator character. See the
scripts in “Cross-Reference Tables” on page 166 for more information on this
variable. Additionally, all of the following keys must be on one line.

The hash # character in class names means that the symbol does not belong to any
classes, and semicolon) Geparates the key and data parts. Positions consist of line
and column numbers separated by a comma (

Table 14: Database Table Structures

File Table Table

Suffix Type Description Record Format

0 hash Ignored words word;#

1 hash Default view filename;#

2 hash Second view filename;#

by btree Referred by ref-classiref-symbol-nametref-typefclassisymbolitypetaccesstpositiontfilename;\
{caller_argument_types}${ref_argument_types}

cl btree Classes nametstart_positionfilename;end_positiontattributest{}{class template}+{}#{comment}

com btree Common blocks nametstart_positionifilename;end_positiontattrioutest{}1{}+{}1{comment}

con btree Constants nametstart_positionifilename;end_positiontattributest{dec_type}f{}+{}#{comment}

cov btree Common value common-blockinametstart_positionifilename;end_positiontattributest{}1{}+{}+{comment}

e btree Enumerations nametstart_positiontfilename;end_positiontattributes${}+{}+{}+{comment}

ec btree Enum-constants namedstart_positionifilename;end_positiontattrioutes{}1{}+{}{comment}

f btree Project files name;groupiparsing-timethighlight-file

fd btree Function ‘ nameis;?rt_positionifiIename;end_positioniattributesi{ret_type}i{arg_types}i{arg_names}i\
commen
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Table 14: Database Table Structures (Continued)

SH\

Database API Program Examples

The Tcl script below opens atable for afictitious Source-Navigator project named

pure.

#!/bin/sh
# Repl ace $HOVE/ snavi gator with the Source- Navi gat or
# installation directory! \

exec $HOMVE/ snavi gat or/ bi n/ hyper "$0"

#

"$@

# Don't forget the backslash before exec!

#

set db_functions [dbopen nav_func .snprj/pure.fu RDONLY \

0644 btree cachesize=200000]

# Output the list of matches with newline characters after
# each.
puts [join [$db_functions seq] \n]

This shell script produces the following result:
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File Table Table

Suffix Type Description Record Format

fil btree Symbolsof files filename#start_positiontclasstidentifierttype;end_positionthigh_start_posthigh_end_posH
arg_types

fr btree Friends nametzstart_positionifilename;end_positiontattributest{ret_type}i{arg_types}f{arg_names}f\
{comment}

fu btree Functions nameistart_positionffilename;end_positiontattributest{ret_type}+{arg_types}f{arg_name
{comment}

gv btree Variables nameipositiontfilename;attributest{type}t{templatetparameter}t{comment}

in btree Inheritances classtbase-clasststart_positionifilename;end_positiontattributest{}#{class template}$\
{inheritancettemplate}+{comment}

iu btree Include included_fileFstart_positiontinclude_from_file;0.030x0+{}+{}+{}+{}

iv btree Instance variables classtvariable-nametstart_positionffilename;end_positionfattributes${type}+{}#{}+{comment}

v btree Local variables functiontvariable-nametstart_positiontfilename;end_positionattributest{}+{type}+{}+\
{comment}

ma btree Macros nametstart_positiontfilename;end_positionfattributes:{}+{}+{}+{comment}

md btree Method classtnameistart_positiontfilename;end_positiontattributes${ret_type}f{arg_types}\

definitions {arg_names}t{comment}
mi btree Method classtnametstart_positiontfilename;end_positiontattributes${ret_type}t{arg_types}\
implementations {arg_names}f{comment}

rem btree Remarks filenameipositionfclasstmethod_or_function;comment

su btree Subroutines namezpositiontfilename;attributest{}+{}{comment}

t btree Typedefs namezpositiontfilename;attributes${original}+{}${comment}

to btree Refers to classtsymbol-nameitypetref-classiref-symboliref-typetaccesstpositiontfilename;\
{caller_argument_types}+{ref_argument_types}

un btree Unions nametpositiontfilename;attributest{}+{}+{comment}
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{chk 000011.012 chk.c} {17.1 0x8 {void} {int} {size} {}}
{fncl 000019.012 chk.c} {33.1 0x8 {void} {int,int,char *}
{i,size,str} {}}
{keys 000026.005 keybind.tcl} {28.1 0x0 {} {} {k} {}}
{mai n 000035.000 chk.c} {38.1 0x0 {int} {} {} {}}
Each record containstwo Tcl lists: the first is the key part, the second is the data part.
If - key, - dat a, Or - col umms is used, the key and the data parts are always retrieved in

separate Tcl lists.

If you use the - dat a switch inthe f et ch command (such as$db_f uncti ons seq
- dat a) in the example script above, only the key is fetched and the result is the
following:

chk 000011. 012 chk.c

fncl 000019. 012 chk.c

keys 000026. 005 keybind.tc

mai n 000035. 000 chk.c
To restrict the result to functions whose names begin with mai n, use the following
command:

$db_functions seq -data "main"

To fetch only the functions with the name mai n, you should add a blank to the key
value:
$db_functions seq -data "mai n$sn_sep"

The - col umms switch can be used to change the order of fields. The query below
retrieves the name of the files, then the name of the functions and their positions:
$db_functions seq -data -colums [list 2 0 1]

Theresultis:

chk.c chk 000011.012

chk.c fncl 000019. 012

keybi nd. tcl keys 000026. 005

chk.c main 000035. 000
Asdescribed on page 173, the Tcl list following - col umms contains sub-lists. Thefirst
element of asub-list identifies (offset number beginning from 0) which field should be
retrieved, and the second element is an optional format that controls formatting. In the
example below, the" " appends a blank after every retrieved field. Sometimesitis
useful touse\t (tab) instead of blanks. In Source-Navigator, types are often shown in
parentheses.

For example, to obtain a listing of every function, indicated as (f u), the following
command
$db_functions seq -data -colums [list {2 "(fu) "} 0 1]

produces the result:

chk. c(fu) chk 000011.012
chk.c(fu) fncl 000019.012
keybi nd. tcl (fu) keys 000026. 005
chk. c(fu) nmain 000035. 000
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The format characters: , <, >, and = can be used to make comparisons of database
table field contents. When a condition is not true, the record is not retrieved.

For the purposes of this example, the source file where the following C++ class TEST
is defined will be called t est . cc.

cl ass TEST {
private:

int inm)
{
return O;

}

outside(int x,int y);

public:
static void copy(){}

prot ect ed:
int var;
I

TEST: : outside(int x,int y)
{
}

The Tcl script below queriesthe project for all of the public methods of classes that
have been defined int est . cc. The value four used in the example maps to the
constant PAF_PUBLI Cfrom sn. h.

#!/bin/sh

# Repl ace $HOVE/ snavi gator with the Source- Navi gat or
# installation directory! \

exec $HOMVE/ snavi gat or/ bi n/ hyper "$0" "$@

#

# Don't forget the backslash before exec!

#

set db_prefix .sn/doc.md
set db [dbopen methods_db $db_prefix RDONLY 0444 btree]

set res [$db seq -col [list 0 1 32 "5 :0:4"] -end "test.cc"]
# 4 -> 1 for private methods, 4 -> 5 for public and private methods
puts [join $res "\n"]
The script produces this output:
TEST copy test.cc 000009. 014 0x200c
To query the private methods, change the value four to one (the value of PAF_PUBLIC).

This modified script produces this output:

TEST i nmtest.cc 000003. 006 0x2001
TEST outside test.cc 000007.002 0Ox1

To query the public and private methods, use the value five. Thisisthe bitwise OR of
the values for PAF_PRIVATE and PAF_PUBLIC.
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To query all static (SN_STATI C) methods defined int est . cc, change the script as

follows:

set res [$db seq -col [list 01 3 2 "5 :8:7"] -end "test.cc"]
To query every method between lines seven and nineint est . cc, make the following
query:

set res [$db seq -col [list 01 3\

"2 <10" "2 >6"] -end "test.cc"]

Database Application Examples

The Source-Navigator installation contains a number of larger examples for useful
tools that can be quickly realized using the database API. They arelocated in
~/ shar e/ sdk/ api / t cl / dat abase/ exanpl es.

Source-Navigator can assist in awide variety of software engineering and
re-engineering tasks and these examples tend to address the common scenario of
bringing under control inherited bodies of source code that may be poorly written and
poorly understood.

These examples are all written in the Tcl programming language. Some examples
utilize the Tk toolkit. None of the examples require that Source-Navigator be running
in order to use them. They work on the database directly using the database API
provided by the hyper interpreter that comes with Source-Navigator.

NOTE At thetop of each script is a path to the interpreter that may need to be edited
to locate hyper on your system.

Most of the examples require at least two command line arguments: the path to the

Source-Navigator project directory and the name of the project you're interested in.

More details can be found in the comment block at the top of each script file, and each

script is quite heavily documented.

Scripts

The example scripts are described below.

multicludes.tcl

This tool reports on redundant header files. By reducing #i ncl ude complexity in a
source file, compilation time can be reduced. Thistool locates simple duplication,
whereby f oo. ¢ may includebar . h (such as#i ncl ude "bar. h") and then bar . h again
later. By optionally specifying a-transi t i ve command line argument to the script, a
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more thorough search through the header file graph is performed, such that includes of
st di 0. h may be detected as unnecessary if another included header file includesit on
your behalf.

diamonds.tcl

This tool locates multiple inheritance “diamonds” in the class hierarchy of a project

written in an object-oriented language like C++. In his bé&dfective C++%, Scott

Myers points out the dangers associated with class hierarchies in which two classes
derived from the same superclass are inherited by a fourth derived-most class.
Diamonds are universally considered to be poor C++ programming practice and this
tool can locate them in a Source-Navigator project.

call-freq.tk

This tool plots the caller/callee frequencies for all functions and methods in a project.
Functions appearing to have called many functions or that are called by many
functions may be ones requiring coverage testing, additional documentation,
optimization, etc.

Each function is represented as a point on a graph. Clicking on a point opens a list bo»
showing the name of the function and the caller/callee statistics.

clobber.tcl

This tool shows the names of all functions/methods in a project that modify a
particular global variable.

constants.tcl

This tool identifies global variables in projects which are accessed as read-only
objects. These variables are therefore candidates for becoming constants.

unimp-methods.tcl

This tool locates class method definitions that are surplus to a class, for which there is
no method implementation. This tool is not always accurate as it will also suggest that
methods that are defined inline are not implemented when they actually are.

unused.tcl

This tool determines where unused global variables exist in a project.

4 Meyers, Scott. 1997. Effective C++: 50 Specific Ways to | mprove Your Programs and Designs. 2nd ed. 1SBN
0-20-192488-9.

Red Hat Source-Navigator Reference Guide = 189



Database Application Examples

190 = Reference Guide Red Hat Source-Navigator



Database Utilities

The Source-Navigator utilities dodunp, dbcp, and dbi np access and maintain
databases that can be started from user shells or applications. These utilities are
located in the ~/ bi n directory.

NOTE  Thescriptsin this chapter are written to work on the UNIX operating
system. When running on DOS, the scripts must be changed.

dbdunp

The dbdunp utility provides a complete listing, or a dump, of the contents of a
database table. Itsusageis:

dbdunmp ?-separator char? file

dbdunp separates the key and data parts with a semicolon (; ). The hash character (#)
and brackets ({} ) indicate an empty field. The following shell script lists the name
and locations of the project class.

#!/ bi n/ sh

dbdunp=$HOVE/ snavi gat or / bi n/ dbdunp
project=tmp
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$dbdunmp -s ' ' $project.cl | awk '{printf
", %, %8\ n", $1, $3, $2}’

dbcp

The dbcp utility copies and compacts the database. Space freed up by deleting
key/data pairs from bt r ee tablesis never reclaimed, although it is normally made
available for reuse. When copying a database with dbcp, deleted records are not
copied, resulting in amuch better page-fill factor and reduced disk space
requirements. Its usageis.

dbcp input _table output_table

The following shell script compresses the tables of a Source-Navigator project.
#!/ bin/ sh

execdi r =$HOME/ snavi gat or/ bi n
dbcp=$execdir/dbcp

proj ect =TEST
cd . paf

for i in $project.[a-z]*
do
$dbcp $i $$.tnp
mn $$.tnp $
done
Y ou can use this script even for currently-running Source-Navigator projects because
compressing database tables does not affect performance. Hash tables may also be

copied with dbcp, but there will be no space savings.

dbi np
The dbi np utility inserts, updates, and deletes records in a project database. It reads
commands from its standard input.
Itsusageis:
dbi np ?-c cache_si ze? ?-C cross_cache_si ze?
?2-1? ?2-f file? db_prefix
References to local variables are stored only if the-1 flag is specified.

db_pr ef i x contains the name of the database directory, for example, . sn and the base
name of the project file. If the project fileiscalled t est . proj, db_prefi x could be
caled . snprj/test.

The format of the commands (read from standard input) must follow this syntax:
COVVAND; KEY; DATA
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If COMWAND is greater than or equal to 0, dbi np inserts key/data pairs. The value of
COMVAND must be between PAF_FI LE and PAF_COMMVENT_DEF, inclusive. (For the
numerical values seesn. h.)

The following example inserts a function (st r copy) definition.
8; strcopy 000001.004 x.c;4.1 0x0 {int} {} {} {}
The following example inserts a method definition (pr 03) of the class xhar om
17; xharom pro3 000036. 005 x. C;36.11 0x2 {int} {} {} {}
The instructions below insert cross-references (refers-to and referred-by) into the
project database. The f symbol representsrtheep separator character in the
instructions below.
16; #tabcif utabcivar #l viwt0000041x.
15; abcivar #l vi#tabcf uswt0000044x.
16; #tabcif ut#thel | of utp+0000054x.
15; #thel | otf ut#tabctf utp+0000054x. C;
See “Database Table Structures” on page 184 for information on the structure of the

Source-Navigator database tables.

If comvaND is 0,KEY must contain a known source file name of the project, and
dbi mp deletes the definitions of, but not cross-references to, the file.

If comaND is -1,KEY must be 0 andATA must contain a known source file name
of the project, andbi np deletes the definitions of, but not cross-references to, the
file.

If COMVAND is -2,KEY must be 0 andATA must contain a known source file name
of the project, andbi np deletes the cross-references to, but not definitions of, the
file.

The following example deletes the cross-reference information for the dile
-2;0;x.c¢c

Limitations

Undefined results occur if tr@MvaND does not have a legal value.
In the commands, you may use only single blank spaces and no tabs.

Qe
*E WK
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Integrating with Version Control
Systems

Source-Navigator’s user interface provides a standard set of version control
operations. The SDK allows third parties to integrate version control packages so that
some or all of these operations can be performed from within Source-Navigator. This
chapter assumes a basic understanding of the Tcl programming language and
familiarity with the version control system that is to be integrated with
Source-Navigator.

Basics

The version control interface in Source-Navigator assumes that there is a basic set of
version control operations in the context of source code comprehension:
obtaining different versions of a source file from a repository or archive
maintained by the version control system. This operation will be referred to as a
check-out.
examining the differences between the current working version of a source file
and another version held under version control. This operation will be referred to
as adiff.
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making changes to the most current version of afile and placing those changes
under version control. This operation will be referred to as a check-in.

deleting versions from the repository.

acquiring exclusive access to a particular version of afile so that no other
developer can make changes to that version. This operation will be referred to as
locking.

relinquishing exclusive access to a particular version of afile so that other

devel opers may make modifications. This operation will be referred to as
unlocking.

discarding any changes to the current working version and reverting to the most
recent version in the repository.

obtaining the history of afile from the version control system. This includes:
« descriptive text about the changes made for each version.

« alist of symbolic names for the versions associated with a file. In GNU RCS,
for example, these names are knowtegs.

Version Control Operations

Source-Navigator takes a universal approach to interfacing with external version
control systems: each operation is performed by executing a particular command line
and capturing the output from that command.

For some operations, the output of the command is significant and only information
relevant to the user must be extracted from the output. Examples of this include
obtaining a history of changes made to a file, obtaining the names of symbolic tags,
and obtaining all of the version numbers associated with a file. The SDK provides a
mechanism based on Tcl regular expressions for extracting the relevant text from
command output.

The Configuration File

The Source-Navigator configuration filg,shar e/ et ¢/ sn_pr op. cf g, is read at

start-up and can be used to customize Source-Navigator. In particular, new version
control systems may be integrated from within this file. New systems are added by
calling a Tcl procedure calleth_add_ver si on_cont rol _syst em

The signature of this procedure is:
sn_add_version_control _system {ident args}
where
i dent is an internal identifier used by Source-Navigator. This should be a logical
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derivation of the name of the version control system and consist only of
aphanumeric characters and start with an a phabetic character. Examples are:

rcs
cvs
ccase3

ar gs isavariable number of arguments and may be any of the options described
in the Options section, followed by a suitable value. For example:
- checkout co

Options
For optionsthat have simple values, the possible values are outlined and the default is
given. If thisdefault value is satisfactory, the option may be omitted from the call.

For options that specify command lines, the usage of the command is shown. If the
option is not applicable to a particular command, omitting it from the call is
permissible, but may result in some version control operations being unavailable to
the user.

Using the - checkout example on page 198, the checkout command lineisillustrated
in the following notation:
${checkout} filenane

At runtime, the command line that is executed might be:
CO maln.c
ar gs may be any of the following options:
- checkin
This specifies the command line to check a modified file back into the
repository.
Command usage:
${ checki n} filenane or
${checki n} comment -text filenanes Or
${checki n} comment-filenane filenanes
Which command is used depends on the value of - checki n- conment - vi a.
- checki n-coment - vi a

This option specifies how comments about changes made to afile must be
passed to the - checki n command. The three possible values are:

stdin The comment is issued on the checkin command'’s standard input.
file The command is placed into a temporary file and the filename is
passed on the command line prior to the names of source files.
cmdl i ne The comment is placed on the command line prior to the
filename(s).
Default:
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None
- checki n- excl usi ve
This option specifies the command line to check afile into the repository and

to acquire alock once the check-in is complete. Thisis useful when you want
to make successive changes to afile.

Command usage:
{$checki n-excl usi ve} fil enanes
- checkout

This option specifies the command line to check out the latest version of afile
from the repository.

Command usage:
${checkout} fil enanes
- checkout - excl usi ve

This option specifies the command line to check out the latest version of afile
from the repository with exclusive access that prevents other developers from
modifying the file. Some version control systems require that afile be
checked out exclusively before amodified version of it may be checked in.

Command usage:

${checkout - excl usi ve} fil enanes
- checkout - i ndi vi dual

This option specifies the command line to check out a particular version of a
file from the repository.

Command usage:

${checkout -i ndi vi dual } versi on-num fil enanes
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- checkout -i ndi vi dual -t o- st dout
This option specifies the command line to check out a particular version of a
file from the repository and echo the contents to standard output.
Command usage:
${checkout -i ndi vi dual -t o- stdout} versi on-num fil enanes
- checkout -wi t h-1 ock

If thisoption is set to yes, then checkout operations will by default attempt to
acquire alock to prevent other developers from making concurrent
modifications. This option determines whether thewi t h | ock check buttonis
initially set in the checkout dialog box.

Default:
None.
-def aul t

If this option is set to yes, then this version control system entry will be the
default for new projects. If thisoption is set to yes for more than one entry in
the configuration file, then the entry which appears|ast in the file will be the
default.

Default:
None.
-del ete-revision
This option specifies the command line to delete a particular version of afile
from the repository.
Command usage:
${del ete-revision} version-num fil enane
-di ff-command
This option specifies the name of the command used to compare two files (or
two versions of the samefile).
Default:
diff
-di ff-ignore-case
This option specifies any additional command line optionsto the di f f
command to cause it to perform case insensitive comparisons. For amost al
implementations of the traditional di f f command, thiswill be-i .
Default:
-1
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-di ff-ignore-whitespace
This option specifies any additional command line options to the di f f
command to cause it to perform comparisons that are insensitive to
whitespace. For almost all implementations of the traditional di f f command,
thiswill be - w
Defaullt:
-W
-di scard
This option specifies a command line to discard any modifications made to
the working version of afile and revert it to the current version in the
repository.
Command usage:
${di scard} filenanes
-history
This option specifiesacommand lineto retrieve the history of afile. Typicaly
thisincludes comments made by developers at each version of thefile, the set
of version numbers for the file and the time and date of each change.
Command usage:
${ history} filenane
-history-pattern
This option specifies a pattern to extract the version history from the output of
${ hi story}. It should extract all the relevant information about all versions

of afile. See “Patterns” on page 202 for more detailed information about
possible values for this option.

Default:
None.
- hi story-individual
This option specifies the command to retrieve the history for a particular
version of a file.

Command usage:
${ hi story-individual} version-numfilenane
-hi story-individual -pattern

This option specifies a pattern to extract the version history from the output of
${ hi story-indivi dual }. It should extract all the relevant information about
the particular revision of a file.

Default;
None.
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-hi story-repl acenents
Thisoption specifies aset of textual replacementsto perform on text extracted
by the patterns ${ hi st ory- pat t er n} and
${ hi st ory-i ndi vi dual - pat t er n}. Thisallows text to be manipulated so

that it may be cosmetically improved before being shown in the History
window.

See “Replacements” on page 203 for details about possible values for this
option.
Default:
None.

-ignore-dirs
This option specifies one or more directories to ignore when presenting
directory trees to the user. Such directories may include a repository
subdirectory for each directory maintained by the version control system.

When specifying more than one subdirectory, use the Tcl list notation. For
exampleifoo bar}

Default:
None.
-1 ock

This option specifies the command line to lock a file such that no other
developer may make concurrent modifications.
Command usage:
${1 ock} filenane
-1 ock-i ndi vi dual
This option specifies the command line to lock a particular version of a file

such that no other developer may make concurrent modifications to that
version of the file.

Command usage:
${| ock-i ndi vi dual } version-num fil enane
-revi sion-nunber -pattern

This option specifies a pattern to extract all of the available revision numbers
from the output of the{ hi st ory} command.

Default:
None.
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-synbolic-tags-pattern
This option specifies a pattern to extract the names of a file's symbolic tags
from the output of the{ hi st ory} command.
Default:
None.
-synbol i c-tags-repl acenent s
This option specifies a set of textual replacements to perform on text that is
extracted by the{synbol i c- t ags- pat t er n} option. This allows text to be

manipulated so that it may be cosmetically improved before being shown in
the Symbolic tags window.

Default:
None.
-title
This option specifies a descriptive label that will be presented to the user in

the project preferences window. This option is useful for showing a
mixed-case product name or one that contains whitespace.

Default;

thei dent parameter (in upper-case).
-unl ock

This option specifies the command line needed to unlock a file so that other
developers may make concurrent modifications.

Command usage:

${unl ock} filenane
-unl ock-i ndi vi dual

This specifies the command line to unlock a particular version of a file so that
other developers may make concurrent modifications to that version of the
file.

Command usage:

${unl ock-i ndi vi dual } versi on-num fil enane

Patterns
Patterns are used to extract text resulting from certain version control commands. It is
necessary to use patterns to filter relevant lines of text from the output.
A pattern is specified as either:

A list of regular expression pairs specifying where to start and stop extracting text.
The two keywordst art andend are reserved and refer to the start and end of the
body of text respectively, or
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An atomic regular expression specifying lines that will be extracted if the regular
expression matches any text in the line.
Some examples of patterns are:
Extract the names of al the directoriesinls -1 output:
~d (an atomic regular expression)
Extract the names of al thefilesand directoriesin| s -al output, but exclude the
current and parent directories (“.” and “.."):
{ {".." end} } (alist of one regular expression pair)
More sophisticated examples exist in the configuration example on page 204.

Replacements

Replacements may be used to modify or delete text that is extracted from the result of
certain version control commands.

Where replacements are mentioned in the option descriptions above, legal values are
list of zero or more pairs. A pair is defined to be a list of exactly two elements. The
left-hand side of the pair is a Tcl regular expression and the right-hand side is a literal
string to replace the text matched by the regular expression.

An example of a replacement list is:
{{"\vtr " "} {"foo" "bar"} {"~-+$" ""} }
When applied to output from a version control command, this would cause:
tabs to be replaced by spaces.
all occurrences dfoo to be replaced blyar .
separation lines consisting of hyphens to be replaced by a blank line.

Scripts

Situations may arise in which a version control system will seem incompatible with
Source-Navigator’s approach to constructing command lines and examining the
output of the command.

In most cases, these issues are overcome by writing shell scripts that provide a
wrapper interface that Source-Navigator works with, but internally issues commands
that work with the version control system.
Consider a version control system that does not adhere to the convention of specifying
the version number of a file prior to the filename on the command line. Systems such
as RCS would expect a command line such as:

co -rl.5 main.c
But other systems might expect a command line like:

foocs checkout main.c/1.5
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This could be handled by writing a small shell script that maps the command lines
accordingly:

#1/bin/sh

foocs checkout $2/$1

Y ou would then instruct Source-Navigator to work viathe shell script:
-checkout -i ndi vi dual "foocs-w apper"

Shell scripts can aso be useful in situations where a particul ar operation requires more
than one command to be issued to the version control system.

Example

The following example is based on the GNU RCS version control system, which
many developers are familiar with. Red Hat has integrated Source-Navigator with
RCS and this configuration example is taken directly from the sn_prop. cf g
configuration file.

# GNU Revi sion Control System (RCS)
sn_add_version_control _systemrcs -default yes \
-checkin "ci" \
-checki n-comment-via stdin \
-checki n-exclusive "ci -1" \
-checkout "co -f" \
-checkout -exclusive "co -f -1" \
-checkout -i ndi vi dual "co -f -r" \
- checkout -i ndi vi dual -t o-stdout "co -p" \
-checkout-wi th-1ock yes \
-delete-revision "rcs -0" \
-discard "unco" \
-history "rlog" \

-history-pattern { {""----- "ot Az===="1 1\
-history-individual "rlog -r" \

-history-individual -pattern { {""----- "ot Az===="} } \
-history-replacenents { {"[ \t]+" " "} } \
-ignore-dirs RCS \

-lock "recs -1" \

-l ock-individual "rcs -1" \

-revi si on-nunber-pattern "~revision (\[0-9.\]+)" \
-synbolic-tags-pattern { {""“synbolic names" "“keyword"} } \
-synbol i c-tags-repl acements { {"\t" ""} } \

-unlock "rcs -u" \

-unl ock-indi vidual "rcs -u"
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This chapter addresses communication between Source-Navigator and external
applications, and provides examples of how to control Source-Navigator from other
applications.

These examples use the Source-Navigator Tcl interpreter called hyper. To use the
standard Tcl/Tk interpreter, replace the ~/ snavi gat or / bi n/ hyper string with the
appropriate name; for example/ usr /| ocal / bi n/ wi sh.

After an external application connects to a Source-Navigator project, it may be
controlled remotely using the Tk send command.

The Tk send Command

The communication between external applications and Source-Navigator can be
achieved using the Tk send command. Communicating with Source-Navigator from
another application requires that the application know the name of the interpreter
running Source-Navigator. The Tk command wi nf o i nt er ps isuseful for
determining the name of all the interpreters active on a host.

Further information on the Tk send command can be found in one of the Tcl/Tk texts
mentioned on page 136.
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Multiple Source-Navigator Interpreters

An application may need to query every Source-Navigator interpreter name in the
network. The example below queries every Source-Navigator interpreter name and
fetches the name of the Source-Navigator projects. Then if the string c++_deno is
found, the project name reloads files specified in the command line.

#1/bin/sh
# REPLACE $HOVE/ snavi gat or/bi n/ hyper with the
# Source-Navigator installation directory! \
exec $HOVE/ snavi gat or/ bi n/ hyper "$0" "$@
#
# Don't forget the backslash!
#
# This program instructs all Source-Navigator applications
# running on this host to reload the files specified on the
# command line. The project currently opened by each
# Source-Navigator application must contain the string
# "c++_demo".
# The C++ demo project, c++_demo.proj, is optionally generated
# during the Source-Navigator installation process.
# We don't need the top-level window for this program.
wm withdraw .
# Scan through all the Tcl-based interpreters on this system
# and try and find running Source-Navigators.
foreach interpreter [winfo interps] {
if {{[string match "*navigato*" $interpreter]} {
continue ;# not S-N, keep looking.
}else {
set sn $interpreter ;# found one.
}
set msg "™
# Set the command that we're going to send to the
# application (using "set" on a temporary variable to
# examine the name of the currently opened project).
set cmd {set tmp sn_options(ProjectName)}
# Send the command to the other application and capture the
# results.
catch {set result [send $sn $cmd]} msg
if {$msg 1= ""}{
puts $msg

# See if the project name contains the substring "c++_demo".
# If so, then issue the command "paf_parse_uptodate" within
# the remote interpreter.
if {[string match "*c++_demo*" $result]} {
send $sn_parse_uptodate [list $argv]
}
}

# Force our way out of this event-driven shell.
exit
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If the script aboveis executabl e and the path to the interpreter is correct, the script will
reparse and reload all files specified on the command line. If alisted fileis being
edited in a Source-Navigator editor window, the contents of the editor window will be

updated.

NOTE File names have to be used relative to the project root directory if thefileisin
asubdirectory of the project; otherwise, the file names must be specified with
absolute path names (. / and ../ cannot be used in file names).
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Index

A B
abbreviations backslashes, 31, 838
panel, 16 baseclass, 64
symbol and type, 15 bi nd, 144
access level, filtering by, 64 browser
adding Class, 61
see also creating, importing Cross-Reference, 65
additional libraries to build targets, 103 Hierarchy, 57, 59
directoriesto aproject, 9 Include, 73
files Symbol, 37
from another project, 9 btree
to aproject, 8 data structure, 179
to build targets, 102 database access
menu buttons, 140 cachesi ze, 180
new macros, 106 conpar e, 180
parser, 153 errors, 181
ANSI C programming language, 150 | order, 181
API (Application Programming Interface), 153 maxkeypage, 180
call examples, 185 m nkeypage, 180
functions, 168 prefix, 181
using Tcl, 164 psi ze, 180
applications 179
connecting external, 205 :
starting specific, 138 table -

X ' - cachesi ze, 169
assembly file extensions, 29 £l 169
associating files, 29 ags,
auto generated paths, 106 lorder, 170

m nkeypage, 169
psi ze, 170
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c-C

BTREEI NFO, 180
Build Rulestab, 103
build targets
adding
files, 102
libraries, 103
Build Rulestab, 103
Definestab, 106
Includestab, 105
Settingstab, 105
compiling, 109
creating, 99
defined, 99
deleting, 99
duplicating, 99
editing, 100
include
libraries, 102
paths, 105
project directories, 101
source files, 101
Library Filestab, 102
project
directory, 102
files, 102
removing
files, 102
library, 103
rule
description, 104
edit, 104
Source Filetab, 101
user specified paths, 106
button
adding, 140, 145
browser, 39
changing behavior, 144
list filter, 39
toolbar, 38

C

C programming language
API functions, 175
code pre-processing, 150
file extensions, 29
query tool, 183

type definitions, 151
C++ programming language
code pre-processing, 150
diamonds, 189
file extensions, 29
type definitions, 151
cachesi ze, 165
character
set, 28
special, 20
checking in files, 93
checking out files, 92
Class Browser, 61
baseclass, 64
declaration and implementation, 59
filtering by accesslevel, 64
Member List Filter dialog box, 63
preferences, 59
scope selector, 64
dtarting, 61
subclass, 64
window, 62
class name
filtering by accesslevel, 64
searching, 62
ClearCase, 91
close
synopsis, 170
cl ose, 165, 176
COBOL
dialects supported, 150
file extensions, 29
structure declaration, 150
color
changing, 34
preferences, 32
Colors & Fontstab, 32
column
filter, 41
resizing, 19
command line
editor, external, 53

importing files and directories from, 11

options, 11, 131
parser, 153

print (UNIX), 22, 32
version control, 196

Compile button, changing behavior, 144
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compiler
build target, 109
error format, 148
macros, 30
concatenated expressions, 89
contacting Red Hat, iv
continuing commands, 31
conventions
document, 2
keyboard, 3
creating
see also adding, importing
build targets, 99
macro, 106
views, 10
cross-reference
database, creating in background, 65
information, 166
inserting in database, 193
tables, 166
Cross-Reference Browser, 65
preferences, 69
starting, 66
subnode levels, 66
tree diagrams, 65
window, 66
customizing, startup/runtime behaviors, 137
CVS (Concurrent Versions Systems), 91

D

database, 163
accessing using Tcl, 164
compressing, 192
creating in background, 65
files, 164
indexes, 164
inserting cross-references, 193
modifying records, 192
tables, 164
complete listing (dump), 191
fetching, 172, 173
get, 172
seq, 172
dbcp, 192
dbdunp, 191
dbi np, 192
dbopen (C)

access, 168
specific data structure, 181
errors, 179
library interface, 179
synopsis, 176
dbopen (C), 176
dbopen (Tcl)
dbobj ect, 168
openi nf o, 168
per i ssi on, 168
t abl eNane, 168
type, 168
dbopen (Tcl), 165, 168
debugger, error format, 148
declaration
Class Browser, 59
Editor, 50
define, 30
Definestab, 106
del
synopsis, 171
del , 165, 177
deleting
see also removing
build targets, 99
libraries, 103
projects, 11
dialog box
Check Infiles, 93
Check Out files, 92
Choose Color, 34
Choose Font, 33
Find, 49
Member List Filter, 63
Replace, 50
Diff tool, 93
directories
adding to aproject, 9
importing into project, 11
discarding version control changes, 93
document
conventions, 2
documentation
online manuals, 14
DOS
scripts, 191
shell, adding button to toolbar, 140
vi executable, 54
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E-G

duplicating build targets, 99

E
editing
build targets, 100
rules, 104
Editor, 38, 45, 85, 111
adding keyboard shortcuts, 144
changing Compile button behavior, 144
declaration and implementation, 50
extended toolbar, 48
modifying the extended toolbar, 145
opening, 45
preferences, 51
window, 46
editor, external
Emacs, 53, 54, 55, 62
specifying in Source-Navigator, 53
vi, 54
Emacs
commands, 55
starting a new process, 54
tab completion supported, 62
using as editor, 54
using with arunning process, 55
versions supported, 54
error format
compiler, 148
debugger, 148
escape sequences, 88
example code
adding
buttons to Editor extended toolbar, 145
buttons to Symbol Browser toolbar, 140
Editor keyboard shortcuts, 144
new menu items, 141
changing Compile button behavior, 144
generating HTML from project database, 146
excl ude, synopsis, 171
expressions, concatenated, 89
expressions, regular, 88, 174
extended toolbar, 48
modifying, 145
extensions, file, 28
external applications
communicating, 205
connecting, 205

F

fd, 177
files
adding
from another project, 9
to aproject, 8
associating, 29
checkingin, 93
checking out, 92
database, 164
extensions, 28
hiding
from aproject, 10
from view, 165
locking, 91
removing from aproject, 11
SDK related, 154
types, 29
unlocking, 91
filter
by access level, 64
by symboal type, 19
column, 41
Member List Filter, 63
patterns, 20
special characters, 20
symbol accelerator combo-box, 46
toolbar buttons, 39
Find dialog box, 49
fonts
changing, 33
preferences, 32
FORTRAN
file extensions, 29
FORTRAN 77 syntax, 150
include extension, 150
structure declaration, 150
structure extension, 150
type definitions, 151
function, inserting in database, 193

G

get
for fetching database tables, 172
synopsis, 171

get, 165, 177
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gl ob, 174
GNU regular expression, 85, 148
gnhucl i ent, 55
Grep, 51
search example, 84
tool, 83
GUI (graphical user interface), 136

H

hash
access routine, errors, 182
data structure
bsi ze, 182
cachesi ze, 182
ffactor, 182
hash, 182
| order, 182
nel em 182
database access, 181
table, 169
cachesi ze, 169
nel em 169
HASHI NFO, 182
Help menu, 14
hiding files from a project, 10
Hierarchy Browser, 57
preferences, 59
shortcuts, 60
starting, 57
Tools menu, 58
window, 58
hierarchy tree
diagram, 65
function call, 65
limiting, 58
traversing, 66
History menu, 13
history, viewing, 49
horizontal windows, 28
HTML
online manuals, 14
HTML, generating from project database, 146
hyper, 164

i fdef, 30
implementation
Class Browser, 59
Editor, 50
importing
see also adding, creating
directories
from the command line, 11
into build targets, 102
filesinto build targets, 102
Include Browser, 73
preferences, 75
relationships, 73
starting, 73
window, 74
include search path, 150
index, accessing symbols, 164
inheritance, 189
defined, 57
multiple, 57
tree, 62
internationalization, 28
interpreter, 206
hyper, 164
i senpty, synopsis, 171

J

Java
file extension, 29
programming language, 150
type definitions, 151
using bytecode, 144

K

key/data pairs, 178

keyboard shortcuts, 3, 138
see also shortcuts
adding to Editor, 144

L

levels, subnode, 66
Library Filestab, 102
list filter buttons, 39
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M-R

locking files, 91

M

macro, 30
adding, 106
compiling, 30
defining, 31
modifying, 107
make, 110, 111
makefile, 183
Member List Filter dialog box, 63
menus
adding new, 141
Help, 14
History, 13
Scope Selector, 64
Search, 49
View, 19
Windows, 14
method definition, inserting in database, 193
multiple, 189

O
Others preferences tab, 31

P

pagesi ze, 165
parser
adding, 153
ANSI C support, 150
C/C++ support, 150
ELF, 154
FORTRAN, 150
Java, 150
K&R C support, 150
preferences tab, 28
Tcl, 151
toolbox, 155
paths, 106
patterns, 20
special characters, 20
preferences
Class, 59
Colors & Fonts, 32
Cross-Reference Browser (Xref), 69

Editor, 51
Hierarchy, 59
Include, 75
Others, 31
Parser, 28
Project, 25, 26
Version Control, 94
preserving context, 18
printing, 21, 32
project
auto-create, 132
creating new, 132
database, 163
building applications from, 163
records, 192
deleting, 11
directory, 8
hiding files, 10
preferences, 25, 26
removing files, 11
Project Editor, 7
views, 10
window, 8
Project Editor/Viewer, 144
Project tab, 26
put
method
R_CURSOR, 172
R_NOOVERWRI TE, 172
synopsis, 171
put, 165, 177

R

rc.tcl file
adding
buttonsto Editor extended toolbar, 145
buttonsto Symbol Browser toolbar, 140
Editor keyboard shortcuts, 144
new menu items, 141
changing Compile button behavior, 144
generating HTML from project database, 146
rc.tcl file, 138, 144
RCS (Revision Control System), 91
records, modifying, 192
Referred-by, 166
Referred-to, 65
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Refers-to, 65, 166 Settingstab, 105
regular expressions, 85, 88, 148, 174 shortcuts
removing finding implementation, declaration, 50
see also deleting general, 3
build targets, 99 Hierarchy Browser, 60
files, 102 sn_edit_rc, 144
filesfrom a project, 11 sn_i nsert_synbol , 157
libraries, 103 sn_rc_synbol browser, 140
version control changes, 93 sn_sep, 164
reopen, 172 Software Development Kit (SDK)
Replace dialog box, 50 adding parsers, 153
Retriever, 79 building applications, 163
searching patterns, 79 customizing, 137
window, 80 description, 136
reusing windows, 18 other applications, 205
rule source files, 29
auto generated paths, 106 Source Filestab, 101
changing default settings, 105 statusline, 16
defined, 103 subclass, 57
defining macros, 106 Class Browser, 64
disable, 104 subnodes
enable, 104 in hierarchy tree, 66
include paths, 105 setting levels in Cross-Reference Browser, 66
modifying, 107 superclass, 57
symbol
S accelerator combo-box, 46
list box, 40
SCCS (Source Code Contral System), 91 searching for, 79
Scope Selector menu, 64 selector, 19
script Symbol Browser, 37
cross-reference table, 166 calssn_rc_synbol browser, 140
opening table, 185 modifying the toolbar, 140
stand-alone Tcl, 164 sync, 172,178
SDK-related files, 154
searching T
include path, 150
patterns, 79 tab
restricting, 20 Build Rules, 103
symbol names, 79 Class, 59
text patterns, 83 Colors & Fonts, 32
using Grep, 83 Cross-Reference Browser (Xref), 69
send, 205 Defines, 106
seq Editor, 51
for fetching database tables, 172 Hierarchy, 59
synopsis, 173 Include (Browser), 75
seq, 165, 172, 177 Includes (Build), 105
sequences, escape, 88 Library Files, 102
sequential fetch, 173 Others, 31
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u-w

Parser, 28
Project, 26
Settings, 105
Source Files, 101
Version Control, 94
table
btree, 169
cross-reference, 166
database, 164
formats, 184
opening, 185
Tcl
API, 164
file extensions, 29
installing additional programs, 138
script
opening table, 185
stand-alone, 164
type definitions, 151
template, 184, 185

text patterns, searching in source code, 83

toolbar, 39
extended, 48
list filter buttons, 39
modifying Editor, 144
modifying extended, 145
modifying Symbol Browser, 140
Tools menu, 58
type definitions, 151

U

UNIX
adding menu buttons, 140
customization, 137
fonts, 33
printing, 21
stand-alone Tcl scripts, 164
unlocking files, 91

Vv

version control, 91
checking infiles, 93
checking out files, 92
command lines, 196
Diff tool, 93

discarding changes, 93
external systems, 91
integration, 195
locking files, 91
operations, 196
preferences, 94
starting, 92
tab, 94
unlocking, 91
version differences, 93
window, 92

vertical windows, 28

vi editor, 54

view
creating, 10
defined, 163
hiding files, 10
history, 49
project, 165
selecting, 10
specifying when table opened, 166

View menu, 19

w

Windows
adding menu buttons, 140
customization, 137
DOS vi executables, 54
fonts, 33
printing, 21
SNsdk, 164
stand-alone Tcl scripts, 164
windows
Class Browser, 62
Cross-Reference Browser (Xref), 66
Editor, 46
Hierarchy Browser, 58
horizontal, 28
Include Browser, 74
Project Editor, 8
Retriever, 80
reusing, 18
Version Control, 92
vertical, 28
Windows menu (toolbar), 14
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X see Cross-Reference Browser
Xref
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